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Welcome to theWord

Welcome to theWord® Bible Software!

theWord is a free, high quality Bible software! I hope that it will prove to be a valuable tool as you

study the Word of God!

theWord is simple enough for the novice user, yet is very powerful and allows you to do things you

would not have expected to see in a free software. This manual will help you discover the features of

the software and how you can better use it to enhance your Bible study.

This manual is available as a PDF file, HTML Help file (.chm) and online.

 

Before you start 

1. theWord provides very useful tips when you hover your mouse over a button, menu item or other

control. Unlike other programs, the tool-tips in theWord have been designed to give you real help and

explain in detail what each function does! 

2. theWord can be simple as well as complex! In case you are overwhelmed when it first starts, do the

following: Go to the main menu View -> Layout -> Predefined Layouts and choose Beginner, or

Novice. This will automatically switch everything to a much simpler layout. 

Welcome Screen/Quick Startup Guide

The first time you run theWord, the following Welcome Screen appears:

http://www.theword.net/app/manual
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The same screen is also available from the Help -> Welcome Screen/Quick Startup Guide... menu.

You may move your mouse over one of the three pre-created Beginner, Basic, Default tabs to see a

preview of three predefined Layouts that you can initialize theWord with. A short description is available

on the right part of the Welcome Screen to help you choose a startup layout that better suits your needs.

It is suggested to go through all three options and read through the quick notes on the right in order to

get a quick overview of some of the basic features of theWord.

You may click on:

Cancel: to retain your current layout

Preview: if you want to preview a layout live, before choosing

Go: if you want to start using the selected layout.
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Installing/Updating

Installing theWord

theWord software uses an installer to automatically install itself on your computer. You can start the

installer by double-clicking on the installer exe (typically, the installer file name is theword-setup-en.exe,

but it may be slightly different depending on the package you have downloaded or whether you install it

from a CD/DVD).

Once you start the installation, just follow the on-screen instructions. 

theWord is compatible with Windows 9x, ME, 2000, XP, Vista, Windows 7, Windows 8, 10 both 32bit and

64bit versions. The default installation folder is c:\Program Files\The Word, or c:\Program Files (x86)

\The Word for 64bit operating systems.

TIP: Notice that although theWord may be installed under the Program Files

folder, the actual modules will not, and should not, be installed in this folder. If

you install modules in that folder, then theWord will not be able to use them

because these folders are read-only in normal windows installations. 

Be careful if you download modules from a 3rd party site that use installers to

put the modules under the Program Files folder: they will not work!

Installing add-on modules

Read the Installing new modules topic to see how you can add more modules in theWord. See also the

file associations section for information on the extensions that theWord associated with itself.

Updating from previous versions

You can install a newer version of theWord over a previous one if you want to upgrade. All your personal

settings are safely preserved. If you upgrade from version 2, some settings may not be properly

migrated, but all your notes will still be migrated. You can import at a later time notes that you created

with version 2 from the File->Import personal notes... dialog.

Installation types: Normal, Compact, UFD

There are basically two installation types: normal installation and compact installation. These can be

selected during installation from the installer (the UFD -USB Flash Drive- installation is a sub-type of the

compact installation that allows you to create completely portable installations).

In a normal installation, the files used by theWord are spread to several folders according to the official

Microsoft recommendations (see Files used by theWord for details). In a compact installation, all files

used by theWord reside in the folder (and sub-folders) where you installed the software. 

A UFD installation is identical to a compact installation, except that no registry settings are written during

the installation and no uninstaller is created, since it is not needed; you can completely remove theWord

in that case by deleting the installation folder.

There are no differences between a normal and a compact installation apart from the file locations. What

makes an installation compact is the existence of a file with the name compact in the same folder as the

main executable file (theword.exe). If this file is present, then theWord runs in compact mode. You can

check the mode the software is running from the About dialog (Help->About), File Locations tab: If

running in compact mode, there is a message on the upper-right corner reading running in compact

mode:
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Appears if theWord is
running in compact mode

By default, when running in compact mode, theWord will not use any modules that reside outside the

program's installation folder. You can change this option from the File->Preferences dialog, General tab,

Other options section (When running in compact mode, use also all modules installed in target

computer option).

TIP: You can change the installation type of theWord at any moment by creating/

deleting an empty file with the name compact at the same folder where the main

executable file (theword.exe) resides -normally under c:\Program Files\The

Word. 

If you change the installation mode like that, then the next time theWord starts, it

will read its settings from the config.ini file appropriate for the installation -

see Files used by theWord for details. 

USB Flash Drive (UFD) installation

The only difference in that case is that no registry settings are written when you install the software. In

general, theWord makes minimal use of the registry. Among the few settings written in the registry, one is

the location where theWord is installed: in a UFD installation even this information is omitted; practically

nothing is written to any folder in your computer, except from files in the installation folder!

Installing a portable version of theWord by yourself

You can install a portable version of theWord on a USB flash drive, or in any folder you wish. Just follow

these steps:

Download the software (any package) along with any add-on modules you want. if you have

already downloaded and installed on your PC, you don't need to re-download. Use the same

installer.

Run theWord installer. Wait for it to start.

1. On the welcome screen, click Next.

2. Please, read carefully the License Agreement and click I Agree if you fully agree with it.

3. On the 3rd screen of the installer (Installation type) select Compact (Single folder) and also

check the USB flash drive mode option. Click Next.

4. From the next screen (Choose components) select the modules you want installed on your

USB flash drive. Click Next.

5. Make sure the USB flash drive is inserted in a USB slot of your PC. From the next screen (

Choose install location) click Browse and select the drive letter of the USB flash drive

6. Click Install and wait until the installer finishes. That's it!

To run the program, open from your windows explorer the USB flash drive and double-click on the 

theword.exe file. Remember that you should not pull the USB flash drive from the PC while the program

is running or you will lose unsaved data.

TIP: Please, consider making a donation and get a pre-loaded USB flash drive
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as a gift! Although you can do it yourself, if you have found theWord useful

please consider the possibility of a donation to help support it! You can read

more on the official site at http://www.theword.net/donate 

Multiple installations of theWord

You can safely install theWord more than once in a single computer. The only thing you should be careful

(in order to avoid confusion) is that you should do at most one normal installation. It is advised that in

that case you should choose to make the next installations in Compact/UFD mode. If you do so, each

installation will be totally independent of the other.

Languages

theWord is translated in several languages. The standard installation of theWord includes all available

languages. You may choose to install these or you can later install add-on language packs that you can

download from the official site. Each language is normally distributed as a self-installing package so you

only need to download and execute the appropriate add-on.

To change the current language theWord is using go to File->Languages. Notice that the current

language impacts the way that automatic verse  recognition occurs!

Uninstalling theWord

You can fully uninstall theWord software from your computer in 2 ways:

1. From the theWord program group that is created during installation (can be found on your

Windows program menu), click uninstall

2. From the Control Panel, click Add or Remove programs, locate the entry for theWord and click

uninstall.

3. For a compact/UFD installation, you can just delete the installation folder and everything will be

deleted (in case of a compact installation, remember to delete the 2 registry keys manually: check

the Files used by theWord section for those; for UFD installation nothing else is required).

The uninstaller is well designed so that no trace or garbage is left over; moreover, upon uninstalling, you

have the option to keep all your personal files created from within theWord.

Auto update

Overview

theWord has a built-in mechanism which periodically checks if there is a newer version of the software

available. By default such a check is made once a week. If you have a firewall installed on your computer

you may get a warning that the software is trying to connect to the Internet: this is normal and you should

accept the connection if you want to use this function.

The first time theWord attempts to check for a newer version you will get a warning dialog to verify that

you want this to happen.

During the auto-update procedure, no personal info of yours is sent over the internet and it is perfectly

safe to allow this function to execute, if you find it useful. If you are unsure you can disable this function

from the Preferences dialog (General tab, Auto-update options section).

TIP: It is possible that if you go to the official site you will see a newer version

than the one you currently have, yet the auto-update feature has not informed

http://www.theword.net/donate
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you about this. 

The reason is that theWord is regularly updated and it is often the case that new

minor versions are being released that address specific obscure bugs or minor

new features. In those cases, and in order to avoid being harassed  all the time

with installing a newer version that you don't really need, these new version are

not reported automatically.

Manually checking for newer versions

Under the Help menu there are the following two options:

1. Check for new version...: this option allows you to check if there is a new version manually. This

option will work even if you have turned-off the Auto-update feature

2. Check for updates on language files...: this option allows you to check whether there is an

update to any of your installed language files. This menu will open the default browser window and

will take you to the official site to check for newer versions. Information of all your currently

installed languages files (and their versions) is being sent in order to give you a list with only the

ones that have been updated.

3. Check for updates on modules...: this option allows you to check whether there is an update to

any of your installed official modules. This menu will open the Download Titles dialog where you

can check for updates and new modules. Remember that when you install a newer version of a

Book module, any custom user highlighting you have made is lost/reset for this Book

module. This does not apply for Bible modules, where all user highlighting is preserved when you

install newer versions of a module.

Installing new modules

Overview

For official theWord modules you should use the integrated downloader.

theWord can be extended with add-on modules that you can download from the official site or from

other 3rd party sites. The installation of add-on modules highly depends on the way they are packaged

and distributed. 

Modules from the official site are distributed as .exe files (executables). In order to install them you just

need to download the module .exe file and double click to run it. An installer will then guide you through

the installation of the module.

TIP: Be careful that in order for the automated installer to work properly, a

normal or compact installation of theWord is required. 

If you have more than one installation of theWord on your PC, or if you want to

install a module in a USB flash drive, this method may fail, unless you manually

specify during module installation that path where theWord software resides

(e.g. the path of the file theword.exe).

TIP: Problems with Anti-Virus or Anti-Malware programs may arise when you

try to run an .exe file that is downloaded from theWord. This is because some of

http://www.theword.net
http://www.theword.net
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these programs will incorrectly report that there might be a problem with the .

exe file you downloaded. In that case you can use the integrated Installation

function of theWord to install the modules (read below).

Integrated Installation Function

theWord provides an integrated installation function that allows you to easily install modules you

download without having to explicitly running installers or un-packing compressed files or worry about

file locations and paths. You can access the Install Modules dialog from the menu File -> Install

modules...:

To install a module just drag-n-drop the files you downloaded onto this window (or click the Browse...

button on the top to select them) and click the Install Selected modules... button.

This method of installation provides several advantages:

You can drag many different kind of files, including the official .exe files you download from

theWord site, all kind of archives (.zip, .7z, .rar, etc) and all kind of modules files (.ont, .twm, etc). 

You can automate the installation of multiple files in one step. For example, you can download 10

modules from the official site and drag them all in this dialog to be installed. For archives that

contains multiple modules, the same will apply.

You don't need to run .exe files and run in any problems with Anti-Virus programs.

You don't need to specify the location where the modules should be installed. If you have

multiple installations of theWord on your PC, you can install the modules in the correct installation

because you can do that from within theWord installation that you want.

The integrated installer will also handle archives with a password: if an archive has been password

protected, a dialog will appear to prompt you for it.
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TIP: If you have downloaded an uncompressed module file (e.g. .ont, .twm, etc

file), then double-clicking on it will popup this dialog and allow you to install it.

Archives  modules with - the .twzip extension

Archive files with the extension .twzip can be used to easily install modules you may download. 

These are standard archive files (can be zip files, 7z files, etc) but their extensions have been changed to .

twzip. theWord associates .twzip files with itself and so you can just install these files by double-clicking

on them.

TIP: Notice that if you want to install a .twzip file on a USB Flash drive, then

theWord must be running before you double click on the .twzip file (obviously

you should be running theWord from the USB Flash drive).

Download/Update Modules from Official Repository

Overview

Finding resources to install or update from the Official Repository

Installing free resources

Purchasing resources

Recover Unlock data

Overview

theWord has an Official Repository of maintained resources (Bibles, Books, Commentaries, Dictionaries,

etc) that can easily be installed and checked for updates from the Download Titles dialog, which you

access via the Add Titles, on the main menu.

Below is the default appearance showing the content of the Official theWord Repository. Third-parties

can create repositories that can be accessed via this interface, the details of this are covered in a

separate document. As of November 2015 there is just this repository available.
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Key: 

Resource is already installed

Resource not installed

Resource has an update available for download

Finding resources to install or update from the Official Repository

Here you can group, and filter the resources, by typing in the Search: area. You can filter the resources in

real-time by any partial data matched in each row. This can be further grouped/filtered by the options in

the menus under the links:- 

Show all titles -> 

Show titles not already installed

Show titles for which a newer version exists

Show New Titles (added in the last 30 days!)

Group by Type ->

Group by language
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Group by author

[No Grouping]

Installing free resources

Once you have located one or several resources, simply click in the box at the left. You can select more

than one item to download at a time.

 

Now just click on and follow the prompts. Once theWord restarts your new

resources will be available.

Some third-party purchases do not have a download checkbox.

Some third-party purchases do not have a download checkbox. A link to their site is provided in the left

window for purchase and download. Installation instructions will be their responsibility.

New and updated resources

From version 6 of theWord a menu item, New Titles... will appear in the Main menu. It will indicate that

new and updated titles for the past 30 days are available. Hovering New Titles will show a hint as above,

showing some new/updated modules. Clicking the New Titles item will do two things. 1) Take you to the

Download Titles dialog. 2) Set the New Titles to not show again for the next 7 days.

Once in the Download Titles, you will see just the new and updated modules for the past 30 days
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available for you to download. Any New Titles you have already added within the last 30 days will not

appear.

Download Titles

Purchasing resources

For example, to purchase the above, NET Bible, select the item and click on the link Purchase Online:.

This will take you through the purchase process, after which you will receive the unlock data via email.

Now you will be ready to download the resource, by checking the box in the left column, then click 

Download and Install. When the download is complete you have the option to restart theWord after

which you will have to enter the unlock data for the purchased resource. See Paid Modules.

Recover Unlock data

If at any time in the future you loose your unlock data it can be e-mailed to you again: follow this link.

http://www.theword.net/recover
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General Concepts

Views

theWord utilizes windows, called Views, as it basic structure and layout.  Views are rectangular areas

within theWord's main window that are dedicated to a particular function.  There are five separate views

in theWord.  They are:

Bible View

Bible Search View

Book View

Book Search View

Bible Tree

theWord allows you to create more than one Views of each type (with the exception of the Bible Tree

view). As you learn to use the program, you will find this ability very useful. You can use layouts to save

and restore a specific arrangement of views, and their settings.

Views are automatically organized in theWord's main window.  Any of the Views can also be detached

from the main window, making the View float.  Otherwise, the Views are docked to theWord's main

window.  Each of the Views are color coded, with the colors appearing in the window buttons, title bars,

etc., as follows:

Bible View - blue

Bible Search View - green

Book View - orange

Book Search View - purple

Bible Tree - yellow

Each View displays particular type of information.  For instance, the Bible view displays (obviously) the text

and related options of Bible modules: this information is organized into tabs (or buttons).  In the Bible

and Book Views, these tabs represent each individual Bible or module.  This is essentially the visible

library.  Each view has a specific menu (called View Menu) for its layout and placement.  This is found at

the top left of each view, (the little arrow).

View Specific Menu (at left)

Each View can be maximized, restored, or closed.  This is done via the buttons at the top right of each

View.

Close and Maximize View Buttons

As you will learn later, these Views can be organized, positioned, restored, and manipulated very easily

within theWord.  You can find more information in the Views section of the help file.
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Global Preferences

Overview

Global program preferences control the way the program behaves in general and in relation to Microsoft

Windows.  Various other settings are found here as well.  These settings can be found via the main menu: 

File -> Preferences...  Since Clipboard monitoring and Bible texts tab help is found in other topics, they

will not be covered here.

General Tab

General Tab of Preferences Dialog

Start program with Windows causes theWord to start when you start your computer.  You may also

cause it to start minimized by checking the option below.

Minimize window to tray icon will cause theWord to minimize to a tray icon (located in the Windows

taskbar) rather than to a normal button on the Windows taskbar.

Mouse wheel scrolls and activates window under cursor causes the mouse to activate the window

under the mouse so that no clicking is needed to scroll.

The Error handling section describes the procedures theWord takes when there is a problem with the

program. If you check the When an error occurs... option, then the program will automatically send an

email in case of an error. If you want, you can include your email in the text box below in order to be

contacted if further information is needed. The Display dialog to enter... option will display a dialog that

allows you to enter a description of what you were doing in case of an error. Notice though, that this can

be annoying since the program can usually recover from the errors, yet this procedure requires will

temporary distract you.

The When running in compact mode... option refers to which modules theWord uses while running in

compact mode. When in compact mode, by default, theWord will only access those modules that are in

the same folder as the theword.exe file. If this option is selected, theWord will also use modules that may

be found in the default folders of a normal installation.

Fonts Tab
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Fonts Tab of Preferences Dialog

This tab controls several widely used fonts in theWord.

Default Greek font is the font used in the Book View to display Greek content. It is also used in the

display of certain Greek content in the Bible view (such as some Greek words, when the option to display

the original words instead of Strong's number is used, for those certain Bibles that support Strong

numbers).

Default Hebrew font is similar to the Greek font above, only Hebrew.

Default Book View font is the font used by default to display content in the Book View.  See also

Preparing User Modules for Distribution.

Notice that:

All the above font selections may be overriden in the Book view by Book modules themselves. 

User modules (e.g. modules that can be edited) do not necessarily use the above fonts; instead

they are using the current editor fonts. 

Proofing Tab

theWord provides spell checking capabilities for content written in user modules (non-user modules do

not get spell checked). This applies to all types of user modules (dictionaries, books, commentaries,

maps). 

You can set proofing options from this tab, including the languages you want to enable for spell checking.

theWord ships with a dictionary for US-English text, but you can add more dictionaries for any other

supported language. theWord uses the open-source hunspell engine which is used by LibreOffice and

Mozilla firefox (and others).

Advanced Tab

http://hunspell.github.io/
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Preferences .

The first section (Bible view specific -> When hovering over a verse reference, use:) customizes the

way tool tips are displayed.  By default, theWord uses the default Bible (see Bible View) to display verse

texts in tool tips; if you press CTRL while hovering over the link, the active Bible will be used.  You can

reverse this logic by selecting the Active Bible module to display the verse text, or the Default if

CTRL or ALT is pressed.

Display the verse references in these additional translations in popups: Choose Bibles... takes you to

the dialog where you can select Bibles that will appear in popups.
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Choose Bibles

Only display additional translations when SHIFT is pressed. This is a useful toggle for temporarily

viewing multiple translations in the popup.

Show hints when hovering over Bible view module tabs: whether hints will be displayed when the

mouse hovers over the modules tabs/button of the Bible view. 

Use the TAB key to insert tabs instead of navigating through the program controls:Normally, the tab

key is used to navigate through the controls of a program. When the cursor is in an editable topic in the

Book view and this check box is selected, the TAB key will insert a tab character in the editor instead of

navigating to the next control.

Show hints when hovering over book view module tabs: whether hints will be displayed when the

mouse hovers over the modules tabs/button of the Book view. Especially for the buttons of the Book

view, the hints do contain a lot of information about the module, so it may be preferable to leave this

option off.

Keep the focus on the current input box after pressing 'Enter' to execute command: By default, when

you place the cursor in an input box, type something and press Enter, the focus moves to the view/

window that normally is the receiver of the associated function. Check this option if you prefer the focus

to remain in the input box instead. This option affects:

the Verse Reference input box (accessed with F4)

the Bible Search View input box (accessed with F3)

the Book Search View input box (accessed with F2)

the Bible view module search input box (accessed with SHIFT+F3)

the Book view module search input box (accessed with SHIFT+F2)

Show help tips: Check if you want to display help tips when you pause your mouse over buttons and

other controls. This is a global setting and affects every single control and button. Remember that these

tips are very explanatory and helpful in finding out what each button does.
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File Associations Tab

When theWord is installed, it associates certain file extensions (corresponding to theWord modules) with

itself. This means that when one double-clicks on files with one of these extensions, theWord fires up to 

display or install the module(s). From this screen you can select the file extensions that you want

theWord to associate with itself. 

TIP: theWord automatically associates these file extensions with itself so,

normally, there is no special action needed from you. This screen should be

only used to re-associate one of the known extension, in case another program

has overwritten it, or for some other reason the association is broken.

Notice that for a normal installation, these associations will be already in place (so everything here will be

checked), since theWord automatically creates them on startup if they do not exist. Un-checking an item

from the associations list here will not reset the association.

The .twzip files are archives (zip files) that contain one or more modules that should be installed in

theWord. 

There is some special handling for file associations for UFD installations of theWord: since for a UFD

installation no trace should be left on the target PC, theWord will register these associations on startup

and remove them when it shuts down. This allows a UFD installation to properly handle files with these

extensions while running, but removing registry traces when it is shut down.
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Modules

Overview

Modules are individual books or resources that are used within theWord.  Compared to a regular library,

the modules would be the books on the shelves.  theWord has only two basic types of modules: Bibles

and non-Bible (or Book) modules.  See below for more information on modules.

Bible Modules

Book Modules

Official Modules

theWord's website (www.theword.net) hosts all official theWord modules.  They can be downloaded from

the website freely. These official modules have identifiers and are maintained by theWord team. They are

formatted correctly and have been tested. However, users are not limited only to official modules. Users

can make their own modules or share modules with one another. As modules are made by users, shown

to be in the public domain or proper permission has been obtained, and formatted correctly, they can be

submitted to theWord team to be placed in the official library. Our hope is that the library will become a

very rich resource for users. You can go the library here.

Installing new modules

Read the Installing new modules or the Download/Update Titles from Official Repository topic to see how

you can add more modules in theWord.

User and non-user modules, encrypted modules

A user module is one whose content can be edited. You can change the status of a module from user to

non-user and vice versa from the Module properties dialog (Settings/Actions tab, User module (can be

edited) option). You can think this status as a module level property that can be changed if necessary.

The primary reason for the distinction between the two is to prevent the content to be changed by

mistake. Notice that although non-user modules' content cannot be edited, it can be formatted/

highlighted.

An encrypted module is a special case of a non-user module whose content is also encrypted and,

moreover, it cannot be switched to non-user status. Paid modules are encrypted modules that require a

proper unlock key in order to be used. There is no way to edit the content of an encrypted module. 

Storage Locations

theWord can read from several different storage locations to locate modules that can be used in

theWord.  At startup, theWord searches all these locations for new modules and indexes them.  These

locations (on Windows 7) are:

C:\Program Files\The Word

C:\Users\<user>\AppData\The Word

C:\ProgramData\The Word

By default, official modules downloaded from theWord library are installed in the third path in the list

above.  User modules should be stored in the user's personal path, which is the second path above.  All

of the user's installed modules can be found in theWord via the main menu: Help -> About... -> File

Locations tab.  More detailed and technical information on module storage locations can be found at

this page on theWord's website.

Deleting a module

http://www.theword.net
http://www.theword.gr/index.php?downloads.modules&l=english
http://www.theword.gr/index.php?article.tools&l=english
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To delete a Book module you can right-click on the module's tab and click on the Delete menu.

There is no direct way to delete a Bible module from within the program at this moment; yet, since, each

module corresponds to a single file on your disk you can just delete the corresponding file.

To delete a Bible module:

1. Right click on the module tab and select Info...

2. At the bottom of the info dialog notice the full path to the module: You can open a window to that

location by clicking on the ... icon.

3. Close theWord and delete this file using Windows Explorer.

To delete a Book module:

Right click on a module tab and click on Delete module... 

Encrypting a module

theWord allow you to encrypt a module if you want to distribute it but do not wish for the end user to be

able to change it's content. To do so, you will need to invoke the following command from a DOS

command prompt:

for a Bible module: 

theword.exe -encrypt "filename" [-maxverses xxx] 

The -maxverses argument is optional and defines the maximum number of continuous verse that

can be copied in a single step from the Bible. The value used by default for official encrypted

Bible modules is 200. 

for a Book module:

theword.exe -encrypt "filename"

In the case of a Bible module, the result is an encrypted module file with the letter x appended to it's

extension. Notice that the first time an encrypted Bible module file is opened by theWord, it is indexed

and its size grows significantly, so if you want to distribute your encrypted module file do not run

theWord after the encryption!
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In the case of a Book module, the result is an encrypted module file with the phrase -encrypted

appended to the filename (the extension will not change, it will remain .twm).

TIP: Encrypting a module prevents it from later being compressed. This is an

inherent property of the encryption. If you plan to distribute your module (and

obviously you would want to compress the file before you distribute it), you will

not be able to do so effectively. In order to circumvent this it is better to

compress the module from within theWord before encrypting it. You can do so

from the Module Properties dialog, Settings/Actions tab, Module is

compressed (to save disk space) option.

Also, make sure to execute the action Prepare module for distribution...

before doing so, so that unnecessary search data are removed from the module

prior to distribution (this will further remove it's size). See Preparing User

Module for Distribution.

Bible Modules

General Information

Bible Modules are the types of modules that contain the text of a Bible.  These modules, under the hood,

are simply properly formatted text files.  Bible modules come in three types:

1. .ont files - These are modules that contain both the Old and New Testament text.

2. .ot files - These are modules that contain only the Old Testament text.

3. .nt files - These are modules that contain only the New Testament text.

If a Bible module file is encrypted, then its extension will have an extra x at the end (e.g. .ontx, .otx, .ntx). A

module may be encrypted either due to  copyright reasons or because of the author's request, or both. 

Go here for more information about encrypted and/or non-free modules.

Bible modules' Bible text contains exactly 31,102 lines (for .ont files).  These are formatted using tags

similar to, but not the same as, html.  They are custom tags read only by theWord.

The Bible View (see General Concepts) displays all .ont, .ot, or .nt files found in theWord's known folders.

Though many hundreds of Bible modules may be installed and used in theWord, the user has complete

control over which modules are displayed in the Bible View(s).  See the Bible View section to learn more

about displaying and hiding Bible modules.

About Info

From the Bible View, the user can find some general information about each displayed Bible module.  This

is done by either right-clicking the Bible module's tab and selecting Info, or by clicking the Organize

button to the left of all the Bible tabs, then clicking Info.

Bible View Organize
Button (at left)

Once opened, the menu looks like this.
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Bible Module Organization Menu

The About or Information dialog contains pertinent information about that specific Bible module,

including the version number, unique official identifier (if applicable), and the path of the actual file on the

disk.  See below.

Advanced Information

Advanced information for Bible modules, including specifications, all supported tags, etc., can be found at

theWord's website here.

Book Modules

General Information

Book modules are also called non-Bible modules/resources.  Any resource that is not a Bible can be used

in a book format.  Book modules are, under the hood, simple database files (the sqlite3 database format

is used).  Book modules are somewhat more complex than Bible modules files.  All Book modules are

basically the same kind of file (e.q. sqlite3 databases).  However, depending on the specific use of the

module, the formatting changes some.  Specifically, there are six different kinds of Book modules.

Dictionary modules

Commentary modules

http://www.theword.gr/index.php?article.tools&l=english
http://www.sqlite.org/
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General Book modules

Map modules

Devotional Modules

Reading Plan modules

In reality, these modules are very similar in structure. This is especially true of dictionary, general book,

devotional and map modules. The difference in the names is primarily for organizational purposes.

Further, all Book modules have a file extension of .twm. There is an extension prefix of .dct, .cmt, .gbk,, .

map, .dev or .rdp respectively to help organize the modules. Book modules fully support rich text editing

and displaying, rich hyper linking capabilities, drag-n-drop for topics, and the use of tables and images.

See Creating a User Module for more information.

The distinction between User and non-User modules is that User modules can be edited. In fact, for non-

encrypted modules, you can change this attribute in any existing module from the Module Properties

dialog.

Module Properties

The Book View, in a similar way to the Bible View, displays all installed non-Bible resources. Also similar to

the Bible View, several module properties can be displayed and edited for each module. This is done by

pressing the Define Module Sets icon on the Book View:

Module Sets Icon
(at left)

From there, the menu appears, select Module Properties...

Module Sets Menu

You will see the Module Properties Dialog.  This dialog gives much information about the module itself,

many actions that can be performed on the module, and displays Information about the module (About

tab). For more information, see the section on creating user modules.
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Book Module Properties Dialog

For Reading Plans, there is a different page in this dialog as follows:
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Advanced Information

For users interested in advanced information regarding Book modules, please refer to the Book module

specification documentation found on theWord website here.

User Modules

Overview

User modules are Book modules that can be edited.  You can create commentaries, dictionaries,

general books, maps, etc.  Some of the editing features include:

Full image support

Advanced hyper linking to Bibles, topics within the module, other non-Bible modules, websites, files

on the host computer, etc.

Automatic Verse Recognition

Bookmarking

Full rich text formatting.

Drag-and-drop of topics.

Simple copy and paste from Wordpad or Microsoft Word with format preservation.

User modules are identified in the Book View by the edit icon next to the module abbreviation in the tab

bar . 

Default User Modules

http://www.theword.gr/index.php?article.tools&l=english
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When you first install theWord, two user modules are created to help you write your own notes on verses

and on topics. They are called My Verse Notes and My Subject Notes.

You can access these modules from any Book view and use them to write your own personal notes.

Notice though that these two modules are identical to any other user modules you can create for yourself

at any time. Actually the My Verse Notes is just a commentary, whereas the My Subject Notes is a

Generic book.

Read on to find out how you can create more user modules

Creating a New User Module

To create new user module, go to the main menu: File -> New user module...

New User Module Dialog

In this dialog, you will need to choose the type of module that you want to create.

Commentary modules enable you to make comments on verse, verse-range, chapter, and book

levels.  The comments follow the structure of the Bible's divisions, just as in a printed commentary.

Dictionary modules are general one-word, or multiple word entries, that do not have a tree

structure.  This means there is only one level in the structure.

Generic book modules have a tree structure in which topics are found within other topics, etc.

There is, in reality, no difference between a dictionary and generic book structure. They are divided

for organizational purposes for you. Generic book modules include all kinds of other modules:

such as, charts, maps, devotionals, etc.

Map or images modules are identical to Generic book modules; the only difference is that they are

marked as such so they can be grouped separately in the Book view tab bar.

TIP: To create a Reading plan you need to go to the menu File -> New Reading

Plan.

In the second section, fill in the Abbreviation, which is the name that will appear in the Book View tab bar.
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The Title is the full name of the module. This is also the name used as the filename of the module.

The Description gives a brief description of the module that is displayed when you hover the mouse over

the tab in the tab bar.

The Path should be filled in automatically with the filename when you enter a Title. You can change the

default path where the new module will be created by clicking the button at the right of Path.

Once you press OK, the module should be successfully created.  You should see the dialog below and

the Book View that contains the new module should be highlighted.

New Module Successfully Created

Adding/Editing Topics

Adding/Editing Topics

Topics can be edited in two ways:

1. Via the Add New Topic icon in the Book View.

2. Via the topic content area in the Book View when there is not a topic selected, or the topic is

currently empty.

For Commentaries

For commentaries: Press the Add New Topic icon, the following menu appears:

Add/Edit Topic

From this menu, you can add a new topic.  The first selection will bring up another dialog that will allow

you to select the verse or verse-range to which you want to add a comment on.

The second selection above allows you to add a comment on the current topic.

The third selection allows you to update the reference that a topic is associated with.

The final selection deletes the current topic.
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Select Verse for Comment Dialog

This is the universal dialog to select the verse reference or range to which to add a comment.  Notice,

you may add comments for a single verse, a verse-range, a chapter, and an entire book.  

You may also add a topic from the topic content area by clicking on the proper link:

Add Topic

From this list of links in the topic content area, you may add comments for the active verse on the verse,

chapter, or book level.

For Dictionaries or Generic Books

From the Add New Topic icon, you may perform the following actions:

Add/Edit Topic

From this menu, you may add a new topic in the first selection.

The second selection changes the current topic's subject.

The third selection deletes the topic.
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Add New Topic Dialog

In this dialog, you will enter the title of the topic in section 1. In section 2, if applicable, you will pick in

what position the new topic will appear in relation to the current topic. This position could be a sibling of

the current topic (same level, before or after) or a child (lower level).

In the topic content area, you may also add entries.  See below:

Add Topic

You may add a new topic for the module by clicking the second link.

Changing Topic Positions

You may easily change the position of a topic in dictionaries or general books by simply clicking and

dragging the topic name in the topic list to the new location in the topic list.

Adding/Editing Content

Overview

The Book View supports a great deal of rich text editing.  Many of these editing feature are available in

theWord via the Formatting Toolbar.  However, there are some other formatting features that are not yet

included in the toolbar.  These features will eventually be available from within theWord.  Until then, if

there is other formatting that you would like to use, you can copy and paste from Wordpad, Microsoft

Word, or other text editor.

Formatting Toolbar

The Book View has a formatting toolbar to use to format the content of entries in the Book View.  This

toolbar usually resides just under and to the right of the main menu.
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Book View Formatting Toolbar

This toolbar contains very familiar formatting tools for anyone who is familiar with a rich text editor. In

case of a non-user module, the toolbar has less options, please see the User Formatting section for

details on non-user module formatting. The hyperlink button (bottom row, second from the end) will

display the Hyperlink Dialog.

Insert Manager

The Insert Manager dialog allows you you to insert snippets of information that you might frequently

reuse. You can access it by right-click on the book view reader and selecting the Insert menu from the

popup.

Examples

To make a snippet for "system time am/pm"

Enter in the Description what the snippet is about

Click on the button, Symbols and navigate to, Symbols ->clock -> system time am/pm, and click.

This will input placeholders (Indicated by a % at each end) into the Insert Value area.

Now click the Add button, and you will see your first snippet has been saved.



30

By pressing the Insert button the selected snippet will be inserted at your present cursor position.

The Help button will show some other useful placeholders that you can manually input as an Insert Value

to construct snippets, that have amongst other things Tabs, and New lines, allowing the use of plain text

data as well, where you have fixed values like a list of names etc. It is up to you how creative you are with

this feature.

You can access more formatting tools for the current Paragraph, Border, and Bullets/Numbering by right-

clicking on the content area of the Book view and selecting the menu items Paragraph..., Paragraphs

Borders and Background..., and Bullets and Numbering...:

Tables Tables are easily inserted and manipulated.
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Saving Content

As you type content into the topic content area, theWord saves the content in real time.  There is no need

to save the content.  If you make a mistake, the well-known CTRL+Z (undo) option is always available.

Setting the Default Font

To set the default font and font-size used for new topics do this: create a new topic and immediately

(before typing anything) change the font and font-size to the one you want to be the default for all other

new topics. theWord will remember this selection and use this font and font-size for new topics.

Hyper linking

theWord features Automatic Verse Recognition and advanced, manual hyper linking. See these related
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sections.

Find and Replace

You can perform a Find and Find & Replace in the current topic by right-clicking on a word and selecting

from the popup menu:

The following dialog appears:

This dialog allows you to find a word in the current topic, or find and replace it with another.

Image support

theWord supports the most common types of images. You can embed an image in any module topic

either by selecting the Insert a picture from a file... button from the formatting toolbar ( ), or by drag-

n-dropping an image in the content area of the Book view. The supported image types are bmp, jpg, gif,

png, wmf including transparency. The viewer supports smooth image resizing as well as auto-resizing of

images for non-user modules. 

When moving the mouse over an image, a button appears at the top-left area of the image that provides

access to a number of image-related functions.

Specifically:

Display in Graphics Viewer opens the image in the Graphics Viewer

Original size restores the image to it's original size (notice that you can resize an image by

dragging one of the size handles -black squares- at the edge of an image).
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Fit to page resizes the image so it fits in the visible area of the viewer

Auto resizing allowance controls how this specific image behaves when the module is viewed in

non-user mode. By default, when you view a non-user module, the images contained within are

resized to fit the viewer available area. You can control whether image resizing is allowed on the

module level from the Module Properties dialog, Settings/Actions tab, Allow auto-resizing of

images option. This option allows you to override the default behavior of the module on a per-

image basis. 

Always allow auto-resizing this image will cause the specific image to be resizable, even if

the module level property above is not set

Never allow auto-resizing this image will cause the specific image to not be resizable, even if

the module level property above is set.

Remember that whether images are actually resized and how on the view level is controlled from the 

icon on the book view toolbar.

TIP: In order for an image to be auto-resizable, it must not have any text before

or after it and should not reside within a table. Even a single space before or

after the image will cause it to not be resized. Keep this in mind in case you

don't get the behavior you expect!

Adding/Editing Module Properties

Overview

The Module Properties dialog gives much information about the module in general. Just as with an official

module, user modules have properties. These properties can be edited by the user, when a module is

editable (user module).

The Module Properties Dialog can be accessed most easily by right-clicking the module's tab, and

selecting Module properties...

Module Properties Dialog
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Module Properties Dialog

In the Properties tab, the first section, General properties and information, gives information that you

would find in the printed edition of this work.  The Language box uses the ISO 693-2 codes. Clicking the

link to the left will take you to a web page that shows these codes.

The System properties section is non-editable. It contains information about this module on the

computer.

If you scroll down, you will see the Electronic text module properties section. This information is

specifically for the electronic edition of the module, not the work itself. Sometimes, electronic and printed

editions will have the same information, if they were produced both in printed form and electronically

concurrently. Status refers the status of completion or non-completion. If the module is not yet complete,

you may put "incomplete" in that area. The Editorial comments and version history is an area where

you can elaborate on version changes or any necessary information that a user should know, especially

before editing the module.

In the About tab of this dialog, you should put relevant information for this module, especially copyright

information, biographical information, prefaces, etc.

For the Settings/Actions tab, see Preparing User Module for Distribution section of this help.

Preparing User Module for Distribution

Overview

Because there is no technical difference between user modules and non-user modules, making your own

modules, or compiling modules for an electronic source, and preparing them for distribution is easy to

do.  If the content of the module does not belong to you, you must check to ensure that you either

have permission to use the content from the copyright holder, or ensure that the module is in the
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public domain.

The Settings/Actions tab of the Module Properties Dialog performs many last-minute tasks easily before

distribution. The Module Properties Dialog can be accessed most easily by right-clicking the module's

tab, and selecting Module properties...

Setting/Actions Tab of Module Properties Dialog

The User module checkbox determines if the module can be edited by the user. This should be the last

step taken before distribution.

Allow auto-resizing of images: check this if you want the images of the module to automatically fit the

reading space. 

Module is compressed (to save disk space): this option compressed the module to about 50% of the

original size. You should always choose to compress a module that you will encrypt. If you don't need to

encrypt a module, you may leave this option unchecked since an installer will usually compress the

module much better and make it easier to distribute.

Compress also search data (will result in slower searches): select this option if you want the search

index to be compressed. This option only saves space in the end user's disk. It may be useful to select

this option for really large modules.

Module uses right-to-left alignment: select this if the content of your modules is in a right-to-left

language (e.g. Arabic)

Show hidden topics: Hidden topics are an advanced feature that is only used for very specific purposes:

do not check this option unless you are debugging/preparing your modules (read the Book modules

specification more info on hidden topics).
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Contains Strong's definitions, Contains morphological codes: these options should be checked for

special types of modules that contain Strong's definitions of morphology codes.

In the fonts section, you can customize the way a user views the content of the module.  These two areas

are only editable after you have deselected the User module selection above.  Use the fonts that are

defined in the module uses the fonts you selected when you were making/compiling the module. It will

override the user's Book View font setting (which can be found under File->Preferences->Fonts). The

Use the default Book View fonts selection will use the font that the individual user has selected as the

default font for the Book View.  The Do not substitute the following fonts area is especially useful for

the second selection when you have special fonts that should not be substituted (e.g. Cardo and Gentium

fonts that are usually used for Hebrew and Greek words).  If, for instance, you use a language in your

module that requires a special font, but the normal content is a common font, you want to input the

special font's name in this area so that the user's default font is used, except for instances in which the

special font must be used.

Topics tree/list font: from here you can select a special font to use for the topic list. This is useful for

modules where the topics are in a language where a special font is required (e.g. Hebrew). You can select

a custom font and a custom font size in that case.

Actions

At the bottom of this tab, you may perform a number of actions on the module that will greatly reduce

the time needed to prepare the module for distribution. 

1. Prepare module for distribution - deletes all the search data from the module and compresses

the module.

2. Detect all verse references - automatically detects all verse references. This is especially helpful

when you paste content while compiling a module. 

Normally existing verse references will not be overwritten, unless you hold down the ALT key while

you initiate this action. 

For commentaries, if you keep the CTRL+SHIFT pressed while initiating this action, partial verse

references (e.g. see also verse 1) will use the context of the current chapter in order to be converted

to links.

3. Convert module content to rtf - in general, reduces the size of the module, apart from changing

the internal storage format to rtf. Since some features are not supported by rtf (potential problems

with tables, esp.), you should make a copy of the module before performing this action. In general

there is no need to perform this action unless you need to have the content in rtf format within the .

twm file.

4. Delete all user formatting from non-user module - deletes are user formatting from the module.

 If you have user formatting in the module, this should be done before distribution.

5. Make permanent all user formatting from non-user module - causes all user formatting of the

module to be made part of the module permanently.

6. Recreate the search index for subjects - recreates the index only for the subjects. This is useful if

there is a problem that arises with the topic subjects. This index is different from the topic content

index.

Paid Modules

Overview

theWord supports paid modules. These modules are strongly encrypted and have certain copy

protections.  They are also subject to copyrights and usage restrictions. Once you pay for the paid

module via theWord's website, you will receive a confirmation email for your payment and an email with

the link to retrieve your unlock key for the module. Go to the link, enter the information used to purchase
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the module as required. You will then be sent the unlock key and download link. The instructions on the

website are very thorough and need not be covered here as well.

Unlocking a Paid Module

Close theWord (if open). Run the installer for the new paid module to install it. Re-open theWord.

Once you re-open theWord, you will prompted to input the unlock code and registration information as

shown below:

Locked Modules Prompt

When you press Yes, you will be shown the Unlocked Purchases Modules dialog.  If you select No in the

above prompt, you may access the Unlocked Purchases Modules dialog manually via the main menu: 

Help -> Unlock modules...

Unlock Modules Dialog

The module(s) that you have purchased that have not yet been unlocked should be in the selection box at

the top. Select the module you want to unlock.

Enter the Unlock Key from the email you received. It is best to copy-and-paste to ensure no errors are

made.
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Enter the Full Name as it appears on the email you received.

Enter the Email as it appears on the email you received.

Select the Unlock Module at the bottom of the dialog to unlock and you should see the prompt below.

Unlocked Prompt

You will then see the Book or Bible View where the module is displayed shaded and a message saying

that the module was successfully installed. You may begin using your new module.

Locked modules warning dialog

Locked modules warning dialog

This dialog appears if you have purchased at least one module and you make an attempt to use this

locked module in a different computer than the one you registered it. For example, this can happen if you

have installed the software on a USB flash drive and you insert it in a different computer, or if you format

your hard drive and restore your installation from a backup. Please, consult the standard module license

agreement for details on how you are allowed to use paid modules.

The reason this dialog appears is because copying paid modules to different computers is prohibited by
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the standard license unless you own this computer and you use it yourself or for your immediate family. 

In case this dialog appears (which can happen for valid reasons) you will need to enter the email you

used when you registered the paid module in the appropriate input box(es) (marked with the red-

rectangle above). You will need to enter the correct email for each module (in case you have used the

same email for all your paid modules you can simply check the Automatically verify all modules that

are registered with the same Name and Email in order to avoid typing the email many times -if it is the

same).

Once you enter the appropriate info press the Continue... button. 

If you are not the legal owner of the paid module then you should leave the corresponding fields

empty! In that case the paid modules will get unregistered since it is the legal and moral thing to do. The

following dialog will appear:

Warning dialog if you are not the legal owner

Why should you prayerfully proceed with honesty in such a situation!

The following message appears if you click on the Why I should be honest in filling in this form? link

on the dialog: it is repeated here for honest contemplation.

Please consider with prayer

The content of the modules listed are the property of the respective copyright

holders. Permission has been granted to theWord to distribute these modules

for a fee and to be used only for private purposes by the payer.

Violating these conditions by distributing these locked modules and/or

providing the means to unlock them is dishonest and a form of theft.

Owning a hard copy of a copyrighted work does NOT entitle a user to have an

illegally distributed electronic form of that work. God commands us in Romans

12:17, to "provide things honest in the sight of all men." It is dishonest to take

the work of another that is protected by an exclusive right to reproduce,

electronically or otherwise, and distribute it without permission.

Further, for those that do steal, they are commanded in Ephesians 4:28, "Let him

that stole steal no more". Illegitimately distributing and using a copyrighted work

is truly the equivalent of stealing from the copyright holder. The profit that the

copyright holder would have gained by the purchase of the work is lost. Please

respect these copyrights. "Thou that preachest a man should not steal, dost thou

steal?"'
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Please, remember that by respecting the copyright of the publishers and other contributors you

encourage the continued development and production of such material. 
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Views

General Information

Views in theWord are rectangular areas within the main window that serve a particular function within the

program.  For instance, the Bible View functions to display the texts of Bibles, etc.  The Views can be

manipulated very easily within theWord. 

Available Views

There are five Views used by theWord.  Each of them is color-coded to aid in reference.  Each View

serves a particular purpose within theWord.  See the chart below for the color codes and purposes of the

respective Views.

View Color Code Purpose

Bible View Blue To view Bibles' texts

Bible Search View Green To search Bibles' texts

Book View Orange To view non-Bible resources and/or create/edit user modules

Book Search View Purple To search all non-Bible resources

Bible Tree Yellow To navigate through the Bible text

The easiest way to create a view is from the Window menu. There are also available shortcuts to do so.

The style of the colored caption can be changed from the View Menu (see below). You may even turn off

completely the coloring of the captions, or even the captions themselves.

You can toggle the caption with or CTRL+F6 or by pressing on the button  on the main toolbar.

View Tabs

The Bible and Book Views have tabs or buttons that display an abbreviated name of a Bible or Book.  To

view that particular resource, simply click the tab to display that resource.  This is the user's bookshelf so

to speak, where all the titles can be seen and selected.

Manipulating Views - Active Views

Views can be created dynamically from the Window menu. You can have more than one views of each

type visible at any time (except for the Bible Tree View). 

theWord uses a unique way to indicate which is the Active view at any one time. Unlike other applications

where there is only one active window, theWord has one active window per view type. This means, that if

you have two Bible views open and three Book views, there is always one active Bible view and one active

Book view. The active views are easily discerned because their captions are painted with a more intense

color. Clicking on any view, will cause all other views of the same type to get 'deactivated' (their captions

fade). Most operations in theWord that target a view occur on the currently active view. For example, if

you use the Bible tree view to navigate to a verse, the active Bible view will be used to display the verse

you selected. If you click on a link to display a topic from a commentary, then the active Book view will be

used to display it. 

TIP: At any time you want to execute an action whose result will be the display of

some content in a view, you should first click on the desired view that you wish to
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be used and then perform the required action. Whenever you are in doubt

"which view will be used if i do this", the short answer is "the active one", or "the

one whose title is brighter than the others of the same type".

Try this: open two Bible Search views by clicking twice on menu Window -> New

Bible Search View. Then, go to a Bible view, right click on a word and from the

popup menu select the first option "Find [word]". Notice that the active Search

View will be used to execute the search operation. If you want to make another

search but keep the search results of this search query, just click on the second

Bible Search View and repeat the operation: notice now that the second Bible

Search View will be used. Notice also the titles of the two Bible Search views to

see the difference in the color that indicates which one is the active.

Views can be easily manipulated within theWord.  Views are normally docked in some sort of layout,

according to the user's wishes.  Views can also be detached from the main window to float.  This is done

simply by clicking and dragging the title bar of the View (notice that the titles must be visible to do so,

use CTRL+F6 to toggle the visibility of captions).  The View will move where you mouse moves. You can

freely rearrange the views within the main window by dragging it to another place.

TIP: if you hold down the CTRL key while you drag a view, it will not get

automatically docked in the main window (will remain floating). This allows you to

move it freely over the main program window without worrying of it getting

docked to an undesired place.

A View can be resized by holding down the mouse at the edge of it and dragging it (notice the mouse

pointer changes to a double-edge arrow in that case to indicate the you can resize the View). As a view is

resized, all other views in the main window are equally resized to fill in all available space of the main

window.

Views can also be maximized.  This is done in two ways:

1. Double-clicking the View's title bar, or

2. Clicking the maximize button at the right side of the View's title bar.

To restore a maximized View, simply double-click the caption bar of the view or click the restore button

(which is at the same place as the maximized button).  You cannot maximize a floating view. You cannot

also maximize the Bible Tree View.

Creating new views - inheritance of options

You can create new views either from the Window menu, or by using the available shortcuts. The

following table lists the shortcuts used:

Bible view Bible Search view Book view Book search view

Create a new one F11 F10 F12 F9

Create a new floating

one

SHIFT+F11 SHIFT+F10 SHIFT+F12 SHIFT+F9

Navigate CTRL+F11 CTRL+F10 CTRL+F12 CTRL+F9

Close view CTRL+SHIFT+F1 CTRL+SHIFT+F10 CTRL+SHIFT+F12 CTRL+SHIFT+F9
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1

Each view has a number of options that you can set in order to match your preferences. 

There are always 2 ways to create a view:

either with the shortcuts above (or the menu Window), or

by clicking on the New Window button that exists in all view (e.g. for Bible view: , similar icons

for other views)

Notice that there is a difference in the initial settings of the new view that depends on which way you

created the view:

if you created the view from the menu Window (or the above shortcuts) then the new view will be

initialized with the settings of the last view that you closed. So, if you just closed a Bible view

window were you have customized with specific setting, clicking on F11 will recreate the exact same

view.

If you use the New Window buttons on each view, then the new view will have the same settings as

the view you clicked the button on (e.g. a duplicate of this view will be created). This is important to

understand in order be able to easily duplicate the options of your views.

TIP: To see how options of each view are inherited to newly created views, do

the following: open 2 Bible views and in one of them change the background

color (this can be done from the menu Tools -> Bible view options, Fonts

colors and styles category, Default background color setting). Now, click on

one of these views and press F11 to create a new Bible view: notice that the new

Bible view will have the same background color with the view you clicked on just

before you pressed F11. Close this view (from the X button on the top-right of

it's caption) and now click on the other Bible view and repeat. Notice that the

new Bible view will now have the background color of the second Bible view. 

Remember that all settings of the active view are inherited to a newly created

view (for each view type). Moreover, remember that if you close all views of the

same type, the last one you closed will be used as a template the next time you

create a new view of the same type.

You can save and restore the entire set of views by using layouts. 

View Menu

Below is the View Menu.  You can access it via the button shown.

View Menu
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The first option in this menu is obvious.  

The second option allows the user to dock the View to the yellow areas shown. You can use this menu,

instead of dragging a view with your mouse, if you find it difficult to place a view at the exact position you

have in mind. As you hover over this menu, a shaded rectangle will appear on the main window indicating

the place that this view will be docked.

Dock Menu

The Caption Color menu allows the user to change the look of the title bars of the menus according to

predefined schemes and select to show title bar icons for menu, maximize, and close.  Try them out to

see which ones you like best.

The Restrict floating windows within screen,  forces floating Views to stay within the monitor screen (in

a multi monitor setup, you are still able to drag the floating views to a different monitor, yet they will

always remain within the limits of the monitor).

Arrangement of Views

The different views can be arranged in theWord in the way the following diagram displays:
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Views Arrangements

The gray thick-border rectangles display the pre-defined areas where views can be placed/docked.

Notice for example that the top and bottom rows extend to the full width of the main window, unlike the

left and right columns that will not extend to the full height, if there are views in the top/bottom rows.

The green thin-border rectangles display possible placement of views, and how they will be arranged in

the pre-defined dock areas.

Advanced panel settings

Show local minimize/maximize buttons

In the above diagram you see, for example, vertical views (thin green lines) stacked vertically within the

individual panels (thick gray lines). By turning on the option to Show local minimize/maximize buttons

 

 You can manipulate all the views in a panel to maximize and restore within that individual panel. Note

that the feature is implemented as it is, so there are some anomalies, but has been included at the

request of some experienced users willing to accept it as it is.  
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Suggested usage

Here is a layout using the three horizontal panels (thick grey lines) with views docked in each panel like

so; three, two, two. Now it is easy to maximize and restore a view within its panel. It is best to stay with

these two actions and just toggle the view so you get this effect.

Views Arranged as Normal in Panels

As shown below, one view in panels one and two, have been maximized using the local maximize icon

To return the view to the previous state simply click the restore view icon of the maximized view
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Views in a Maximized State Within Two of the Panels

Bible View

General Information

The Bible View is the most important of the Views because of that which it displays—God's Word. A new

Bible View can be made by simply pressing the shortcut F11. The Bible View has a myriad of options and

customizations. Many of these can be found in the Bible View Menu.

Almost every aspect of the display of the Bible view can be customized and all additional information can

be switched on/off. This allows you to customize very easily how the Bible text is displayed and what other

options are displayed along with the text. For example, you can easily turn on/off the Strong's numbers

by pressing S on your keyboard, or to show/hide the footnotes with the F key. 

The caption of the Bible view displays the current verse and translation. The current verse of the active

Bible view is also displayed in the program's button on the windows taskbar (theWord allows you to run

at the same time multiple instance of the program, so this helps to distinguish one from the other).

TIP: To get the most out of theWord, it is also important to understand how

Views are synchronized! Clicking on a word in the Bible view or changing the

active verse may cause other views within theWord to get updated! Read the 

View synchronization topic to understand this subject.

Bible reading, default mouse operations and behavior

To start reading the Bible, just click on the Tab/Button on the top of the Bible view to select the translation

you want and use one of the several methods to navigate to the desired book/chapter/verse. You can use
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your mouse wheel to navigate to the previous/next verse. The active verse is highlighted with a darker

shade of the background color to help you identify the location you are reading (you can change this

behavior of the mouse wheel from the Bible view options dialog -> General behavior category).

If you hover your mouse over a Bible tab, you will get a popup that displays some quick information for

this translation. The tabs that represent the Bible modules usually use small abbreviated titles in order to

make it easier to fit many translations in your views (you can change these abbreviations to more

descriptive ones if you want from the Show/Hide Bible texts dialog).

Clicking on a word in the Bible view causes the current Dictionary entry to change to that word. This

operation will cause all linked Book views to update their content and/or tabs depending on whether they

contain an entry for the word you clicked on. Every time you change the active verse of the active Bible

view, you also cause all linked Book views that contain commentaries to get updated. Read the View

synchronization topic to understand how this works (notice that you need at least one Book view open for

this function to work properly).

Notice that the status bar of the program displays at all times the current dictionary word (Dct) and

current commentary entry (Cmt):

The last rectangle of the status bar displays the current verse along with the current Bible abbreviation:

click on it to copy the verse reference; hold down the CTRL key to exclude the abbreviation.

Bible View context menu

Right-click on any word in the Bible view to get the Bible view context menu. The following popup menu

appear when you right-click on a word in the Bible view (if you right-click on white space, some of these

options will not be available). 
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Bible view context menu

Multiple views sub-menu

The options for this menu are as follows:

Find [...]: there may appear one or more items with the Find [...] caption depending on the module you

use and the word you click on. At minimum, one Find [...] item will appear containing the word you right-

clicked on, or the current selection (if one exists). By default, theWord uses an advanced word-break

algorithm to determine the boundaries of the word you clicked on, yet for some "exotic" languages, this

algorithm may fail to understand where a word ends (especially in languages that use non-standard

word-breaking symbols). In that case, just select with your mouse the letters that comprise the word

before right-clicking.

There may be extra Find [...] menu items that can appear, depending on the support on the module

level:

if the module contains Strong's numbers, a Find [...] item for the Strong number (if there is more

than one Strong number associated with a word, more items will show up there)

if the module contains Morphology codes, a Find [...] item for the Morphology tag

if the module contains Lemma information, a Find [...] item for the Lemma

Clicking on a Find [...] menu will cause the active Bible search view to locate the word you clicked on. If

you have more than one Bible search view, the active one will be used (if you need to select yourself which

one will be used, just click on it before performing the search to activate it). If you have no Bible search

view, one will be created.

Lookup "..." in: there may appear more than one sub-menus below the Lookup menu, depending on the
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word you clicked on. For each Find [...] menu, a corresponding Lookup "..." in submenu will appear. If

only one Find [...] item appears, then the Lookup "..." in menu will not have 2nd level sub-menus, but

will contain a list of all modules that match the word you clicked on. Please, see the How word lookups

are performed? topic to understand how the list with matched topics is generated. Clicking on a topic of

the Lookup submenu will cause a Book view to display the content of this topic.  

Add a cross reference on "..." ...: see Cross-References topic

Copy ...: all copy options allow you to copy one or more verses of the Bible.

TIP: Clicking on the Copy Verses... brings up the Copy Verses dialog. If you

select with your mouse one or more verses before you bring up this dialog (you

can do so with the F5 key also), then the dialog will be initialized with the starting

and ending verse of your selection. This is an easy way to copy fast more than

one verse from the Bible view:

1. select with your mouse more than one verse (no need to be exact with the

selection, just make sure that the first and last verses you want are partly

selected).

2. Press F5

3. Press Enter

Select All...: selects all text in the Bible view

Add [...] to current verse list...: adds the current verse to the current verse list.

Paste [...] to editor: pastes this verse to the selected editor: you need to have at least one Book view

with an editable module for this option to be enabled.

Show [...] in Bible view: this menu appears only if you have more than one Bible view open (the image

above does not show this option). In that case you can select to view this verse in another Bible view.

Bible view options...: displays the Bible view options dialog

Show/hide viewer icons: refers to the vertical toolbar on the left of the Bible view (see below).

Close this view: closes this Bible view. You can press ESC to close any view also.

Bible View Menu

This menu allows you to customize general aspects of the view itself (not the appearance of the Bible text,

which can be customized from the Bible View Options dialog). The Bible View Menu can be accessed in

two different ways

1. Clicking on the Organize icon to the left of the tabs

Organize Icon

2. or, Right-clicking any tab
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Bible View Menu

Set as default allows the user to set the default Bible module. The default Bible module is the module

used to display verse references in tooltips when the user hovers over a hyperlinked verse reference. The

active Bible module (rather than default) can be used by pressing CTRL while hovering over the reference

(this logic can be reversed from the Advanced Tab of the Preferences dialog). The same option can be

set from File->Preferences->Bible texts->Set as default.

In the Title option, the user can change the abbreviation used on the tab for that module in the View (this

can also be changed from File->Preferences->Bible texts).

Info... displays the active module's about box that shows information about the module, the notation

used and copyright information (same dialog can be accessed from the menu Help->Bible Info).

Set tab icon displays the Tab Icon Menu. This menu allows the user to customize the icon beside the

abbreviation for the module in the View. This menu allows the user to place a colored dot beside the

active module, use the flag of the module's language, browse for a custom icon on the computer, or

simply don't use an icon.

Set Tab Icon Menu

Bible View Options... is covered in another topic.  Go to Bible View Options.

Show/hide, reorder Bible texts... is the option to customize which Bibles are displayed in the tab bar.
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See this section about this option.

Tab options allow the user to customize the way the tabs display in the tab bar (multiple rows, compare

and list views, icons, etc.) - menu descriptions are self-explanatory.

Actions for icons deals with whether or not the icons next to the tabs are used and auto-assigning flags

to all tabs. Notice that these options will change the icons of all the tabs, so use with care.

Show/hide view icons turns off and on the view icons to the immediate left of the Bible View.  

Finally, the Bibles' bar background color changes the color of the entire tab bar background.

Bible viewer icons/toolbar

Bible view
icons

The Viewer Icons provide a place near the Bible text to help the user navigate through the Bible. From top

to bottom, the functions are:

Go back to history

Go forward to history

Previous book: you can click on the black arrow on the right for a popup menu of all Books

Next book: you can click on the black arrow on the right for a popup menu of all Books

Previous/Next chapter

Previous/Next verses

Zoom in/Zoom out

Verse Target: Select to make this Bible view a target for displaying verse links. If this Bible view is a Verse

Target, then every time you click a verse reference link, this view will display the verse. If no Bible view is

a Verse Target, then the active Bible view is used to display verse links. 

You should notice the following:

When a Bible view is set as a Verse Target, then it will not produce synchronization events; no Book

views or Bible views will be synchronized while this option is turned on for this view.

The Verse Target view will only respond to verse links: not to the Bible Tree, Bible Search View, F4
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quick access menu

Holding down the CTRL key causes the same Bible view to be used to display a link, even if a Verse

Target view exists.

TIP: Here is what happens if you click on a verse reference:

If a Verse Target view exists then:

o the Verse Target view is used

o the same (originating Bible view) is used if CTRL is pressed

If a Verse Target view does not exist

o the same (originating Bible view) is used

o another random Bible view is used if CTRL is pressed.

New Bible view: create an exact duplicate of this Bible view

Print: if you select part of the Bible text before pressing the Print button, you can choose to only print the

selection.

Grab-n-drag mode: this mode is specifically designed for touch screens and other devices where

navigation with a tap-device is easier. In that mode you cannot make text selection.

Synchronization between Bible views: see below for details

Bible view options: see relevant topic here

You can hover over the icons to see an explanation of each function. The Viewer Icons can be turned off

and on via CTRL+T or within the context (right-click) menu in the Bible View.  

Synchronization between Bible views

This function allows you to synchronize two or more Bible views with each other so when you change the

verse in one of these, the other(s) change also. You need at least two Bible views open for this to work (or

else the corresponding button will appear faded/disabled). 

Click on the black arrow on the right of the button and you will see a list of all other Bible views currently

open; as you hover your mouse over the popup menu entries you will notice that the corresponding view

gets shaded to help you identify it: click on the one that you want to synchronize the current one with.

Notice that the synchronization can be either one-way or two-way! The logic here is that the current view

on which you are performing this operation will be synchronized to the one you selected (e.g. the

current view will follow the changes of the one you selected/clicked on).

If you want to have two-way synchronization, then you need to do exactly the same thing on the other

view, selecting as target this one. You can make arbitrary synchronizations between any number of views

like that.

This button also acts as a switch: pressing it will temporarily enable/disable the synchronization of this

Bible view (without affecting the selections that determine for which other views this one is synchronized

with).
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Bookmarks

Overview

Bookmarks provide a simple way to keep verses of Scripture readily available to switch back and forth

between them.  The bookmarks toolbar can be toggled via the main menu: View -> Toolbars ->

Bookmarks.  Just as any toolbar it can be moved anywhere, be made to float, and positioned horizontally

or vertically.

Explanation

Bookmarks Toolbar

You may have a maximum of ten bookmarked verses.

The will add the active verse in the Bible View to next number in the index.

The will add the active verse in the Bible View to the index number that you specify.

The  will delete all bookmarks. You may also delete a bookmark by right-clicking on the

number/button and selecting the appropriate menu option.

The allows you to view a bookmark of your choice.

If you click on any number at right (1-0), the active Bible View will jump to the verse for that

bookmark.

If you hover over any number at right (1-0), a tool tip will display with the verse reference that this

bookmark refers to.

Using keyboard shortcuts

To define a bookmark press CTRL+SHIFT+<DIGIT>, where digit is between 0 and 9.

To jump to a previously defined bookmark press CTRL+<DIGIT>.

Bible View Options

Sections in this topic

Overview

Fonts colors and Styles

General behavior

Paragraphs and Headings

Strong's numbers

Morphology codes

Footnotes and Cross-References

Commentary Links

Inline commentaries

Word Lookup Dictionaries

Word click options

General Options

Overview
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The Bible View Options in theWord provide a very feature-rich way to view the text of the Bible.  There are

many, many options to customize the Bible View to fix your exact taste.  The Bible View Options can be

accessed in four ways:

1. CTRL+O (when Bible View is active)

2. Gear icon in the Bible Viewer Icons to the left of the Bible View (for quick access).

3. Main menu, Tools.

4. Right-click within the Bible View and select Bible View Options...

TIP: There is a quick set of Bible View Options at the bottom of the View Icons.

Pressing the small arrow will display a quick list to quickly toggle certain Bible

View Options.  Further, each option in that list can be toggled through a one-

letter keyboard shortcut (when the Bible View is active).  These options will make

much more sense at the end of this section.

Bible View Options Quick List

There are eleven tabs within the Bible View Options.

TIP: Not all Bible View Options will be available for all Bibles.  The Bible will only

display the options that the module supports.

Fonts Colors and Styles
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Fonts colors and styles

Within this dialog, the user can customize many display colors and styles for various aspects of the Bible

View.

Default Bible text font is the global setting for all Bible texts.  The fonts for Bible texts can be changed

on an individual level via the Show/Hide Bible Texts dialog.

TIP: The default Bible text font that theWord is setup with is Tahoma. This font is

used because it supports many different languages and, in general, has very

good support even in older versions of Windows. Yet, it may not look as

beautiful as other fonts (like Trebuchet MS or Georgia), or even some modern

fonts that Microsoft made for Windows Vista/7 or Microsoft Office (like Segoe

UI or Calibri). You may want to experiment on a font that looks good on your

PC and is comfortable for your eyes.

Reader's background image: From this button you can select an image to use as the Background of the

Bible view. theWord comes with several predefined image backgrounds that can be found in the 

Backgrounds sub-directory of theWord installation folder. Clicking the Reader's background image

button allows you to select the image and how you want it to be displayed.

TIP: theWord ships with several ready-to use Background textures. In order to

use them effectively, you will need to combine them with an appropriate

background color of your liking! 

You may notice that all the textures appear as gray, but in reality they are semi-

transparent so you can combine them with any color you want.

Show header and footer is another way to navigate the Bible.  When this is selected, a set of links to

navigate to next/previous chapters appears at the top and the bottom of the chapters in the Bible View. 
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The keyboard shortcut for this option is Q.

Header and Footer Navigation Links

There are a couple of keyboard shortcuts to mention.  For the words of the Lord Jesus, it is J.  To display

Old Testament quotes, press O.

The remaining options are self-explanatory.  You can customize them to your liking.  Some of these

options are dependent on the Bible module's support of them.

General Behavior and Parallel View Options

General Behavior and Parallel View

Most of the options in this section of the Bible View Options are fairly clear.  The options in the top

section deal primarily with the navigation of the Bible View, especially with the mouse.

Show user's formatting/highlighting on Bible text refers to the highlighting, underlining, etc. the user

may perform on specific verses.  This can also be toggled with the U shortcut.

The bottom section of this dialog gives options for the Bible View when the Compare mode is activated

(pressing the Compare button/tab on the Bible view).
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Show floating header in parallel view toggles the appearance of the Bible's abbreviation at the top of

each row/column for easy reference.  See Compare View.

Paragraphs and Headings

Paragraphs and headings 

The first section toggles whether the text is displayed one-verse-per-line (with wrapping, obviously), or in

paragraph mode.  This option can also be toggled with the shortcut P.

The second section deals with translator's paragraphs, which are paragraph divisions included in

translations.  Since all modules don't have paragraph tags included, you can use alternate paragraph

divisions that are found in other installed modules, and apply them to the current module. The Alternate

Paragraphs list displays all installed modules that contain within them information for paragraph divisions

and can be applied to module that don't have.

TIP: if you want to read a Bible text that does not contain within itself information

on paragraph divisions, you can "borrow" the divisions of other installed

modules that have this information. To do so, you just need to select the If the

module does not have paragraphs, then use "Alternate paragraphs" option

above, and select a module from the Alternate Paragraphs list. 

The third section has options for chapter headings.  This, like paragraphs, are tags included in the Bible

module.  These headings, when displayed, give an outline or summary of sorts of the contents of that

section in the Bible.  Like, translators paragraphs, if the module does not contain chapter headings of its

own, you can use predefined ones from the Alternate headings drop down box.  The color of these

chapter headings can also be customized.

TIP: theWord can use the chapter headings included in Bible modules, or
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separate sets of chapter headings (files ending with .hdgs.twm). By default, a

set of English chapter headings is included in the program and appears on the 

Alternate headings list as English headings.

This feature allows you to "borrow" chapter headings and display them even for

Bible modules that do not have this information within. Remember, that using

this function may result in cases where the language of the chapter headings is

different from the language of the Bible text!

TIP: Entries in the Alternate Paragraphs and Alternate headings lists may

appear:

- within [square brackets]: in that case, they refer to a set of paragraph/headings

that exist in an installed Bible module (the name there is the title of the Bible

module they have been taken from).

- without square brackets: in that case, they refer to a set of paragraph/headings

that exist in separate files and are independent of any installed Bible module

(theWord ships with two predefined paragraph sets and one predefined chapter

headings set in English - more may be downloaded and installed separately

from the official site). 

Strong's numbers

Strong's numbers

Strong's numbers are the coding systems for every Hebrew and Greek word in the Bible.
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In the first drop-down box, the user can choose which dictionary is used to display the definition for a

Strong's number link in the Bible View.  Not all Hebrew/Greek dictionaries support this feature.  If the

feature is supported, the name of that dictionary will display in that selection box.  Further, instead of

showing a number, the user can make theWord display the actual Hebrew/Greek word or some text of

the user's choice.  The size of the Strong's number/text relative to the Bible text and the color can also be

customized.  Strong's numbers can be toggled easily with the S shortcut.

The Show no link, just show... option is useful if you don't want to display any extra text in the Bible text

(to avoid clutter) but you just want to display the Strong's number when you hover your mouse over a

word. Notice that special support on the module level is required for this option to work.

The second section is similar to the options of the Strong's numbers.  The options are nearly the same,

except when a Greek morphology code is hovered over, the chosen morphological dictionary will display

the entry for that morphology.  The shortcut for Greek morphology codes is M.

Morphology codes

Morphology codes

Morphology codes give grammatical information about Greek and Hebrew words in original language

modules (Old and New Testament).

The options are nearly the same, except when a morphology code is hovered over, the chosen

morphological dictionary will display the entry for that morphology.  The shortcut for Greek morphology

codes is M.

It is usual for Bible modules that contain morphology tags to be accompanied with specific dictionaries to

lookup the morphology codes. The default dictionary that ships with theWord (RMAC) contains standard

Morphology codes for the Greek New Testament only.

Footnotes and Cross-References
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Footnotes and Cross-references

Like other Bible View Options, the Bible modules support the display for translator's footnotes that occur

in some Bibles. According to the options in the first section, these can display in a variety of places in

reference to the Bible text. The color of these links can also be customized. The shortcut for toggling

footnotes is F.

In the second section, options regarding the displaying of cross-references can be customized. Position

and color are again available to change.

Merge original cross-references when displaying inline as links: this option applies to cross-

references that appear in a Bible module itself (e.g. not for external cross-references that may be

overlayed). When checked, a star (*) will appear in place of the cross-reference(s) instead of the actual

verse reference. This is useful for modules that have many cross-references and their display would cause

a lot of clutter in the reading area.

Cross-references are bi-directional means that when a user adds a cross reference in one place the

target verse will also show the root cross-reference so that the user does not have to cross-reference

both verses each time he adds a new cross-reference.  The format of the back-references can be

customized as well.  The symbols "%s" (without quotes) refers to the verse reference.

TIP: Notice that when cross-references are visible, some of these are found

within [square brackets] and some are not. The ones in the square brackets are

actually back-references (e.g. the verse they appear is actually the "target" verse

of a cross-reference that appears in another verse). The square brackets help

you differentiate these. You may customize how these appear if you change the 

Format of back-referencing cross references field. For example, If you enter in

that field "(%s)", then the back references will appear within round parenthesis. If

you just enter "%s", then nothing special will appear for back-referencing cross

references, yet you will not be able to tell them apart. At any time, you can

choose to turn the back-references off if you find it confusing.
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The cross-reference system in theWord also can display more than one cross-reference set at one time. 

These sets can be overlayed to appear as one large group of cross-references.  The Organize button

opens the cross-reference dialog to organize and view the cross-reference sets.  The keyboard shortcut

for displaying cross-references is X.  See the Cross-References topic for more information on this subject.

Commentary Links

Commentary Links Options

When commentary links are active, theWord will display links to the user-selected commentaries near the

Bible text.  The links appear as abbreviations of the commentaries' names.  When the user hovers over

these links, the entry in the commentary for that verse where the link is found will be displayed in a tool

tip.  See the example below.  The user can customize the way links are displayed, the color of the links,

and the commentaries to display.  The keyboard shortcut for commentary links is L.

Example of Commentary Links

Moving your mouse over a commentary link will display the actual content in a popup window. Clicking on

the link will display the commentary in a Book view.

Inline Commentaries
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Inline Commentaries Options

Inline commentaries are different from commentary links in that the entire entry in a commentary for a

given verse is displayed with the verse, not just links to show tool tips.  The commentary entries can be

shown either after or at the right of each verse.  See below.  There are various options for the display of

the commentary text and the resulting table.  Any or all of the commentaries can be selected to display

with the Bible text.  The colors are also customizable.

Example of Inline Commentaries (after each verse)

The quick list option for the inline commentaries is a little different than the other quick list selections.  In

the quick list, the user can choose whether to display the commentaries' text to the right or under the

Bible text.  Accordingly, there are three keyboard shortcuts: C to show below each verse, T to show to the

right of each verse, and N to turn off inline commentaries.

Inline Commentaries Quick List
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TIP: An interesting usage of inline commentaries is that they allow you to

annotate the Bible text with your own personal notes (a function which also

existed in previous version of theWord and was called footnotes). To do so, you

just need to select a user commentary to display inline with the Bible text (e.g.

the default My Verse Notes commentary that is created by the program upon

installation, or any other you can create by yourself from the File->New module

menu). Adding notes for a verse in the Book view to your commentary, will

display them along with the Bible text as soon as you save them (pressing 

CTRL+S or just changing to another topic).

Word Lookup Dictionaries

Word Lookup Dictionaries Options

theWord recognizes individual words in the Bible View.  The word lookup dictionaries option allow the

user to instantaneously see the definition of any word in the Bible View as given in any installed dictionary

module.  When the user mouses over a word, after a given number of milliseconds (the delay can be set

in the General options category of the Bible view options dialog), a tooltip will appear with the dictionary

entry for that word.  See below.  By default, only the first dictionary's text will appear, unless If more than

one dictionary matches... is selected.  In addition, different dictionaries can be used depending on the

current Bible module.  First, select the Bible module in the For this module... select box, then check the

dictionaries you want to use for that module.  This can be done for every Bible module.  The keyboard

shortcut to toggle word lookup dictionaries is D.
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Example of Word Lookup Dictionaries

The if there is a lemma for the word, use it instead... option allows the lookup to be performed on the

lemma of the word, instead of the one being displayed. This is a special option that mostly applies to

original language modules (Greek and Hebrew) that contain the roots of the word within. 

TIP: How exactly the lookup is performed?

At times you may hover over a word and get hits from topics you wouldn't

expect (or vice versa). Please, read the section How word lookups are

performed to understand how the actual lookup takes place! 

Word click options

Word click/lookup options

Normally, clicking on a word will cause the current dictionary entry to change (and Book views to get

synchronized - read more about View synchronization). The question arises of what happens when you

use a module that contains Strong's indices, Morphology information and Lemmas (and you have

checked the Show no link, just show in a popup... options in the Strong's numbers and Morphology
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codes pages). In that case there are 4 different pieces of information that exist "underneath" a word you

see in the Bible view. This page allows you to define exactly the behavior of the program when you click

on a word in such cases.

Check the options and the order you wish to use when you click on a word. Use the move up and move

down button to change the order.

The Perform the lookup on all checked items (don't stop at the first one) option allows you to

perform more than one lookups by clicking on a word. This is very useful if you have more than one Book

views open, each one with a different module selected. In that case, you can even cause each Book view to

get synchronized to each different part of information that is "contained" in the word you clicked on. The 

View synchronization topic provides further information for this.

See also some advanced information here

General options

General options

Select the delay (1 second = 1000 milliseconds) for the popup to appear when you hover over a non-link

word in the Bible view. This applies to:

- word lookup dictionaries

- strong's code, when the Show no link, just show in a popup... option is checked in the Strong's

numbers page

- morphology code, when the Show no link, just show in a popup... option is checked in the

Morphology codes page

Set separate Strong's and Morphology dictionaries dialog

You can access this dialog from the Strong's numbers and Morphology codes page from within the Bible

view options dialog (click on the link at the bottom of these pages):
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Click on a column header to sort the list.

Click on the Strong dictionary or Morphology dictionary columns to select custom dictionaries for a

module. The drop-down that appear contains the following entries:

[Bible view default]: refers to the selected dictionary on the Bible level

[Module default]: if there is an assigned dictionary on the module level (this property exists within

the Bible module itself), then this option will select it

Other entries: this is a list of dictionaries that contain Strong's codes or Morphology codes.  

 Empty values are identical to [Bible view default].

Show/Hide Bible Texts

Introduction

The Bible View tab bar is the area in the Bible View directly above the Bible text.  This tab bar contains all

or a portion of the Bible modules installed on your computer and tabs for the Compare and List Views as

well.  The Bible modules that are displayed can be organized and displayed in a variety of ways according

to your preference.  This is done via the Show/Hide, reorder Bible Texts Dialog.

Bible View Tab Bar

The Show/Hide, reorder Bible Texts Dialog is found by pressing the Organize icon at the extreme left of

the Bible View tab bar.  It can also be found in the Main Menu: File -> Preferences -> Bible texts tab.

Organize Icon

The Dialog
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Show/Hide Bible Texts Dialog

Through this dialog, you have full control over which Bible modules appear in the tab bar in the Bible

View.  You are presented with basically a table.  All columns in this table are editable, except the 

Description column. Clicking on the title of a column will sort the table accordingly.

TIP: All the options in this dialog are global, and apply to all Bible views of the

program. Unlike the option in Bible view options dialog, these options will affect

all Bible views. For example, un-checking the 'Visible' box in this list will make this

Bible module unavailable within the whole program.

The Visible column alters whether that particular module is visible in the Bible View tab bar. 

The Title column allows you to change the abbreviation used in the tab bar for that Bible.  This can also

be done via the Bible View Menu.

The Font column allows the user to customize which font that particular module uses to display its text.

This is important for all modules, especially for modules that require special fonts.  If you have multiple

special fonts for a particular language installed, you can change which font is used for that text.  If no font

is selected, theWord will use the default Bible View font as found in the Bible View Options. Usually,

modules that require special fonts are shipped with them and these fonts are automatically selected.

The Size column changes the size of that font, relative to the font size setting in the module itself. This is

very useful in case the font you choose is smaller than the default fonts (this is usually the case for Greek

and Hebrew fonts).

Save order of texts will save the order that the modules appear in this dialog so that they appear in that

same order in the tab bar. Notice that if you don't check this option, then changing the order of the texts

will have no result. This is useful in order to avoid destroying the order of the texts if you just want to click

on a column header to sort the table for easier viewing/editing.

Set as default will set the selected Bible as the default Bible.  See Bible View for more information about

the default Bible.

The four icons at the right can change the order of the texts, check all modules, and check no modules,

respectively. Individual Bibles can also be moved up/down in the list with the use of the CTRL + ARROW

keys
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TIP: At times, it appears that the order of the Bible texts you have chosen here is

not used in the Bible view tab bar. The reason is that there is an option that

brings the most-used Bible tabs in front so they are visible at all times. This

option can be found under the Bible view menu under Tab options->When tabs

in a single row->Move used items in front. You may uncheck this option if you

find this behavior distracting.

User Formatting

Introduction

theWord's user formatting allows you to mark up each of your Bible modules to your liking, just as you

may in your printed Bible.  This includes highlighting, underlining, coloring the text, etc.  Each Bible

module has its own user formatting.  All of these options are easily accessible via the Formatting Toolbar.

Notice that you cannot apply user formatting to more than one verse at a time. If you select with your

mouse more than one verse and click on any formatting button, only the first verse will be highlighted.

Notice also that the formatting you make applies only to the specific Bible text you use. 

The Formatting Toolbar

Formatting Toolbar

The Formatting Toolbar actually serves two functions within theWord.  First it serves as the toolbar used

to format the user formatting of the Bible View.  It also serves to format your text as you make your own

module in the Book View.  It changes appearance depending on  the use at hand (the picture above

displays the toolbar when you are about to apply formatting to a Bible text).

The formatting toolbar toggle can be found in the Main Menu: View -> Toolbars -> Formatting.

The icons in the toolbar explain each function:

Highlighting - you can highlight any text with a highlight color of your choice.  This will alter the

background color of your selected text.

Text color - you can change the text color of selected text to a color of your choice.

Bold and Italic - just the same as in a text editor.

Solid Underline - this will underline the selected text with a solid underline of your color choice.

Dashed Underline - this will underline the selected text with a dashed underline of your color choice.

Dotted Underline - this will underline the selected text with a dotted underline of your color choice.

The palette icon at the far left of the toolbar serves a very important purpose.  This will turn the

formatting off and on.  This will not delete formatting, only make the formatting invisible.  User

formatting can also be toggled in the Bible View Options, Bible View Options Quick List (see here), or by

the shortcut U.

TIP: if you right click on any toolbar in theWord, you will get a popup menu from

where you can quickly toggle the visibility of any toolbar.
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TIP: for the Highlighting, Text Color, and Underlines, you can click on the little

black arrow at the left of the button to see a list of available colors. theWord

automatically saves the last used colors so you can re-apply them and create a

uniform highlighting result. 

TIP: Remember that before you apply some formatting, you need to first select

some text in the Bible view (holding down the left mouse-button and dragging

the mouse over the text). If you don't do so, any action you do will just be

ignored, without any visible sign.

Compare View

Introduction

The Compare View is a "sub-view" of the Bible View that allows you to view multiple Bibles at the same

time in a parallel format (hence, also called Parallel View).  The Compare View tab is found at the right of

the Bible module tabs in the Bible View tab bar.

There are number of options for the Compare View in the Bible View Options.  Please reference Bible

View Options for the options (some of which are redundant) found there.

Compare View Explanation

Compare View can be displayed in two different ways: columns and rows.

Compare View in Columns
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Compare View in Rows

TIP: Each type of Compare View(in rows and in columns) has its own set Bibles

to display. Remember this when you select the Bible modules to view.

By clicking the small arrow to the right of the Compare tab, a small menu will show toggles and further

options for the Compare View.

Compare View Options

Obviously, the first two options toggle which type of Compare View you want to use.  They can also be

toggled via the keyboard shortcuts CTRL+H (columns) and CTRL+J (rows).  Further, when the Compare

View is activated, these same three options also appear in the Viewer Icons to the left of the Bible View.

Bible Sets

You may create predefined sets of Bibles with a given name and use these sets by clicking on the set

name (e.g. English Bibles, Original Languages, etc). 

Selecting Bible Texts for Compare View

The Bible texts selection dialog can be accessed via the Compare View Options Menu.  This dialog is used

to select the Bibles you want to view for each type of comparison separately.  There is no limit to the

number of Bibles you can compare.  The only limit is your screen size.
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Compare View Bible Selection Dialog

First of all, notice there is a separate dialog for column and row types of compare view.  This is shown

both in the icon (squared in red) and text of the dialog. This can be overridden by the check box at the

top of the dialog. This will use the same options for both column and row Compare View.

You can also reorder, sort, check all, or check none of the Bibles using the icons at the right. 

Once finished making your selections and order your Bibles for the Compare View, you might either press

the check icon at right to save the configuration, or just click outside the dialog to make it disappear.

The Show descriptions checkbox at the bottom toggles the descriptions from the list.

From this dialog you can also define Bible Sets which can be reused for selecting Bibles to display or for

selecting Bibles to search.

Bible Sets

A Bible Set is just a predefined collection of Bibles with a given name. Bible Sets are used in two places:

1. In the Compare View, where you can choose which Bibles you want to display

2. In the Bible Search View, where you can choose which Bibles you want to search.

Bible Sets are common for both these operation and are defined from the same dialog:

This dialog can be accessed from two places:
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1. From the Bible View, Compare button -> Select Bible texts for Compare View...   

2. From the Bible Search View, Select Bibles to Search link or button ( ) -> Select Bibles to

Search...  

The definition of Bible Sets is done from the Sets button. There are 3 submenus:

Load saved one: load a previously defined Bible set in the dialog

Save current: saves the current selection of Bibles as a new Bible Set (or overwrites a previous one)

Delete a set: deletes a previously saved Bible Set

TIP: Remember that Bible Sets are global! They are used for both viewing and

searching multiple Bibles.

List View

Introduction

The List View provides you with a central place to maintain verse lists to quickly reference and manipulate.

 The List View maintains any number of separate named lists for you.  For instance, you could have a list

for "The Prayers of the Lord Jesus" and another called "The Foolish Man" with verses that reference each.

 The List View also supports verse ranges.  The List View tab appears in the Bible View Tab Bar to the

immediate right of the Compare View tab.

TIP: The List View allows you to add verses from various installed Bibles in

theWord.  By default, the Default Bible is used.  You can however add verses

from other versions.  This is done by adding the verse from the right-click menu

of the Bible View.

List View
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Creating and Editing Verse Lists

To create a new list, press the new list icon at left.  From there, you can press the add to verse list icon,

type or select your verse or range.  The verses should appear in the list.  Once finished adding verses,

you must press save to save your verse list!  A list name dialog will appear where you can type the

name of your desired list.

To edit an existing verse list, select the verse list from the drop down box containing all verse lists.  Once

opened, you can add verses just as stated in the above.  Don't forget to press save.

You can rename your verse list via the rename verse list icon.  You will be prompted to change the name

of the list.

Verse lists can be deleted via the delete verse lists icon at left.  This will delete the active verse list.

Miscellaneous Options

The Contents icon (also shortcut CTRL+W) will display all of the users saved verse lists.

You can view your verses in 1 column up to 9 columns.  This is done through the columns icon.  Simply

select the number of columns you desire.

You can copy your verses in four ways:

Copy selection: copy the selected text

Copy content of list as is: copy the list with references and text

Copy only verse references: copy the list with only references

Copy all (hold CTRL for 'Copy Verses' dialog): use the Copy Verses dialog to customize the way

verses will be copied

Create a copy of this list with a new name...: copy the list as a different list name

Copy Verse List Menu

Other Ways to Add New Verses to a List

There are other ways to intuitively add verses to the current verse list:

Via the context (right-click) menu in the Bible View

Via the context menu in the Bible Search View search results

By drag-n-drop verse lists from the Bible search View or the Bible Tree view.

Via the Clipboard Monitor tool tip box

Via the keyboard shortcut CTRL+L

Via the context menu in the Book view (right-clicking on a link)
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Add to Verse List from Bible View

Add to Verse List from Bible Search View

Add to Verse List from Clipboard Monitor



76

Right-clicking on a verse in the Book view

Actions for Current Verses in a Verse List

Once a verse or range is in a list, the context menu for that verse provides some helpful actions to

perform from that verse.

Verse List Context Menu

View Bible text takes you to that verse in the translation you select in the Bible View.

Move changes the order in which the verses appear in the verse list.

Set passage until... changes the range of that entry in the verse list.

Offset passage: moves the entire passage one verse up/down (e.g. Gen 1:2-4 becomes Gen 1:3-5 or

Gen 1:1-3)

Change translation for this verse changes the translation that is displayed for only that verse in the list

Sort the list sorts the verse list canonically or reverse-canonically.

TIP: There are some very useful keyboard-mouse combinations that allow you to

edit verse lists very quickly:

- CTRL+SHIFT+MOUSE WHEEL: this allows you to quickly add/remove continuous

verses from a passage.

- SHIFT+MOUSE WHEEL UP/DOWN: this allows you to quickly move a verse/

passage of the list up/down relative to other verses.

TIP: If you hold down the SHIFT button and you click on a verse link, the view will

automatically jump to the Bible view.
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Book View

General Information

The Book View is the view that allows the user to display and edit non-Bible modules.  Its color code is

orange.  A new Book View can be made by simply pressing the shortcut F12 or from the menu Window -

> New Book view.  The Book View supports commentaries, dictionaries, general books, maps,

devotionals, reading plans, etc.

Book View Options Menu

The Book View options menu contains options to customize the Book View.  It can be found in several

places:

1. The Module Sets button at the left of the tab bar.  Choose Options.

Define Module Sets
Button

2. Clicking any module tab and choosing Module Tabs -> Options.

This is the Book view options menu:

Available options include:

Reader's background image: allows you to set a background image for the reading area. theWord

comes with several predefined image backgrounds that can be found in the Backgrounds sub-

directory of theWord installation folder. Clicking the Reader's background image button allows

you to select the image and how you want it to be displayed.

Reader's background color changes the background color of the area in the Book View that

displays topics content.

Page margins.. These settings are per view.
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Fuzzy matching for topics: read the How word lookups are performed? topic for more

information on this option.

Highlight buttons' background for matching modules adds a yellow highlight to the module

tabs when there is relevant information (See View synchronization for more information on what

this means).

Show 'B', 'C', 'V' buttons in topics selector box: these are the 3 orange buttons that appear in

the topics list selector box (  the ones in the red rectangle). These options

allows you to show or hide these (read below for their function).

Tabs in multiple rows displays the tabs for book modules in more than one row, if desired.

Move used items moves tabs for recently used modules to the far left when in single row mode so

that the modules are readily available when used frequently.

Explanation of Book View
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Book View

There are four main areas on the book view, denoted with the red captions above.

The Tab bar which displays the available modules

The Toolbar that provides direct access to several functions related to the book view

The Topic List (which can be shown or hidden) provides an overall view of the available topics of

the current module

The Topic Content Area is where the content of each topic is being displayed. For user modules,

this is also the editor area where you write your own notes.

The Tab Bar

The tab bar contains all available modules for the view. Each module is represented on the Tab Bar with a

button/tab with the abbreviation of the module. The abbreviations for each  module have been selected

to be short and descriptive (usually consisting of the first letters of the titles of the module). You can

change the Abbreviation of the module by right clicking on the button and entering a new Abbreviation in

the popup menu that appears: . Alternatively, you can do so from the

Module Properties dialog, which you can display from the context menu that appears when you right-click

on a button and selecting the Module Properties... menu option.

Four different colors are used for the text on the buttons that represent the four major module types

(when using dark themes, the colors are adjusted accordingly):

Green color is used for General books and devotionals

Blue color is used for commentaries

Red/Brown color is used for dictionaries and maps

Purple color is used for reading plans

User modules have a small pencil icon on the left ( ) whereas a calendar icon ( ) is used for devotionals .

Notice also that some modules have a colored 'dot' on the right-upper corner (e.g. , , ). These dots

represent whether the module has information that is relevant to the current topic/verse. Read about View

synchronization for more information on what these dots mean. 
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The set of modules that are displayed at any time can be customized via the Module Sets dialog. Each

view can be tailored to display either a specified set of modules, or all modules of one or more given

type. This feature, along with the option to create as many Book views as you want and arrange them as

you like, makes the interface of theWord very customizable.

If you hover your mouse over a button you will get a popup window with information about the module

that includes Abbreviation, Title, Author(s), Publish date, File Path, Categories, Description.

On the left area of the Tab Bar there is the Module search input box . You can click in there (or press

SHIFT+F2) in order to search for a module. As you start typing, a list of modules appears whose

abbreviation or title or description or author matches your input. This is the fastest way to locate a

module if you cannot remember it's abbreviation.  

If the modules cannot fit on the tab bar, a small button appears on the right : press it to gain access to

the rest of the modules. Alternatively, you can choose to display the modules in multiple lines (see options

above and specifically the Tabs in multiple rows option).

Book view toolbar

The toolbar can be dragged and positioned on the same row as the Tab bar in order to occupy less

space. Some icons only appear on the toolbar depending on properties of the current module being

used. 

The first icon on the toolbar  only appears if the current module is a user module. This icon provides

access to editing functions for the current module. Clicking on it, a menu appears that allows you to 

insert a new topic, update the subject or delete the current topic. You can delete multiple topics at

once by selecting them with your mouse and the selecting the Delete selected/current topic(s)... menu

item (or pressing SHIFT+CTRL+DEL)

 The Back/Forward buttons allow you to move to the previous/next topic. Each book view holds a

separate history of topics displayed. The module, topic and current position in the topic are registered in

the history as you browse different books and topics. The history is reset when the program restarts.

The topic list button toggles the display of the topic tree at the left of the Book View.

 The Calendar icon appears only for devotionals that are calendar based. Clicking on it, a calendar

appears that allows you to jump on the reading that corresponds to the selected date:

Notice in the calendar popup, that dates that have a devotional reading appear in bold. 

TIP: To quickly jump to today's reading of a devotional, just right click on

the devotionals tab/button and select the Today's Reading menu option.
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The topic input box allows you to input the desired topic to navigate quickly. If

you click in and start typing, you will get a drop-down menu with all the topics that either start with the

letters you type, or contain them within. The list is divided with the - inline matches - entry that appears

within.  Clicking on the small arrow on the left provide a popup that is similar to the Topic List (read

below) and is displayed according to the current options set in the Topic List. You can resize the popup

that appears by dragging from the lower-right

 corner.

Book/Chapter/Verse buttons: these buttons appear only when the current module is a

Commentary. From left-to-right, they correspond to Book, Chapter, Verse level comments. They allow

you to jump directly to a comment on a different level (if one exists). Each of the 3 buttons is enabled only

if the corresponding comment exists. For example, suppose a commentary has comments for Mark (at

the Book level), Mark 1 (1st chapter of Mark) and Mark 1:1 (first verse of first chapter of Mark). If you are

currently viewing the comments on Mark 1:1, then the Book and Chapter level buttons will allow you to

jump to the corresponding Book and Chapter level comments. Remember that a commentary is

synchronized to a Bible view on the Verse level comments, then on the Chapter level comments, then on

the Book level comments.

The topic navigation arrows will take you either forward to backward one topic at a time.

The print icon allows you to print the content of the current topic.

Create New Book View button duplicates the Book View.

The zoom in/out icons allow you to increase/decrease the font size of the reader. If you right-

click on any of these icons, the zoom level will be reset the default value. You may also zoom in/out by

holding down the CTRL key and scrolling the mouse wheel while over the book view reader.

The grab mode icon allows you to navigate the contents of the topic by clicking and dragging

rather than scrolling.

The sync button allows you to sync the Book View with various Bible Views.

The arrow beside the sync icon give additional options for syncing the Book View.  You can choose the

types of modules to sync.  Normally, when there are two or more Book Views, if the last option in this

menu is unchecked, the Book View will only sync when it becomes active.  When the option is checked, it

will sync even when inactive. Refer to the View synchronization topic to read more.

Book View Sync Menu

 The image auto-resize icon appears when the current topic contains images/graphics (there is

also a module level setting on whether the images are allowed to be resized; this setting should be set
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for the current module). This button appears only for non-user modules and for topics that contains

images. Clicking on this button will force the images of the current topic to be resized so they fill the

content area of the book view. Clicking on the black arrow on the right will display the following menu that

allows you to choose the type of 'fit' you want for the images.

This icon allows you to navigate to the next search match within a topic. It is enabled only after you

perform a search using the Book Search View. Every time you click it, the reader scroll to the next match.

Holding down the CTRL key causes the reader to scroll to the previous match.

The more buttons arrow displays are available modules that cannot be displayed for lack of space in

the single row tab bar view.

Topic List 

The Topic List displays all topics for the selected module and can be toggled with the  icon. The

Topic List supports drag-and-drop of topics that allow you to re-arrange topics (in user modules) or

copy entire topics from one module to the other (by drag-and-dropping topics from the Topic List of

one book view to a Topic List of another book view). For more information read the topic Copying/

Moving book topics.

The Topic List appears by default at the left area of book view.  You can move the Topic List to any

position within the book view (north, east, south, west) by dragging it from it's caption area (click on the

space between the Options button and the X and drag). The Topic List cannot float and you cannot drag

it to another view.

Depending on the type of module you are viewing, the Topic List will display in a flat or hierarchical

mode the topics of the module (see Topic List Options below on how you can customize that).

The nodes in the Topic List, which represent topics, may appear with different formatting (normal, bold,

italic, gray-italic). Each type of formatting denotes some specific properties for the topic. The available

options are:

normal font style: this is a normal topic and there is content available

bold: this is a normal topic with content, but there are also sub-topics available

italic: this is a new topic and there is no content available (empty topic): it may or may not have

sub-topics

gray-italic : this is not a real topic, just a placeholder that is used to group sub-topics. This kind of

node appears mostly in commentaries, when you have selected the Show as tree, replacing

missing nodes or in dictionaries when you have selected the Show as tree, grouping on initials...

If a topic contains sub-topics, then on right part of the topic subject, a number in square brackets in 

green color will appear which indicates the number of direct subtopics (e.g. [3], [11], ...).

Read more on how you can use the Topic List to copy/move topics.
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Topic List options

The topic list menu provides you with options to customize how the topic list behaves (the Options

button appears on the top of the Topic List).

Topic List menu

The Show as... selections determine how the tree will display for commentaries.  A list will display simply

as the topics one on top of one another.  A tree will display the list as child topics of parent topics.  For

example, "Genesis -> [All topics in Genesis]".  The tree mode allows the books to be collapsed to save

space.  The tree replacing missing nodes displays a full parent-child tree, like "Genesis -> Chapter 1 ->

[all topics for chapter 1]". 

In case of dictionaries, the menu will display: 

: in that case, you can select the number of initial letters

(0-3) to group the topics of the dictionary.

In case of books, these options are not available.

TIP: Unlike all other options, the Show as ... options are saved individually for

each module across all book views. This setting also decides how the topics are

displayed when you click on the small black arrow at the right-end of the topics

input box that resided on the book view toolbar.

Expand and Collapse tree will expand and collapse the topic tree (when enabled) all at once.

Show popup when mouse hovers over a topic displays the entire topic in a tool tip when you hover

over the topic in the topic list.

Auto-expand nodes on click causes the tree to auto-expand when you click on a node that contains

children (sub-topics). At the same time, the previously selected/expanded node collapses.

Context menu of Topic List

The following menu appears when you right-click on a topic with your mouse. The first three options

appear only for user modules and are identical with the options that appear when you click on the 

icon on the toolbar.
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The Find "..." options perform a search of the subject of the current topic in the Books or Bibles you have

installed. Please, see the Bible Search View and Book Search View for relevant information.

The Lookup function performs a Lookup on the selected subject. Please, read the How word lookups are

performed topic for more information.

The Topic Content Area

This is the area where the content of each topics appears. For user modules, this is also the actual editor

where you can write your notes or change existing content. Please, see the User Modules section for

more information on how to create and edit user modules.

Read more on User formatting for non-user Book modules.

Module Sets

Overview

Module Sets are sets of modules that are, optionally, saved under a given title. They are used:

as the module tabs of a Book view (e.g. a Book view can be set to display all module belonging to

a particular set)

as a set of modules to be searched from the Book search view.

When potentially hundreds of book modules are installed, module sets make a way to quickly organize

them.  For instance, if you wanted to do a word study, you may have a set called "Word Study" which you

could either search as such, or display it in a Book view.  In this set, you could have only the pertinent

book modules needed to do a word study.  Further, using module sets, you can organize your modules in

any way you like so all of them are available in the divisions that you want them. 

A Module Set can be organized in a hierarchical manner (e.g. it may contain 'folders' within, like the

shelves of a Bookshelf). 

TIP: the collection of all modules at each moment on any Book view comprises a

Module Set. A Module Set can exist under a name (if you have previously saved

it), or it can only exist for as long as it is displayed in the Book view.

The module sets menu and dialog can be accessed in two ways:

1. Via the Module Sets button

Define Module Sets
Button
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2. Right-click on any module and select Module tabs->Define Module sets.

Define Module Sets Menu

Define Module Sets menu

This menu allows you to quickly change module sets to your liking.  This is where (some or all of) your

saved module sets will be found.  There are already six pre-made sets: All modules, Dictionaries,

Commentaries, Books, Maps and Graphics, Reading Plans.  You can enter the Define Module Sets

dialog via Define module sets...

TIP: You can select which Module Sets appear on this menu. You may have as

many Module Sets defined as you want, yet only choose to display in this menu

the ones you use most often (see below how).

Define Module Sets Dialog

This dialog is used for two different purposes:

in order to select a previously saved module set to display in a Book view

in order to create 'on-the-fly' a module set and display it in a Book view (without saving it)

in order to choose which of the pre-saved Module Sets appear on the Define Module Sets Menu

above.

Remember that this dialog provides in essence the way to select a sub-set of your modules in order to

display them in a Book view. If you choose to save this set under a title (which is optional), then you have

a re-usable set that you can recall at any moment (either to display it in a Book view or to search it in a

Book search view).

Choosing an Existing Set or Selecting Directly

The first tab in the dialog gives options for basic and pre-made module sets.  This is the non-advanced

method of customizing module sets.
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Define Modules Sets Dialog (Basic)

The top section of this tab allows you to select which sets are displayed in the Define Module Sets Menu

for quick reference.  The checked sets will be available in that menu (you can have as many module sets

as you like, yet you may only select the ones you used most to be displayed in the quick reference menu).

You may also change the order in which these sets are displayed and delete sets that you do not need.

The bottom section of this tab allows you to choose which types of modules you would like displayed in

the Book View tab bar.  This section does not allow you to choose which modules are in a set on an

individual level, only on a type level.

First, you choose the types of modules you want displayed by the check boxes on the left, then the order

in which to display them at the right.  Once done, you can save this combination as a set by checking the 

Save this combination and typing the name of this new set.  This set will then appear in the top section

of this dialog and (if checked) in the Define Module Sets Menu.

Creating a Custom Set

The second tab in this dialog allows you to select modules on a individual level and create custom sets.
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The left pane contains all available modules installed on your computer, organized in a module type tree

along with several columns with information.

The right pane shows all modules that are either in the active set or that you have placed there to make a

new module set.

TIP: To move modules from the left pane to the right pane, select the modules

on the left and drag them where you want them in the right pane.  You may

select multiple modules in both panes by using SHIFT and CTRL also.  Further,

you may click and drag modules or nodes in the right pane to rearrange them

to your liking.

The Filter text input box allows you to filter the modules in the left pane by what you type, to find

modules in the midst of many. The filter is applied to all columns, thus allowing better searching of the

modules.

The buttons at right manipulate the modules in the right pane.

The Templates... button sorts the modules in the right pane in various ways.  See the menu.

The New folder... button creates a folder in which modules can be placed for organizational purposes in

the Book View tab bar.  For instance, if you wanted to have all useful word study resources available in

this set, but separately, you could select these modules and place them in a folder named "Word Study

Books".

The Rename folder... button renames an existing folder.

The Delete button will delete the selected modules in the right pane.

The Clear tree... button deletes all modules in the right pane.  This button does not delete modules from

your computer.

Once you have organized your set as you want it, check the Save this set checkbox and type the name of

the set in the input box.  The set will now appear in the Define Module Sets Menu.
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TIP: You can have as many module sets as you choose.  Simply clear the tree

and make a new set.  Also, you can place the same modules in different folders.

TIP: A module set can be defined either as a set of static modules or as a

dynamic set that contains at any moment all those modules of a particular type. 

For example, you may create a set that contains all commentaries and name it

'Available Commentaries'. Obviously, this set does not specify which modules are

included within, yet at any moment, when you refer to this set, it will contain all

the available commentaries of your library. Sets of this type are the ones created

from Choose existing set / select directly tab under the "or choose the types

of modules you want in the set" area. 

Static sets (e.g. sets that contain the modules you choose at the moment you

create the set) are the ones you create from "Create custom set (advanced)"

tab. In that case, even if you drag-n-drop the whole 'Commentary' node from

the Available modules tree to the Drag from the list... tree, the actual set will

NOT contain any commentaries that you add to the library in the future.

Hyperlinking

Overview

theWord allows all content to be linked to, e.g. create links in modules that point to another topic or

verse.  This topic explains how you can create your own links in your user-modules.

theWord's Book View supports user-created and editable modules.  One of the helpful features available

while editing a module is the ability to hyperlink text so that tool tips, verse texts, other topics, etc.,

appear when the user hovers over the link; when the link is clicked a view is used to display the content

that this link refers to.  theWord supports hyper linking in many different ways.

Once you have an editable module active in the Book View (and you have, optionally, selected the text you

want to hyperlink), you can access the Hyperlink Dialog in several ways:

1. Keyboard shortcut CTRL+K

2. Right-click an area in the content section of the Book View and select Hyperlink

3. The Hyperlink button in the Formatting Toolbar 

TIP: It is important to make sure you understand how hyper linking works since

choices you make here may affect the way links will behave if you decide to copy

topics to other modules later or change the module identifier.

Hyperlink Dialog

theWord allows you to Hyperlink to just about anything.  The dialog below will guide you in hyperlinking

properly.  More advanced hyperlinking is supported, which can be found at theWord's website.
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Hyperlink Dialog

The dialog is divided into three sections, numbered accordingly:

1. Select the type of module that you want to link to.  Your choices in this dialog are Bible,

commentary, dictionary,  and general book modules.  There is also an advanced option and an

option to use the current module (a topic from the current module).  Once you select the type of

module, you can select the specific module to which you want link in the drop-down box at right. 

For Bible modules, you may select the current Bible module, which will display a verse reference

using the default Bible module (or the active Bible module if CTRL is pressed), or you may select a

specific translation.  Note: If the Bible version you link to is not installed on the computer, theWord

will display the verse text with the default Bible module.  If the book module is unavailable, the link

will be dead (will not work).

TIP: When making a link to a topic of the same book module (the one you are

currently working), always use the option a topic from the current module.

Most links to Book modules usually refer to another topic of the same

module. In these cases, although selecting the option a topic from the

current module and selecting directly the appropriate module from a list will

have the same result, it’s always preferable to use the first option since a

future change to the module identifier will "break" the links.

2. Once you choose the module to link to, you must select the target.  For Bible modules, this is a

verse reference or range.  For book modules, this is a specific topic of that module.  You can use

the drop-down box to pick your verse or see all available topics for your selected module.  If you

start typing in the Target verse/topic box a list will appear with the topics that match as you type.
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In case of book modules you may also select a bookmark from the Bookmark list (see also the Book

view Bookmarks topic on how to define Bookmarks). Selecting a bookmark (if there is one in the

selected topic) will have the following effect for the created hyperlink:

a. If you just hover over the hyperlink so that the content of the topic appears, then the topic will be

scrolled so that the first line on the popup will be the one containing the bookmark.

b. If you click the hyperlink (so the topic appears in a Book View), then the topic will be scrolled so

that the first line in the Book View will contain the bookmark.

c. The Until (passage) list also contains a list of the bookmarks that appear after the bookmark

you defined in the previous step (in the Bookmark list). Select from the list:

i. [Next bookmark] - The popup that will appear will only contain the part of the topic that

appears between the first bookmark and the next bookmark (if any) in the topic.

ii. Selecting any other bookmark - The popup that will appear will only contain the part of the

topic between the two bookmarks.

3. Show content in popup... determines what happens when the user hovers over the link.  Text is

the actual text seen in the content of the topic.  If you had text selected when you opened this

dialog, this will be filled in already with your selected text.  For every option in section one, except 

Manually enter the target of the link, the Target section will be filled in already with the target.

This area is non-editable unless you choose the Advanced option in section one. Clicking on the <-

Default button will replace the Text with the default text (e.g. a standard text that describes the

link). 

In the Link colors section at the bottom, you can customize the way the link is displayed in the module. 

Normal refers to the link under normal conditions.  Active refers to the link when a user hovers over it or

when the cursor is in the link.  You can change both the text and background colors of these links.  You

can also choose to show these links as underlined or not.

The option Use the topic id instead of the topic in the "Target" means that the target module will be

identified with the Module Identifier instead of the target topics’ subject. This is the preferred way to

create links, since changing the subject of the target topic will break all links that point to it.

If you want to keep the current Link colors options for later use to be used as default, press the Set these

options as default button. This will also make theWord use these colors when auto-detecting verse

references.

Lastly, if you have selected an already existing hyperlink and would like to delete it, press Delete

hyperlink.

See also: Automatic Verse recognition.

Linking to external content (e.g. files, mp3 files, etc)

You can add links to file on your disk by manually entering the path in the Target text box. When you click

on these links, the Windows program associated with this file extension will be launched to display the file.

You may use relative links to define the location of the file you link. The location is always relative to the

directory of the module. This allows you to have all files associated with a module grouped under a

single folder.

For example, if you want to link audio mp3 files, you can just create an mp3 subfolder under the folder

where your module exists and put in there the audio files. You can link then using the following target (e.

g. for an audio file with the name audio1.mp3):
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Linking to multiple verses

You can add a link to multiple verse using the following syntax for the Target:

tw://bible.*?id=b.c.v;b.c.v;...

where b.c.v stands for book.chapter.verse. For example, if you want to add a link to Gen 9:13 and

Gen 9:17 then the target will look like that:

tw://bible.*?id=1.9.13;1.9.17

Automatic Verse Recognition

Overview

theWord supports automatic verse recognition to facilitate hyper linking while editing a book module. If,

while you are typing, you wish to type a Bible verse reference, simply type the reference, even in an

abbreviated form, press ENTER or SPACE and the reference will be automatically hyperlinked to display

the text of the verse upon mouse-over. By default, theWord leaves the Bible module undefined in these

links. This means:

1. The default Bible module will display the verse, OR

2. If CTRL is pressed, the active Bible module will display the verse.

The color of the text will change (depending on the Link colors options in the Hyperlink Dialog) to show it

has been hyperlinked. If theWord recognizes a text that is not a reference, but parses it as one, you can

remove the hyperlink quickly by pressing CTRL+Z.

Although the automatic recognition of typed verses tries to guess the actual verse, it is useful if you use

some standard notation to enter verse references:

1. Use the : (colon) to separate chapter from verses (e.g. Gen 1:2)

2. Use the , (comma) to separate multiple verses (e.g. Gen 1:2, 3)

3. Use the - (hyphen) to define a verse range (e.g. Gen 1:2-3)

4. Use the ; (semi-colon) to separate multiple ranges (e.g. Gen 1:2; 6:2)

Even if you don't use the exact notation above, theWord will try to parse and understand the verse

reference you are typing. For example, typing Gen 1,2 (German notation) will correctly identify it as

Genesis 1:2.

If you right-click on a verse link that has been parsed/detected automatically by theWord, you can select

the Undo automatic verse recognition from the menu to undo the operation. You may also do this if

you save the topic and come back to it later.

Detecting All Verse References in an Existing Topic

To detect all verse references in an existing topic, right-click in the viewer area and select Detect all verse

references... (or CTRL+D)

TIP When you paste content in a topic in a user module, you can hold down the

CTRL key to make the program detect the verse references that may exist in the

pasted fragment.
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Detecting All Verse References in a module (all topics)

From the Module Properties Dialog, Settings/Actions tab, Actions section at the bottom. Select Detect

all verse references... 

Advanced mode for commentaries

Normally, theWord will detect only verse references that have a proper book name (e.g. John 3:16).

Unfortunately this excludes the cases where a verse is referred in a text with regards to the current

context using words such as "verse 3, vv 3-4, vs. 5", etc. You can enable an enhanced mode for detecting

these by holding down the CTRL+SHIFT buttons while doing verse detection in a whole topic or module.

This advanced mode is activated in the following cases:

1. When right-clicking on the Book view reader and selecting Detect verse references in selection...

or Detect all verse references in Viewer...

2. From within the Module properties dialog, when executing the Action Detect all verse

references...

Notice that this is still an experimental mode and only works with English abbreviations. 

TIP: Normally, theWord will not try to detect verse references in links, except if

the link is a verse reference link that was detected automatically by theWord in a

previous action/iteration. 

To alter this behavior and enable the detection of verse references even within

links, hold down the ALT key while the detection occurs. Notice that unlike the

CTRL+SHIFT advanced mode above where you only need to hold these two keys

at the beginning of the detection process, in that case you need to hold down

the ALT key for as long as the whole detection process takes place!

Language used for detecting verse references

By default, theWord will detect verse references in English and in the current interface language (which

you can change from File->Languages). It is not possible to detect verse references for an unsupported

language since there is no way to know the book names of the Bibles in that language. You can also

change this behavior by directly editing the config.ini file and setting there the language(s) you want to

use.

Copying/moving book topics

The Topic List allows you to copy, move or rearrange the topics of a user module by using the usual

Windows drag-n-drop gesture with your mouse. The drag-n-drop gesture consists of the following steps:

1. You select with your mouse one or more topics from the Topic List (to select more than one topics,

either hold down the CTRL key and click on individual topics, or hold down the SHIFT key to select

the first and last topics, or just drag the mouse in the Topic List in the white area in order to select

all topics that will fall within the drag rectangle that appears).

2. You click then on one of the selected topics, without releasing the mouse key

3. While holding down the mouse key you move your mouse over the same Topic List or the Topic

List of another book view.

4. You release your mouse.

While dragging, there are two different modes that set what the result of the operation will be: copy or
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move. You toggle between the two modes by holding releasing the CTRL key. The default operation

depends on several factors like whether you drag-n-drop topics in the same topic to re-arrange, whether

the source module is a user module or not, etc. The cursor changes according to the operation being

performed (standard windows cursors are used for these operations): the copy operation usually displays

a cursor with a plus (+) sign, whereas the move operation does not.

Identifying the 'sensitive' areas of the Topic List - how drag-n-drop works.

The copy/move operation occurs when you release your mouse over a Topic List. As you move your

mouse over the Topic List, some indicators appear in order to show you the exact position that the

dragged nodes will be added. There are three different visual indicators that provide feedback as you

drag verses over a Topic List. The following image displays several snapshots of a drag-n-drop

operations. The screenshots are enhanced in order to help you understand how the operation works.

Several snapshots of a (faked) drag-n-drop operation

In the above image, there are four snapshots of a sample Topic List while performing a drag-n-drop

operation. Please, notice:

In the first image, notice the cursor: it is an arrow and there is a + sign on the lower-right corner:

this indicates a copy operation. The cursors in all other images contain a white rectangle there

instead: this cursor indicates a move operation.

In the first and second image, there is a red rectangle around topic 2-C: this  indicates the 'hot'

area for this topic. When you drag-n-drop, if you move the mouse over the 'hot area' of a topic,

then when you release the mouse the dragged topic will be added as children/subtopics of the

'hot' topic. While moving your mouse you will notice that as you pass your mouse over the 'hot'

area of each topic, it gets highlighted.

The third and fourth images show what happens when you move the cursor in the 'white-space'

area of the Topic List. 'White-area' can be found either on the right of a topic or on the left vertical

lane, indicated with the blue rectangle on the fourth image (this is the vertical lane that is just a few

pixels wide and runs through the whole height of the Topic List). When you move the mouse over

this 'White-area' you will see the two horizontal blue indicators (these are the horizontal blue lines

in the third and fourth image: in the third image notice that at the edges of the horizontal indicator

there are two small triangles facing upwards, whereas in the fourth image these two small triangles

face downwards). 

In order to understand how the horizontal blue indicators appear/work, try it for yourself: drag one

topic and move your mouse slowly on a vertical direction on the white space of the Topic List. You

will notice that as you move your mouse, there appear these indicator for each single topic. You will

notice also that this indicators do not appear in the middle between two topics, but they appear

near the top and bottom rectangle that the topic node resides: this is exactly how you can decide
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what happens when you perform a drag-n-drop operation. More specifically:

Even if not highlighted, there is also in this case also a 'hot' topic that is associated with the blue

indicators (the topic that the triangles point to, the closest one to the indicator).

When the indicator with the downward-facing triangles appear (as in 4), then the topics you drag

will be added on the same level of the hot topic, exactly before it.

When the indicator with the upward-facing triangles appear (as in 3), then the topics you drag

will be added on the same level of the hot topic, just after it

Operations supported with drag-n-drop

Remember that you can either drag-n-drop a single topic or multiple topics (examples below refer to a

single topic, yet they all apply to multiple topics also). If dragging a node that contains sub-topics, then 

the operation is performed for the whole sub-tree. To perform the following operation you will need at

least two book views (for the operations that required two different Topic Lists). 

You can use drag-n-drop to perform the following operations:

Rearrange topics of existing user module (book or dictionary): use drag-n-drop in a single Topic

List. The default action in that case is move. This operation cannot be performed on commentaries

(since there can only be a single comment for a given verse or verse-range).

Create copies of a topic within the same user module (book or dictionary): just drag-n-drop in a

single Topic List but hold down the CTRL key: when you release your mouse, a copy of the topic will

be created. This operation cannot be performed on commentaries (since there can only be a single

comment for a given verse or verse-range).

Copy topics from one module to another: use drag-n-drop from the Topic List of one book view to

the other Topic List of the second book view. The default operation in that case is copy. To perform

a move operation (e.g. remove the topics from the source module), hold down the CTRL key.

Notice that it is allowed to copy content between different types of modules. In that case, theWord

tries to determine the best way to map topics from one system to the other:

 If copying from a multi-level topic (e.g. copy a topic that has sub-topics from a General Book) to

a dictionary (that allows by definition only single level hierarchies), then the sub-topics are

'flattened' (e.g. demoted to the level of the parent topic)

If copying from a commentary to a non-commentary, then the topics are converted to text, using

the standard verse references

if copying from a non-commentary to a commentary, then the topics are parsed in order to

understand the verse references and apply them properly to the commentary.

Notice that:

You cannot reorder topics in a commentary: commentaries are always sorted on the book of the

Bibles

If you try to copy a topic from a non-commentary to a commentary, and the topic is not a verse

reference, then the copy will fail and a message will appear notifying you of the situation.

You cannot move topics from a non-user modules (because the move operation deletes the source

topics and, by definition, non-user modules cannot be changed).

You are not allowed to copy topics from encrypted modules.
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TIP: You can create quickly a copy of a module (or part of a module) by creating

a new user module of the same type of the source module, opening two book

views (one with the source module, one with the new one), selecting all the topics

from the source module (click on the first one, then scroll to the end, hold down

the SHIFT key and click on the last one) and dragging the topics to the new/

empty module.

Non-user modules formatting

Overview

In case a non-user module is being displayed in the Book view, the formatting toolbar has less options

and is as follows:

Book view formatting toolbar for non-user modules

The functions of the buttons are self-explanatory. 

By definition, you cannot change the content of a non-user module. The formatting options above can be

used to annotate/highlight the non-user module without changing the actual content. 

Since the actual content of a non-user module is not really changed, theWord gives you the option to

restore the original content of a topic of a non-user module that you have applied formatting. To do so,

just right click on the reader area, and from the popup menu select the option Remove user

formatting...

Remove formatting

Notice that this option will appear only if you have applied some formatting/highlighting to the current

topic of a non-user module.

Removing all user formatting from a module

You can remove the user formatting from all topics of a module from the Module Properties dialog,

Settings/Actions tab, Actions group, Delete all user formatting from non-user module... action

(select and press Execute selected action...)

Making user formatting permanent

There is an action that allows you to make the formatting you have applied to a non-user module

permanent. If you do this you are actually over-writing the content of the non-user module with the



96

formatted one. This can only be execute on non-encrypted modules. You can perform this action from

the Module Properties dialog, Settings/Actions tab, Actions group, Make permanent all user

formatting from non-user module... action (select and press Execute selected action...). Be careful

since you cannot undo this.

Changing the user status of a non-user module with formatting

A special case is presented if you try to change a non-user module on which you have applied formatting

to a user module. In that case you need to decide if you want to keep the formatted or non-formatted

content. By default, performing this action will use the formatting content and the original will be lost. If

this is not what you want to do, you will need to remove first all user formatting by following the

instructions in the above section.

Module updates and user formatting

When you apply formatting to a non-user module, theWord actually makes a copy of the whole topic and

saves this along with the original content. The changed/copied topic (with the formatting) is stored within

the same file as the original module. This means that if you overwrite this file (e.g. by installing a

newer version of a module), all user formatting will be lost.

This is a deficiency that will be addressed in a future version. Normally, theWord should store the

formatted content separately (in the Personal file folder) so it is not overwritten when upgrading a

module. Moreover, because at the moment the changes are stored in the module itself, and because the

actual modules are shared by all users of the computer, any formatting of a non-user module also

appears to other users of the computer that possibly use theWord (this is the only case that this happens

since normally every user has it's personalized settings, files, etc).

Book view Bookmarks

Overview

Bookmarks can be added to arbitrary positions in the content of any user module.

To add a bookmark, place your cursor in the Book view editor at the location you want and press CTRL+R

or right-click and select Insert bookmark... from the popup menu.

Bookmarks

The name of the bookmarks is the one used to refer to it. The Subject is not used at the moment. A

default name for the bookmark is automatically set when you display the dialog (bkm1, bkm2, ...). Just

click insert to complete it.

Bookmarks are indicated in the text with a small gray dot (see red rectangle below). These do not show in

non-user mode until the Ctrl key is pressed. Pressing the Ctrl key will show the bookmark in green.

Releasing the Ctrl key hides the bookmark/turns off the green color.
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Bookmark
indicator

To edit an existing bookmark, just place the cursor just before the letter it appears and press CTRL+R or

right-click and select Edit bookmark... from the popup menu (you will notice that the menu item changes

from Insert to Edit). To delete it just press the Delete button.

Seeing all bookmarks defined in a topic

To see all defined bookmarks in a topic, display the Bookmarks dialog and click on the All bookmarks

tab:

Display all bookmarks

To jump to a bookmark double click on it with the mouse, or select it (single click) and click Goto.... From

this dialog you can also delete some (selected) or all bookmarks of a topic.

How are bookmarks useful for popups and footnotes

The usefulness of bookmarks comes from the ability to define Hyperlinks and use them as anchor points.

This allows you, for example, to:

Use them to define footnotes on the topic level

Use them to force parts of a topic to appear in a popup when the user hovers his mouse over a

link.

Create links that drive you to a specific point you in a topic

Please, read the Hyper linking topic for details.

RTF footnotes/endnotes

Overview

theWord supports RTF footnotes/endnotes in the editor. 

Although you cannot create footnotes/endnotes directly from within theWord, you can create them in

another editor (e.g. MS Word) and copy/paste in the Book view editor. In that case, the footnotes/

endnotes will appear when you hover your mouse over the numeric indicators in the text. If you print a

topic, the footnotes/endnotes are printed at the bottom of the page.



98

Export Topics

Overview

theWord supports export of all topics/selected topics from user modules and locked modules (for locked

modules, there is a limit of 25 topics or 10% of total topics).

Export formats

.docx MS Word Document

.rtf Rich Text Format

.html HyperText Markup Language

Topics can be exported from the Bookview or the Book search results view.

How to Export from the Bookview

1. Select a topic from the topics list. Or select several topics by holding down the control key (Ctrl) and

left-mouse-click on each topic to select them. For a contiguous list, left-mouse-click on the first topic,

hold down the Ctrl key and left-mouse-click on the final topic you want in the list.

Right-mouse-click in the topics tree to bring up this menu.

2. Select Export topics...
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3. Set your options for the export, and click Export...

4. Select your save location and one of the three file formats available in the dialog, and Save.
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How to Export from the Book search view

Simply follow a similar procedure but on the Book search view results. You will be able to select results

from different modules and export as one document if you have done a muti-module search.

Spell Checking

Spell checker, allows you to check spelling in various languages in the content of topics in the Bookview,

that are in user mode.

Settings are accessed via the Preferences -> Proofing tab

Preferences Proofing

Check spelling as you type, is useful when typing in notes so you can correct errors live. Error words will

have a curly underline in the color of your choice. Right-clicking on such words will bring up this menu

where you have various choices; select the suggested word, Ignore all, and Add to dictionary.
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For text that has been copied into the topic, the Spell Checker can be activated to check through a single

topic. Simply right-mouse-click in the topic and select Spelling...
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This dialog will appear... which is self explanatory.
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Where can I download more languages?

More spelling dictionaries can be downloaded through Add Titles. There is also a link in the Preferences

-> Proofing tab

Topic Links

What are they for? Can I make them?

You might have seen topic links, in some official dictionary modules, such as AMGL, TWOT, TDNTa, TDNT

etc. Or a Book module as shown below. Usually they are made programmatically by the module maker

using custom code.

In a book module, their purpose is to allow you to jump to different sections of a long topic, and it allows

you to see the structure of a large topic at a glance. In a dictionary module as above it allows you to

lookup the Strong's number or the lemma.
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Can I make them?

Yes you can make them. Start with something simple as the above example.

First insert the bookmark for each section for which you want a  topic link. Simplest way is to select, in this

case "Christology" and press CTRL+R, or right-mouse-click the selection and select the Insert bookmark..

item from the menu. Press Insert... repeat for any others you want to add.
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Next, open the bookmarks window CTRL+R or right-mouse-click window and select Insert bookmark...
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Select the All bookmarks tab, and select the bookmarks you want to become link topics.

Click Create topic-links from selected bookmarks

You have made some topic links as seen below.
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Topic links can be dragged and dropped into tree structures like sub, sub topics.

Deleting a topic link does not delete the content of the topic. Search results will only indicate the main

topic has a match in it and not which topic link it is in.

Bible Search View

Overview

The Bible Search View is the central location to perform both basic and advanced searches of any Bible

text.  

To quickly perform a search on a Bible just:

press F3

enter the word(s) you want to search for

press ENTER

Like every other view, this View can be docked or floating according to your preference.  The color code

for the View is green.  A new Bible Search View can be made by simply pressing the shortcut F10.  The

Bible Search View is divided into three tabs: Fast tab, Detailed tab, and Options tab.  The following gives a

general information about using the View.
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Bible Search View

When either of the Fast and Detailed tabs are selected at the bottom of the View, the search term input

box and green Go button (red square 1 above) is available.  The search term input box is where you

enter your search term to search the Bible. The green arrow begins the search. By default, the active Bible

module is searched if you simply input a search term and press the arrow. You can select which Bible(s)

you want to search by clicking on the arrow button ( ) at the left of the input box. 

For quick reference, you can place the cursor in this text box by pressing the keyboard shortcut F3.

TIP: When you hover your mouse over a verse reference, a popup with the verse

text appears. If you don't want the popup to appear, you can move the mouse

on the right or left area of the verse. The popup only appears when your mouse

is above the actual text!

Selecting the Bible(s) to search

theWord can either search one or multiple Bibles at once. Clicking on the arrow button ( ) at the left of

the input box, the following menu appears that allows you to select which Bible(s) you want to search:
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The available options are:

Current Bible: the current Bible of the active Bible view will be searched. If you have enabled the Is this

what you are looking for? panel at the bottom, you will see which is the Bible that you are about to

search. 

Default Bible: this is the default Bible of theWord.

This Bible: a sub-menu with all available Bible modules will appear that allows you to select any single

Bible to search.

Select the Bibles to search...: 

All Bibles: This option brings up a dialog that allows you to select more than one Bibles to search. This is

the same dialog used in the Compare View -> Bible Sets.

Previously saved set: a sub-menu with any previously saved Bible Sets is displayed that allows you to

select a set of Bibles to search. See the Bible Sets topic on how to setup the sets.

"Is This What You Are Looking For?" panel

This panel appears at the bottom of the Search view (you can turn if off from Options tab). This area

displays how exactly theWord understands the search terms you type. This provides a very useful

feedback so that you know that what you have in mind is actually what theWord understands. For

example, if you enter Jesus Christ in the input box, there are at least two different things that you may

mean:

1. "I want all verses that contain the word Jesus and the word Christ"

2. "I want all verses that contain either of the words Jesus or Christ."

Of course, if you check the Detailed tab you will see that there is an option of how theWord should

understand this by default, yet this panel makes this information available immediately as you type. Since

the input query can be much more complex, this panel will help you make sure that what you mean to

search is actually what theWord searches for.  Moreover, if you enter the terms incorrectly, you can see

the problem in this area.  

The text that appears in this panel depends also on the Ignore case and diacritics option (can be found

on the Detailed tab). If this option is checked then the displayed text will be in lower case without any

accents or diacritics: this gives you an idea of how theWord will perform the actual search.

Finally, notice that this panel show in red the module that will be searched (notice the "Search KJV for:" in

the screenshots above).

Fast Tab

Overview

The Fast tab in the Bible Search View is the quickest way to do a search in theWord.  This tab is the tab
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that shows the search results of your query.  If you are in another tab and perform a search, the View

automatically switches to the Fast tab to display the results.

Search Results

Additionally, you may place the mouse over any search result reference and a tool tip with the entire

verse text will be displayed.  This makes it very easy to sort through search results quickly.  Also, clicking

on a reference will cause the Bible View to jump to that verse.

The search results are organized in a kind of table or chart.  At the left is the verse reference, grouped

below each Bible that was searched. The following features are available:

The Count column gives the number of matches for each book, and the percentage of all the

matches that this particular book has.

The Graph provides a visual for the percentage information.  

Clicking on a column will sort the results accordingly. 

Hover your mouse over a line that represents a book to get short match statistics

Multi selection is allowed on nodes of the same level (e.g. you can select either multiple books or

multiple verses or multiple translations): right clicking on selected node(s) provides access to a set

of features (copying verses, moving to list, etc)

Explanation of the Fast Tab

 Just below the search input box are several icons for use in the Fast tab.  The first is the History

icon.  When pressed, this icon shows the most recent searches made.  It not only remembers the search

terms, but also the translation searched.  So, pressing a history entry will automatically perform the exact

same search as was previously performed for that entry.  The number of entries for the history can be

changed in the Options tab.

 Next is the Expand icon.  This icon will expand all nodes of the search results.  Normally search

results are displayed in a tree view in which the nodes are collapsed.  With this pressed, all the nodes are

expanded so all verse reference results can be seen.

 The Text icon is next in the bar.  This icon simply causes the verse text to appear to the right of the

results.



111

Search Results

The Options icon provides several options, including zooming to make the text in the View larger,

duplicating the View, clearing search results, and the Virtual Keyboard.  You can find more information

about the Virtual Keyboard in the Detailed tab.

Right-click context menu

The following menu appears when you right-click on one or more selected nodes:

Bible Search View context menu
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The following commands are available:

Select all: selects all nodes on the tree: if the currently selected node is a book node, then all book

nodes will be selected. If the currently selected node is a verse node, then all verse nodes will be

selected (same for translation nodes).

Copy all [n] verses from book of [xxx] appears when right-clicking on a book node and allows

you to copy all matched verses of a single book

Copy all [n] from the [n] selected books appears when you have selected multiple nodes (the

numbers in square brackets indicate the total number of verses that will be copied, according to

your selection)

Add all [n] verse(s) from book of [xxx] to list and Add all [n] verse(s) from the [y] selected

books to list work in a similar way as the above mentioned Copy all ... commands, except that

they transfer the verses to the active verse list.

Paste all [n] verse(s) from book of [xxx] to editor and Paste all [n] verses from the [n]

selected books to editor work in a similar way as the above mentioned Copy all ... commands,

except that they transfer the verses to the selected Book view editor (at least one Book view with a

user module is necessary, else these commands are disabled).

Clear clears the results

Close this view closes the current Bible search view (you can also press ESC to close this, or any

other view).

TIP: The format of the copied verses (e.g. whether a book name is included,

chapter number, etc) depends on the settings of the Copy Verses dialog.

Actually, the last options you have used in this dialog are used when copying

verses from here. So, if you need a particular format (e.g. chapter:verse after

the text), go the Copy Verses dialog, select it and click on Copy and Close. From

then on, the format of the verses copied here will match it.

An alternative is to hold down the CTRL key while you perform the copy: in that

case the Copy Verses dialog will open and you will be able to select a custom

format.

Detailed Tab

Overview

The Detailed tab is where you will find tools to perform detailed or advanced searches.  This is the place

to customize the way theWord searches the Bible.  Here you can select ranges to search, add search

operators, and change various options for the search.

The two basic type of searches are Boolean and Regular Expression (see the Search Syntax topic for

details) searches. Boolean searches are the default and the ones you will use most. 
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Bible Search View (detailed tab)

Search Options

(it would be good to read about the Search Syntax supported by theWord to better understand the following

options)

Below the search operators bar are the detailed options for the search.

1. Boolean - allows you to search using the default AND or OR operators.  There are also options for

the NEAR operator. You can also use the * and ? operators in your queries which stand for zero or

more characters (*), and zero or one character (?).

a. If default "OR" is selected, when two (or more) search terms are entered with a space between,

by default theWord will consider the terms to have the OR operator between them.  For

example, Jesus Christ will be considered Jesus OR Christ and will match the occurrences of

either "Jesus" or "Christ" in a verse.

b. If default "AND" is selected, when two (or more) search terms are entered with a space

between, by default theWord will consider the terms to have the AND operator between them. 

For example, Jesus Christ will be considered Jesus AND Christ and will match the occurrences

of "Jesus" and "Christ" together in a verse.

c. The Near operator breaks on selection allows you to customize where theWord will break the

search when the NEARw/NEARv operators are used.  When this is selected, the search will find

occurrences of terms that span either across chapters or books, depending on your selection.

d. Whole words only will match only entire words, not partial words.  By default theWord will

match both whole and parts of words in the search.  When this is selected, it will match only

whole words.  For example, if you searched for believe, with this option Unchecked, theWord

would find "believe", "believeth", "believest", etc.  With this option checked, theWord would find

only "believe".
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2. Regular Expressions - theWord supports full regular expressions in searches.  With this option

selected instead of Boolean, you can use regular expression syntax to match the terms you are

looking for.

3. Ignore case and diacritics - With this checked, theWord will ignore diacritical markings and

capitalizations.  For example, if you searched for jonah, with this option checked, the search would

match "jonah", "Jonah", and "JONAH", etc. With this option on, accents and diacritic marks (even

combining diacritics) will be ignored when searching. This option allows one to easily search Greek

and Hebrew texts without using accents, which can be confusing at times.

Virtual Keyboard

Virtual Keyboard Dialog

To the right of the search operators is the Virtual Keyboard icon.  This icon will bring up the dialog that

allows you to type into the search input box using the mouse instead of the keyboard.  This is useful

especially for languages in which the search input box has trouble rendering text.  You simply click the

letters you want to search, including spaces, and perform your search from there.

Search Ranges

theWord allows you to restrict your search in specifics parts of the Bible, called Search Range. A Search

Range is any number of continuous passages from the Bible. 

theWord has many pre-defined search ranges for searching the Bible.  Clicking the drop-down list will

show those available.  When you select a range, theWord will only seek to match your search terms within

that range of books.  
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Select verse range drop down

The ranges in black color are predefined. The ranges at the end in blue color are custom ranges that

have you have saved. The last entry in blue color in bold is the last custom range you selected (and did

not save).

You can create custom ranges to suit your needs from the Define Custom Range  dialog.  Click the

(define custom range) link (the one in the red rectangle in the first image of this topic) to display the

Define Custom Range dialog.

Define Custom Ranges dialog
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In this dialog you can define literally a range between any two verses.  In the left pane, simply type the

range(s) you want to make according to the instructions below the pane.  The right pane shows the range

that theWord is guessing that you mean. To type more than one ranges press the enter key or use the 

colon ; as separator. Obviously you can add as many different verse passages as you want. 

Once finished, check the Save this range as: checkbox, enter a name for the range, and press the OK

button.  The custom range will now appear in blue in the drop-down box in the detailed tab of the View. It

is not necessary to save a range, unless you want to re-use it. If you don't save it, the range will be added

as the last range (the one with the blue color in bold in the drop down box above).

You can also delete a previously saved custom range by pressing the Delete a previously saved range...

button and selecting the range you want to delete.

Options Tab

Overview

The Options tab of the Bible Search View allows you to customize the way that the Bible Search View

behaves.

Bible Search View Options tab

Auto expand/collapse tree nodes on results will expand all nodes when you click a top-level node, such

as the node for a book.

Show verses as tool tips on results tree will make a tool tip appear when the mouse is hovered over the

search results' verse references.
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No tool tips in results if verse text is visible will make a tool tip not appear if the verse's text is already

visible with the Show verse text next to the verse reference option is selected in the Fast tab.

Short book names in results will abbreviate the Bible book names.

Copy all verses from ranges, not only the first one will copy all results to the clipboard from a range

when the NEAR operator is used.  For instance, if using the NEARv operator, you have a result that says

"Mark 10:4-7".  With this options selected, when you copy this result to the clipboard, the entire range will

be copied, not just the first verse of the range (default).

Synchronize verses' text and tool tips with Bible View will cause both the tool tips and the verse text in

the results list (if displayed) to show the active translation, not the default translation.

Jump to Searched Bible when clicking on a verse will cause the Bible View to jump to the verse in the

translation that you searched when you click on a result.  With this uncheck, the Bible View will jump to

the verse, but in the active translation.

Show the 'Is this what you are looking for?' box will toggle the display of this area in the Detailed and

Fast tabs.  See Detailed tab. This panel is automatically hidden when you search (and it's not needed).

The Keep it visible all the time option will make sure that the panel is always there.

Always auto resize font of search input box will cause the font size of the input box to be larger. If you

uncheck this option, the font size will only grow when you search Greek and Hebrew and use non-

standard fonts.

Default range allows you to change the default number of adjacent verses/words to search when using

the NEARv or NEARw operators respectively.

"NEAR" operator applies by default to: determines the default NEAR operators used (either NEARv or

NEARw) when simply "NEAR" is used in the search.  See the "Is this what you are looking for?" area to be

sure.

Search History Options

Separate history for this window will cause the current Bible Search View to save its own history,

separate from other Bible Search Views.

Delete history on exit will delete the search history when you exit theWord.

Maximum history items determines the number of history items that are available in the history.

Minimum is 3; maximum is 99.

Search syntax

Overview

theWord supports two different types of searches: Boolean search and Regular expression searches.

Read below the syntax for each one. The full documentation of the Regular Expression Syntax is also

included.

The default search type is Boolean search, and is the easier to use as is closer to the natural way one

thinks. Yet the regular expression searches can provide some advanced features that would be

unavailable otherwise.

TIP: You need to be aware that different Bible modules may use a different

character for the apostrophe. This means that searching for the "Lord's" may

not find what you expect in some Bibles.

Boolean searches
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Boolean searches are performed by combining one or more words with operators and parenthesis.

Search operators are one of the important keys to performing advanced searches.  By inserting these

operators, you can vastly improve your search capabilities.  Operators can be combined with one another

and their respective search terms in many ways.  See below for explanations for all the operators:

Search Operators

The above reserved words are highlighted bold green, in the search input to indicate their special use.

When you need to search for the actual word "and, or, not, near, tr", they need to be escaped with a

backslash, except if they are part of a phrase search which is enclosed by quotation marks.

In Boolean searches, entering a simple word will find all verses containing that word. You may use

the * and ? meta-characters also. Words that start with G or H and are followed by a number, are

considered Strong indices.

Examples: (WWO stands for Whole Words Only option):

Example 1: under (WWO on) will match those verses in which the word under appears.

Example 2: under (WWO off) will match those verses in which the word under, understand,

understanding  appears.

Example 3: use (WWO off) will match those verses in which the word use, cause, because, caused,

Methuselah, household, etc appears

Example 4: use* (WWO on) will match those verses in which the word use, used, useth, usest, etc

appears. Notice the * at the end, with the combination of the WWO on option that causes

matches of words that only start with use

Example 5: ?use will match the word muse

Example 6: ??use will match the words cause, house, rouse, abuse, cruse, mouse, etc

Example 7: G123 will match any verse where the Strong number G123 appears.

AND - matches the words both to the right and left of the operator.  The ampersand (&) can also

be used instead of this operator.

Example: Jesus AND Christ will match those verses in which both Jesus and Christ occur.

OR - matches at least one of the words to the right and left of the operator.  The pipe (|) can also

be used instead of this operator.

Example: Jesus OR Christ will match those verses in which Jesus or Christ occurs.

NOT - negates the word following it.  The tilde (~) can also be used instead of this operator.

Example: NOT devil will match those verses which do not contain devil.

NEARv - matches the search terms to the left and right of the operator that occur within a specific

number of adjacent verses.  The default number of adjacent verses is 3.  This can be changed in the 

Options tab.  You can also change the number of adjacent verses for a single search by adding the

number of adjacent verses after the v.  See example 2 below.  The number sign (#) can also be used

instead of this operator (e.g. #8).

Example 1: Jesus NEARv Christ will match occurrences of Jesus and Christ within 3 verses

(default) of one another.



119

Example 2: Jesus NEARv8 Christ will match occurrences of Jesus and Christ within 8 verses of on

another.

NEARw - matches the search terms to the left and right of the operator that occur within a specific

number of consecutive words.  The default number of adjacent words is 30.  This can be changed in

the Options tab.  You can also change the number of adjacent words for a single search by adding

the number of adjacent verses after the v.  See example 2 below.  The at sign (@) can also be used

instead of this operator (e.g. @8).

Example 1: Jesus NEARw Christ will match occurrences of Jesus and Christ within 30 consecutive

words (default).

Example 2: Jesus NEARw8 Christ will match occurrences of Jesus and Christ within 8 consecutive

words.

XOR - matches those verses that contain exactly one of the search terms (and not the other) to the

left or right of the operator.  The caret (^) can also be used instead of this operator.

Example: Jesus XOR Christ will match those verse that contain Jesus but not Christ or Christ but

not Jesus.

TR - used to perform searches on Strong's Numbers and their translations.  To the left of the

operator should be a Strong's Number (H2345, G354) or any other valid expression, and to the

right should be an expression to search to see if the given Strong's Number is translated as such. 

"TR" means "translated" and this is how this operator functions.  It can also be combined with other

operators to perform different functions.  See examples.  The greater-than sign (>) can also be

used instead of this operator. 

To better understand how this operator works consider the following case: In the KJV, in Gen. 1:6 we

find the phrase Let there be a firmament which is mapped to Strong number H7549. Suppose that

we have the expression expr1 TR epxr2 to evaluate. The expr1 will be evaluated again the H7549

(as simple text), and then expr2 will be evaluated against the Let there be a firmament text. In

order for the whole expression to be true, both expr1 and expr2 must be true. So, H7549 TR

firmament will match, H7549 TR (let AND be) will match, H7549 TR firm* will match. Remember

that the TR operator is evaluated in reality for each combination of Strong number <-> Word/

Phrase for each verse (this is why such searches can be slower).

Moreover, the right operand/expression of the TR operator can be a morphology expression (m/).

In that case, the m/ operator is evaluated against the associated parsing and lemma information of

the word associated with the Strong number (this is available in modules where both Strong

numbers and Morphology parsing are available); (See below how the m/ operator is used):

Example 1: G2962 TR master will match those verses in which the Greek word κ ριος is

translated as master (example from KJV module).

Example 2: G2962 TR NOT lord will match those verses in which the Greek word κ ριος is not

translated as lord (example from KJV module).

Example 3: NOT G2962 TR lord* will match those verses where the word lord exists in a verse

but G2962 is not used for its translation (example from KJV module)

Example 4: G1096 TR m/V*3S will match those verse where the G1096 Strong number (the word

γινοµαι) appears in the 3rd person Singular (any tense) (example from TR module)

Example 5: G1096 TR m/V-???-[23]P will match those verse where the G1096 Strong number (the

word γινοµαι) appears in the 2nd or 3rd person Plural (any tense) (example from TR module)

m/ - used to perform searches on morphology data (grammar) and lemmas (roots) of original

language texts. Morphology data are coded with English letters (e.g. V-AAI-4SS, @ncmsa) where
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each one letter represents a grammatical part of the structure of the word (e.g. v is usually used for

verb, n for noun etc). Not all modules that contain such information use the same notation (The

RMAC module contains the analysis of these tags as they are found in the original Greek texts such

as TR, WHNU, Byz, Tischendorf). The general form of the search pattern for this operator is "m/

lemma@tag" (@ can be replaced with % for Aramaic words: when omitted, @ is assumed). The

lemma may also be omitted (the lemma information is not present in all modules: if absent, lemma

search tags are also ignored). The * and ? operators can be used for any number of chars and

single char. Also, square brackets can be used for a character class (e.g. [mf] means either m or f

for a specific character position). Morphological searches are basically string matching searches on

the lemma and morphology tag. Searches on the morphology tags are case sensitive if this is

defined in the module (irrespective of the Ignore case setting). The m/ tag may also be used as the

right operand of the TR operator in order to combine Strong's numbers and morphology

characteristics (see above).

Examples from the Greek NT (TR - Textus Receptus, WHNU, etc)

Example 1: m/N-NSF finds all Nouns in Nominative Singular Feminine form (run the example in

the TR or WHNU module)

Example 2: m/N-* finds all Nouns

Example 3: m/V-???-3? finds all Verbs in 3rd person

Example 4: m/V-A??-?S finds all Verbs in Aorist in Singular (any person)

Example 5: m/γεννάω@* finds all verbs whose lemma is γεννάω - notice that the module MUST

contain the lemmas

Example 6: m/γεννάω@?-???-3P finds all verbs whose lemma is γεννάω and appear in the 3rd p

lural

Example 7: m/γ*@N* finds all words whose lemma starts from γ and are nouns

Example 8: G1080 TR m/V-???-3P finds all words(verbs) with G1080 Strong's number that are v

erbs in the 3rd plural

Example 9: G80 TR m/N-D?? finds all words(nouns) with G80 Strong's number that are in Dative

case

Examples from the Hebrew OT (Westminster Hebrew Morphology module)

Example 1: m/@v* finds all verbs of Hebrew origin (notice the @)

Example 2: m/v??3*+Rq finds all 3rd person verbs, Qere readings only, Hebrew or Aramaic

(notice no @ or %, so both included)

Example 3: m/%*+Nq finds all Aramaic lemmas (notice the %) with the Note q (different Ketiv/

Qere relative to BHS).

Example 4: m/n*s*+* finds all singular nouns

Example 5: m/ברא@* finds all word forms whose lemma is ברא

Example 6: m/ב*@[na]* finds any Hebrew noun or adjective starting with the letter ב

( ) - used to group sub-expressions and assign priorities to the operators.  By default, all operators

are evaluated left to right.  Using parenthesis can change that order

Example 1: (Jesus AND Christ) OR (Peter AND Paul) matches the verses that contain both Jesus
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and Christ or both Peter and Paul.

" " - used to search an exact phrase.

Example: "Jesus Christ is Lord" matches the exact phrase.  If you omitted the double-quotes,

depending on your selected default boolean search operator (see below), it would be treated as 

Jesus AND Christ AND is AND Lord or Jesus OR Christ OR is OR Lord.

TIP: If you want to search for the literal text of any of the search operators, you

need to prepend the operator with a backslash \. For example, if you want to

find the verses that contain the word AND in it, you need to write \AND in the

input box.

Regular expression searches

The term Regular Expression refers to a specific syntax that is used to express text queries. Although it

can be quite complex, the basics are essentially relatively simple. The Regular Expression syntax is very

powerful and allows for very specific searches if ones knows how to use. You may read the complete 

Regular Expression Syntax. 

TIP: Ignoring diacritics will not work on regular expression searches. So if you

have the Ignore case and diacritics option checked, only the case of the letters

will be ignored.

Quick explanation

A regular expression is a pattern that is matched against a subject string from left to right. Most

characters stand for themselves in a pattern, and match the corresponding characters in the subject. As a

trivial example, the pattern

  The quick brown fox

matches a portion of a subject string that is identical to itself. The power of regular expressions comes

from the ability to include alternatives and repetitions in the pattern. These are encoded in the pattern by

the use of “meta-characters”, which do not stand for themselves but instead are interpreted in some

special way.

There are two different sets of meta-characters: those that are recognized anywhere in the pattern except

within square brackets, and those that are recognized in square brackets. Outside square brackets, the

meta-characters are as follows:

    \     general escape character with several uses
  .     match any character
  ?     matches zero or one time(s) the preceding character/expression.
  *     matches any number of times the preceding character/expression.
  +     matches one or more time(s) the preceding character/expression.
{x,y}   matches one or more of the preceding character/expression between x and y
times
 [ ]    Matches any single character, or range in the brackets (character class)
  |     start of alternative branch (or)
 \d     matches any decimal digit
 \D     matches any character that is not a decimal digit
 \s     matches any white space character
 \S     matches any character that is not a white space character
 \w     matches any "word" character (A "word" character is any letter or digit or
the underscore character, that is, any character which can be part of a "word")
 \W     matches any "non-word" character
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 \b     matches at a word boundary
 \B     matches when not at a word boundary
Part of a pattern that is in square brackets is called a "character class". In a
character class the only meta-characters are:
  \     general escape character
  ^     negate the class (not)
  -     indicates character range
  [     starts a character class
  ]     terminates the character class

Examples

Just using the above meta-characters, it is very easy to perform complicated searches:

Jesus|Christ will match any verse that contains the word Jesus OR the word Christ (notice that the

symbol | is used as an OR, e.g. match one OR the other)

\buse\b will match the word use but will not match words that contain the letters use in the middle

of the word (e.g., it will not match the words because, used, house, etc). Notice that the sequence

\b matches a word boundary (e.g. the beginning or end of a word).

\Buse will match the words cause, confused, house, etc but it will not match the words use, used,

etc. Notice that the \B (capital B) sequence matches when NOT at a word boundary, so no word

that start with use will be returned

Jesus.*Christ will match a verse that contains the words Jesus and Christ in that given order.

Notice that the .* sequence means: . (dot) means any character, * (star) means this character any

number of times. So the sequence .* matches every sequence of characters. So, in order for a

verse to match this given phrase, the words Jesus + <any number of characters> + Christ shall

be matched.

Jesus.*Christ|Christ.*Jesus will match those verses that contain both words Jesus and Christ in

any order. Actually, this phrase can be read as: Jesus <followed by> Christ OR Christ <followed

by> Jesus which is equivalent to Jesus AND Christ

Jesus.{1,10}Christ will match those verses that contain the words Jesus and Christ, in that order

but not more than 10 characters away. Notice that the "." (dot) means any character and the

phrase {1,10} means that this any character may be repeated between 1 and 10 times.

abrah?a?m will match those verses containing the word Abram or Abraham. Notice that the letter

h is followed by a question mark (?), which means that it matches 0 or 1 times. The same applies

for the second a (followed by a question mark).

abra(ha){0,1}m matches also Abram or Abraham. This syntax is almost identical (as to the result)

to the previous one. Notice that the phrase ha (enclosed in parenthesis) is followed by a quantifier

that defines that this phrase may be matched 0 or 1 times.

(god|man).*created will match those verses that contain the word god or man, followed by the

word created any numbers of characters away. Notice that the parentheses are used to group the

expressions god and man.

Book Search View

Overview

The Book Search View gives you the power to search the entire remainder of your module library, the

non-Bible modules. The color code for this View is purple.  A new Book Search View can be made by

simply pressing the shortcut F9. The Book Search View functions very similarly to the Bible Search View,

however it is somewhat more simple. You may hover over any result in the results tree to see the entire

matched topic in a tool tip (the tool tip appears only if you hover your mouse exactly over the text of the
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topic: moving your mouse on the white space area of the results list allows you to navigate without seeing

any popups).

TIP: Based upon your search terms and options, the Book Search View will

index your modules before performing a search. This indexing will only occur if

the module has never been searched, or the module has been updated since the

last search. Please note that book modules are sometimes very large, much

larger than Bible modules.  Indexing them before searching the first time may

take a long time, depending on your computer's hardware.  Please be patient.

Book Search View

TIP: Topics can be exported from the Book search view results. See Export

Topics

TIP: Searching a lot of Books may take a considerable amount of time to

complete; to cancel a running search you can press the ESC on your keyboard.

TIP: If you just want to find a word within the current topic, use the Find dialog

(right-click in reader and select Find in topic...)

Choosing Modules to Search

The Book search view allows you to search more than one modules at a time. The dialog to choose which

book modules to search can be found at the down arrow to the immediate left of the search input box.
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Module Selection Menu(s)

From these menus you may select exactly which modules you would like to search based upon the terms

you type in the search term input box.  By default, the View will search the currently active module only.

Select manually the modules to search... will display another menu to allow you to check the modules

you would like to search.  See below.

Manual Module Selection Menu

In this menu, simply check the modules that you would like to search for this particular instance.  The

modules can be grouped by type, alphabetically, or without grouping.  You can also save module sets

from this menu as well.  Once done, press OK.

Back in the Modules Selection Menu, you may also search All modules, All modules in active Book
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View, or a particular module set.

All modules will search all modules installed on your computer.

All modules in active Book View will search only those modules that are available in your currently

active Book View.

All modules of this set will search only those modules in the defined module set that you choose.

Creating subsets/collections of your library for effective searching

When your library starts to grow, it makes sense to start organizing your Books in modules based on a

specific category (e.g. Theology, Apologetics, etc). One way to do this is by using the Module Sets

functionality that is available from the Book View. All Module Sets that you have defined there are also

available as collections when you want to limit your searching to a sub-set of your library.

The Book search view allows you to create extra Search Sets that are only used for searching: these are

the sets created from the Select manually the modules to search...  dialog. These sets, although quite

similar in concept to the Module Sets, they are used exclusively for the Book Search view.

TIP: Do not confuse the Module Sets with the Search Sets! Although both are in

essence a pre-defined collection of modules, they differ in the following:

Module Sets are created from within the Book view Module Sets dialog and

can be used to limit a search but also as the collection of modules visible on

a Book view; they are more versatile since they can be defined in a 'virtual'

manner (e.g. all Commentaries), without defining the exact modules.

Search Sets are only created and used in the Book search view, and they are

comprised of a fixed set of modules.

Book Search View Options

Book Search View Options

Search for:

Any word - matches any one or more of the search terms.

All words - matches only the occurrences of all of the words in the same topic.

Exact phrase - matches the phrase exactly as entered.
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Search options:

Whole words only - matches only whole words, not partial words.  For example, with this selected,

when searching for believe, the View will also match "believeth", "believest", etc.

Ignore case and diacritics - ignore the presence of diacritical marks or capitalizations.  For

example, if you searched for jonah, with this option checked, the search would match "jonah",

"Jonah", and "JONAH", etc. This option will also ignore accents from Greek and Hebrew text.

Search in:

Subjects - includes the topic titles in the search.

Topic content - includes the topic content in the search.

The Auto-expand Nodes icon will automatically expand all notes in the results tree.

Navigating through the search results

Once you click on an entry in the search results list, a Book view will display the corresponding topic. The

search phrase/word will appear in the Book view with a red curly underline and yellow background. If the

topic contains more than one instances of the phrase/word, all of them will be highlighted. To navigate

through these you can use the Locate the next search match icon ( ) on the Book view toolbar.

Alternatively, you can use the following keyboard shortcuts of the Book view:

CTRL+SHIFT+UP ARROW to move to previous match within the topic

CTRL+SHIFT+DOWN ARROW to move to next match within the topic

Bible Tree

Overview

The Bible Tree is a view that provides an additional way to navigate through the Bible.  The contents of

the Bible are presented in a tree view so that you expand or collapse the tree to see the various chapters,

verses, etc.  You may access the Bible Tree in three ways:

1. Show/Hide Bible Tree icon on the View Options toolbar.

2. Keyboard shortcut F8.

3. Main menu: View -> Bible tree.

Using the Bible Tree
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Bible Tree

As you can see, the Bible Tree presents all the books of the Bible, their chapters and verses in a tree view.

 You may hover over any verse and see its text in a tool tip.  Also, you may click on a book name, chapter

number, or verse number and the active Bible View will jump to that book, chapter, or verse, respectively.

The first icon in the toolbar reloads the tree.  It will collapse all nodes and reset the tree to a completely

collapsed state.

The second icon synchronizes the Bible Tree with active verse in the Bible View.  It will not change the

verse in the Bible View; it will change the Bible Tree to match the active verse in the Bible View.

The final icon in the toolbar shows the Bible Tree Options. The Bible Tree has several options, as shown

below:

Bible Tree Options

Book names allows you to cause the Bible Tree to show full book names or abbreviated ones.  For

example, Genesis or Gen.

Show icons determines if the book, paper, and square icons are displayed next to the book, chapter, and

verses, respectively.

Book numbering refers to number the books of the Bible in the Bible Tree.  For example, 1. Genesis, 2.

Exodus, etc.  If Active is checked, the numbers are displayed.  You may customize the way the numbering

is displayed in the Format menu selection.  %d represents the digit and %s represents the book name.

You may also restore the default numbering format via the last selection.

TIP: if you right-click on a Book node, you will get a popup menu with all the

chapters of this book. If you right-click on a chapter node you will get a popup
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menu with all the verses of this chapter. This is an alternative way to use the Bible

tree!

View synchronization

Overview

View synchronization is a feature that attempts to bring you related material as you study the Bible or

read a book. The main idea behind it is to use the current Bible view as a starting point and try to update

all available Book views to display topics that are related to the current verse and word you are reading (

Type 1). A secondary function is to update the current Book view tabs with indicators (colored dots) that

show you whether other modules on the same view have relevant information (Type 2). 

TIP: Do not be confused with the 2 different types of synchronization:

Type 1 synchronization occurs when you work on the Bible view and affects all

Book views, depending on options (see below)

Type 2 synchronization occurs when you work in a single Book view and only

affects the module tabs of this same view: it only occurs whenever you change

the current topic on your Book view.

Whenever the Type 1 synchronization occurs, the Type 2 occurs also, but not the

other way round.

TIP: The information in this topic also explains how theWord reacts when you

click on a link (e.g. a Strong number, a link to a topic in a dictionary, etc). A link is

like a special type of synchronization: a view needs to react to display the topic

you clicked on.

TIP: All the Lookup... menus (they can be found when right-clicking on a word in a

Book view, in a Bible view or in a topic in the Topic List of a Book view), work with

this same logic. Please, read the How word lookups are performed for more

information.

Remember that these menus are treated like links, e.g. theWord tries to find a

book view to display the content. 

Type 1 synchronization

There are two pieces of data that are used to provide relevant information as you read through your

Bible:

1. The current verse you are reading (the current verse has a gray shadow by default; you change

the current verse by clicking on another verse, or scrolling your mouse wheel depending on 

relevant options).

2. A word you click on in the Bible view (called from now on current word) - notice that in that case a

click on a single word may cause a synchronization on more than one piece of information; see

below Example 2.

These two pieces of information are used to update your book views in the following way:
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1. The current verse is examined within all available commentaries you have installed to see if there is

relevant information.

2. The current word(s) is searched through the topics of all available non-commentary modules

(including general books, dictionaries, maps, etc).

Now, depending on the options set on each book view, the following might happen:

The current topic of your current module changes in order for the relevant information/topic to be

displayed

The module tabs of your book view are updated with some colored dots (e.g. , , ) on the

top-right that give feedback on whether the module has related information or not (a yellow light

also appears, depending on options).

The whole behavior is controlled from the Synchronize icon that you can find on the book view toolbar

(the red paper clip icon ). In order for any book view to be synchronized this icon should be

checked/pressed. If you click on the small black arrow on the right you will get three options:

1. Link commentaries allows you to set whether this book view will be synchronized on the current

verse

2. Link dictionaries/books/maps allows you to set whether this book view will be synchronized on

the current word(s)

3. Link this view even if inactive allows you to set whether this book view will be synchronized only

when it is the active one, or even if it is inactive.

Type 2 synchronization

This only occurs within a single Book view whenever you change the current topic. What happens here is

that all other module tabs of the same book view are updated with the colored dots described above to

show whether they have relevant information to what you read. The only difference is that in that case:

1. The current verses changes when you display a topic of a commentary (so the current verse

becomes the commentary entry)

2. The current word changes when you display a topic of a non-commentary (so the current word

becomes the subject of the book entry).

The Synchronize icon settings are irrelevant in that case since only the red-dots are affected with this

type of synchronization.

Status Bar indication

At any moment, the status bar at the bottom of the main window will display the current verse and

current word:  

The Dct entry is updated from both Type 1 and Type 2 types. The Cmt entry is updated only from Type

1 actions.

What do the colored dots , ,  mean?

These dots appear on the book view buttons/tab on the tab bar, and indicate whether the associated

module has relevant information to the current verse or current word. Notice that there are total six

dots, 3 pairs: The different colors (blue, red, green) are just used to match the color coding used for the

tab button text (that changes according to the module type). Yet, for each color there are two different

shades, a dark one and a light one. The dark one is used when there is a direct match on the current

verse or current word being examined, the light one when there is an indirect one. 

In the case of non-commentary modules, the faded dots will appear only if the Fuzzy matching for
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topics option is turned on. You may also read the topic How word lookups are performed to get an idea

of how the Fuzzy option affects word matching.

The following table summarizes the cases:

Dot Color Used for Meaning

Blue Commentaries
The commentary contains a comment for the current

verse precisely

Light blue Commentaries

The commentary contains a comment on a passage that

includes the current verse (including book and chapter

level comments)

Green General Books The Book has a topic that matches exactly

Light Green General Books The Book has a topic that matches using the Fuzzy logic

Red Dictionaries Same as Books

Light Red Dictionaries Same as Books

What about the yellow glows?

The yellow glow that appears on the button tabs is just an extra optional indication to help you identify

more easily the modules that have a match on the current verse or word. It can be turned on/off from

the Highlight buttons' background for matching modules. There are two different shades of the

yellow glow, that represent the two different types of match that are available (according to the table

above):

Remember, that the different colors of the dots have no meaning other than identifying the module type

(e.g. commentary, dictionary, general book, etc). The only two different states that you need to

differentiate are the dark glow/dots and the light glow/dots:

Dark is always used for exact matches (more relevant information)

Light is always used for fuzzy matches (less relevant information)

How commentaries are synchronized

Type 1: A commentary is a module that has content related to a verse, a range of verses (passage), a

chapter or a book of the Bible. The View Synchronization feature works only for verse and passage

comments. Let's suppose that you have a commentary that has comments for Gen 1:3-10; Gen 1:8-10;

Gen 1:9; Gen 1:9-20. Now, as you change the current verse of the active Bible view, the commentary will

display:

Verse in Bible view Commentary synchronized on Colored dot displayed

Gen 1:1 - (no comments  on this)

Gen 1:3 Gen 1:3-10

Gen 1:7 Gen 1:3-10

Gen 1:8 Gen 1:8-10

Gen 1:9 Gen 1:9

Gen 1:10 Gen 1:9-20

Gen 1:11 Gen 1:9-20

Notice that a verse level comment is preferred over a passage level comment (see Gen 1:9: there are
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matching topics: one for topic on Gen 1:9 and one for topic on Gen 1:9-20).

Type 2: The logic is identical with Type 1, the only difference is that the current verse changes when you
change the topic of a commentary. The colored dots on the tab bar are updated to display if other
commentaries have relevant information according to the table above.

TIP: Consider the following case (Cmt stands for commentary): 

CmtA with an entry on Gen 1:3-5

CmtB with an entry on Gen 1:2-6

CmtC with an entry on Gen 1:2

Your book view displays the CmtA and you click on Gen 1:4 on your Bible view,

so: 

CmtA will display a light dot (passage match for Gen 1:3-5) and will jump

to display that

Cmt B will display a light dot also (passage match for Gen 1:2-6) 

CmtC will display no dot

Let's say that you now click on the CmtB tab, so you see the entry for Gen 1:2-6

of CmtB. Now, the question is what happens to CmtC when you click on the CmtB

module tab? The two possibilities are:

1. CmtC should sync now on Gen 1:2, since in your Book view you now see

CmtB on Gen 1:2-6, so the driving verse is Gen 1:2

2. CmtC continue to be synced to Gen 1:4, since this is the originating verse.

The answer is that theWord behaves according to the logic in case 2. The

paradox here is that in front of you, you now see CmtB, it displays the entry on

Gen 1:2-6, yet CmtC has NO colored dot to indicate that it also has a comment

on Gen 1:2. The reason is of course that the Type 2 synchronization happens

only when you change the current topic on the book view. 

If the logic worked according to case 1, you would not be able to really go

through all the commentaries on your Book view to see what each one has to

say for Gen 1:4, which was the original verse that you clicked on your Bible view.

How books are synchronized? (books refers to all non-commentary modules)

The logic is identical to the one used for commentaries. Reading the example below will help you
understand how this is helpful

The dark/light dots are displayed according to the Fuzzy matching for topics option (if this is off, only

dark dots appear). You can read the How word lookups are performed topic on how the matching

occurs.

A notice on clicking on word links in the Bible view and elsewhere

Apart from the Bible text, the Bible view may also display several links (like Strong numbers, Morphology

codes, Commentary links) which, when clicked, will cause a Book view to display the target topic. In a very

practical way, clicking on a link is very similar to syncing to the current word. The major difference is that

when you click on an actual link, theWord may need to resort to change the current module of one of
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the book views in order to display the content (if no book view exists, a new one will be created; if none

of the current book views can display the target of the link -due to settings-, a message will ask you

whether you want to create a new view to do so)! Remember, that standard view synchronization will

never cause the current module of any book view to change!

TIP: Keep in mind, that when you click a word that is a link (e.g. a Strong

number), theWord tries no matter what to display the target (think of it like

commanding the program to try to respond to your request); 

When clicking on a non-link word in the Bible view theWord will do nothing if the

current settings do not allow any action to be taken.

Two exceptions/additions on matching

There are two important exception on the how theWord performs the matching:

1. In case you click on a word in the Bible view and the module has associated lemma information for

this word (this can only exist for original languages modules), then the matching will be performed

using the lemma, and not the actual word.

2. When matching words against dictionaries marked as containing strong definitions which also

contain the word lemmas corresponding to the definitions (all official Strong dictionaries modules

have this information), then the matching is performed on the actual topics (e.g. H1, H2, H3, ..., G1,

G2, G3, ...) but also on the lemmas (original words). This is very useful since it allows to sync

original word modules that have no strong indices with the strong dictionaries.

Putting it all together - examples

Keep in mind that Type 1 synchronization causes the current topic to be changed when clicking on a

word/verse. Also, when clicking on a link the current  module may also change to display the target. These

techniques can be proved very useful in order to use multiple book views and synchronize each one with

a different module.

The following examples use standard modules and abbreviations that should come with a default

installation of the program. It is a good idea to try out some of these examples since they will give you

valuable ideas on how you can organize your views and use the potential behind this mechanism.

To follow the examples, remember that:

Sync on/off means that the Synchronize icon   is pressed/checked

Link Cmts on/off means that the Link commentaries option is checked (click on the black arrow

above to see the popup menu)

Link Dcts on/off means that the Link dictionaries/books/maps options is checked (click on the

black arrow above to see the popup menu)

Link EiI on/off means that the Link this view even if inactive option is checked (click on the black

arrow above to see the popup menu)

Example 1: syncing on Strong and Morph codes, 2 commentaries following

Setup (omit some book views at a time to make it simpler): 

One Bible view with TR, make sure Strong and Morph links are displayed (see Bible view options)

One Book view (1) with Mickelson/Strong, Sync on, Link Dcts on, Link EiI on 

One Book view (2) with Thayer, Sync on, Link Dcts on, Link EiI on 
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One Book view (3) with RMAC, Sync on, Link Dcts on, Link EiI on 

One Book view (4) with TSK, Sync on, Link Dcts on, Link EiI on 

One Book view (5) with Gill, Sync on, Link Dcts on, Link EiI on   

Try:

Click on a strong number: Book view 1 and 2 jump to display the definition

Click on a morph code: Book view 3 jumps to display the definition

Click on a verse (e.g. Matt. 1:1): Book views 4 and 5 will jump to that verse. 

Click on Matt 1:2: Book views 3 and 4 follow.

Notice: Since Strong numbers are links, even if none

of the Book view 1 and 2 where displaying a

dictionary capable of displaying strong numbers, one

of the two would be used to do so. Remember,

clicking on a link is like 'commanding' theWord to

display the content.

Now, click on Book view 4 and 5 and turn off the Link EiI. Now, click again on Matt 1:1, Matt 1:2, ... Notice

that ONLY if one of the Book views 3 and 4 is active it will follow you.

Now, turn off the Sync from Book view 1 and change the module of both Book view 1 and 2 to something

else. Click on the strong number again and you will notice that Book view 2 will switch to Mickelson to

display the Strong definition. Book view 2 has still Sync on, so it will be used. 

Now turn off Sync from Book view 2 also and change the modules to NOT display Mickelson: click again

on the Strong link and you will notice that theWord asks you to use a Bible view to display the definition.

Example 2: syncing on Strong and actual word on a single click

An interesting feature of theWord is that it can hide Strong numbers, Morph codes and lemmas behind

the words (see Bible view options and check the Show no link, just show in a popup the ... option in

the Strong's number and Morphology codes pages). In this case, clicking on a word in the Bible view

actually sets the current word according to the Bible view options -> Word click options settings.

Setup:

One Bible view with KJV: Strong numbers should be on, yet with the Show no link, just show in a

popup the ... option checked, they should not be displayed

One Book view (1) with Mickelson/Strong, Sync on, Link Dcts on, Link EiI on 

One Book view (2) with ISBE, Sync on, Link Dcts on, Link EiI on 

Go to Matt. 1:1 and click on the 4th word generation. Notice that one Book view will show the Strong's

number, while the other one will display the topic Generation from ISBE.
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Bible Reading Plans

Overview

theWord allows you to setup a Bible Reading plan to help you read through the Bible, or a part of it.

You may choose to follow a pre-created reading plan or create one by yourself that suits your reading

habit. 

You may create a new Bible Reading plan from the menu File -> New Bible Reading Plan.

The difference between a pre-defined and a customized reading plan is the selection of passages for

each reading session. In a pre-defined plan, the passages that you read each time have been pre-

selected. In a customized plan, you have the option to select the passages you want. 

A reading session represents the collection of passages from the Bible that you want to read each time.

Usually, a reading session corresponds to the readings of a single day.

Pre-defined Reading Plans

Selecting the Choose a pre-defined reading plan option and clicking the Next button will take you to the

screen where you can choose from a selection of reading plans:

From this list you can choose one of the pre-installed reading plans. theWord comes by default with a set

of reading plans you can choose from, but you may download and install more reading plans from the 

official website. 

The files that represent reading plans have the extension .rdp.twm. 

TIP: The term Reading Plan is used in theWord in 2 different ways:

http://www.theword.net
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1. It refers to a pre-defined reading-plan template that you can use as a

starting point (like the one you can select here). A template reading-plan is

one you can download from the official site, and it will then appear in this list.

2. It refers to the actual, customized-to-your-needs, reading-plan that is the

result of this operation, which you follow each day. This one also stores your

reading progress and also the scheduled calendar days for all your sessions.

A non-template reading plan is the one you customize and then you base

your daily readings on.

Customized Reading Plan

Selecting the Create a customized reading plan by yourself option will allow you to pick by yourself the

passages from the Bible that you want to base your reading plan:

The Which Bible do you want to read? options allows you to base your reading plan on a specific Bible

translation or just select the passages and use any translation you want.

The Which part of the Bible do you want to read? options allow you to specify the actual books of the

Bible from which you want to read a portion each day. The I want to read list contains a pre-defined list

of Book combinations that you can base your plan on. Alternatively, you can just enter the actual books

you want in the Passages included text area by yourself. Notice, that if you want to read each day from

more than one books of the Bible, you just enter the book(s) in a new line.

For example, let's say that you want to read the 4 gospels, 1 chapter from each gospel a day: you will

enter in the Passages included text area the following:
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Notice that as you type in the books you want, the Parsed passages area on the left is updated to show

you what theWord has understood. You should check this area to make sure that what you entered here

is properly understood.

See that at this step you only enter the books that you want to read, not how much you want from each

book (this takes place at the next step).

Another example: you want to read each day a part from the Old Testament, a part from the New

Testament and a verse from Proverbs: you need to enter the following:

As you see, there is no indication at this step of how much you want to read from each part of the Bible,

just that you want at each session to read a part from these 3 book-ranges.

One last option in this screen is the Passages are the actual readings per session (advanced) checkbox

towards the bottom. This is an advanced option and you should normally ignore it. If you check it, then

what happens is that theWord will understand that the passages you enter in the Passages included text

area above do not refer to books that you want to split apart at the next step, but to actual reading

sessions. This is mostly useful for advanced users that want to create their own reading-plan templates

and have already split apart the individual passages of the Bible to put in each reading session.

Splitting up passages and setting up your calendar

Clicking the Next button (either from the pre-defined or custom reading plans) will take you to the

following screen:
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This is where you setup how often you want to read, and how much you want to read each time.

There are 2 ways to create your Bible reading plan:

1. Select a starting date and then say how often you want to read (e.g. select the days of the week

that you want to read).

2. Just split apart the selected Books in passages and complete a reading session each time you

want to.

If you prefer the second option, you need to check the I don't want to bind this plan to calendar days

check box at the top; else you should select the days of the week that you want to read from the How

often do you want to read? options.

The How much do you want to read each time? is where you select the length of the passages that you

want to read in each reading session. There are 3 ways to go here, either:

select the date you want to finish on (I want to finish on option)

select in how long you want to finish your readings, e.g. 1 year, 4 months (I plan to finish in

option)

select how many verses or chapters you want to read each time (I prefer to read each time

option)

Now, depending on your selection, theWord will automatically calculate either the length of the passages

(chapters/verses) that you need to read each day (first 2 options), or the date you will end your plan on, if

you select the third option.

If in the previous step you have selected to read each day from more than one books, then the following

option will appear on the right of the I prefer to read each time option:

Clicking on this option allows you to select the actual number of verses/chapters you want to read from

each book. Taking the previous example where one may want to read each day a part from the Old

Testament, a part from the New Testament and a verse from Proverbs, the dialog will look like that:
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See how you can select how much you want to read from each book. 

The Cycle if needed option means that if the readings of the selected book(s) end before the other ones,

you want them to be repeated. Obviously, when you have chosen to read each day from different books,

it is very difficult to split everything in exactly the same number of passages, so this option makes up for

it.

Preview your plan before deciding

As you click on different options on this screen, the Quick Info area on the top-right is updated to show

you what your selections 'translate to', in terms of how much you read in each session and when your

plan will end:

You can experiment with the options here until you customize the plan exactly as you want. Moreover,

clicking on the Preview plan link will show you the actual readings in tabular form:

Finalizing your plan

Clicking the Next button moves you to the last step of creating your reading plan:
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Here, you can select an Abbreviation, Title and Description for your new plan, as well as select the path

of the file where your reading plan will be stored. Remember that the Abbreviation is used in the Book

view Tab bar. The Preview Plan link here allows you to take a look to your plan just before you finalize it.

You can click on the Previous button if you want to change something.

Click on the Create my Reading Plan button to create the plan: the new reading plan will be added to

one of your existing Book views. Please read-on the Using your Bible Reading Plan topic on how you can

use your plan to follow on your Daily Readings.

Using your Bible Reading Plan

Overview

Your Bible Reading Plans appear in Book views like any other Book modules. They appear in the Book

view Tab bar in Purple color.

Please, notice that before a Bible Reading Plan appears here, you need to create one!

Viewing your Plan

When you select a Bible reading plan in the book view, the reading area displays a calendar. The day area

of each day of the calendar shows you the actual passages that you should read for this day:

Note, that the first day of the week in the calendar is determined by your

settings in the operating system, Region, settings
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This screenshot displays a plan with a passage from the Old Testament, one from the New Testament and

a verse from the Proverbs for each day. The day in yellow represents today's date. Clicking on a link will

display the passage in a Bible view.

For example, if one clicks on the Prov 1:1 link above (first link in the Sept 8 day), the Bible view will display

the following:

This is a normal Bible view, but the Start Reading mark/line has been added to help you identify the place

where your reading starts. You may read through until you encounter the Stop Reading mark/line, that

represents the end of the selected passage:

Once there you may click on the Done or Close link:

Clicking on the Done link will mark this day's reading as completed

Clicking on the Close link will just remove this mark/line from the Bible view

Notice that theWord tracks your readings on a session basis! This means that you can mark a session as

completed either by clicking on the Done link above, or by just clicking the small check mark in the

calendar view:
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In this particular example, there are 3 different readings for the Sept 8 date, so the other two links (Matt 1

and Prov 1:1) should be clicked and read before the completed mark is set.

Navigating your plan

When the Book view displays a Bible Reading Plan, the Topic List on the left displays 3 top-level nodes:

Clicking on the Calendar View and List View nodes expands them and displays sub-entries for each

month of your plan. Clicking on them makes the reader jump to this month.

TIP: Clicking on the Calendar View or List View nodes scrolls the reader to

today's date.

Notice that theWord provides an alternate List View method to display your sessions:

Reading Plans not bound to calendar dates

As mentioned in the section where you create your reading plan, theWord allows you to create a Bible

Reading plan without binding it to specific calendar dates. In that case, you only have a number of

sessions that you can read any time you want. For such reading plans, the Calendar View makes no

sense, so it is disabled (the No Calendar days found in Reading Plan message appears).

The List View mode can be used to view and navigate your plan:
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Notice that in this case, the left column shows the sessions counted from 1 (Session 1, Session 2, etc),

instead of the calendar days.

Stats & Actions

Clicking on the Stats & Actions node on the Topics List

 

will display the following:
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TIP: the same screen appears as the second tab of the Module Properties

dialog.

Current Progress: The first part of this screen displays some statistics concerning your reading progress

and your plan.

Falling behind on your schedule?: This function allows you to Catch Up on your reading plan if you have

missed some days. Just click on the Catch Up button to shift any unread scheduled readings forward, so

you start today with the first unread session.

Want to restart?: allows you to restart you reading-plan, by marking all your sessions as incomplete, and

also shifting  the start date to today (and of course re-calculating the calendar days, starting from today).

TIP: Although you can restart a reading-plan, you cannot change the days that

you want to read. For example, if you have created a reading plan where you

read every day of the week but then you decide that you only want to read on

the weekdays and not on weekends, you cannot change that from this screen.

Yet, there is a way to do this by creating a new reading plan based on an

existing one!

To do so, you need to go to File -> New Bible Reading Plan menu, and select

the Choose a pre-defined reading plan option. On the Next screen, just choose

from the list your existing plan (be sure that the show templates only option is

not checked). From then on, you can re-select your calendar options from the 

Next screen.

Using this method will create a new plan: you can then choose to Delete the

existing one if you want (you can delete a reading plan just like any other Book).

TIP: theWord allows you to have more than one Reading Plans active! This

means that you can create as many reading plans as you want and follow them

independently. The Daily Readings dialog gives you a complete picture of your

daily readings, each day.

Read the Daily Readings topic to see how you can access all the readings of a specific date from a single

place.
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Daily Readings

Overview

theWord provides a centralized way to follow your daily readings through the Daily Readings dialog:

You may access this dialog either from:

the menu Tools -> Daily Readings 

the  button from the main toolbar

Moreover, this dialog will automatically appear whenever you start theWord based on the Startup

options (see below).

How does the Daily Reading dialog work?

The Daily Readings dialog groups in a single place all your readings of the day. The readings include:

1. Your Bible Reading Plans, for which a reading session exists for today

2. Your Bible Reading Plan which are not calendar based

3. The Devotional Books that you have installed

Two icons are used to notify you of the completion status of each reading:

 means that the reading has not yet been completed

means the the reading is completed

TIP: For each reading plan, the actual verse passages appear on the right of

each link! 

If you click on the link that corresponds to the reading plan, then a Book view

with your plan will appear. If you click on a verse passage, you can start reading
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directly in your Bible view.

You can use this dialog to perform all your daily readings!

The easiest way to track your daily readings is through this dialog. You can click on the individual links on

this dialog to jump directly to the appropriate readings. 

This dialog will remain open while you perform your readings and may go behind the main theWord

window. Moreover, you can minimize this dialog to the Windows taskbar as it has its own taskbar button.

To complete a reading you need to:

for a reading plan with a calendar, you need to select the Done link or the completed check box (

read here)

for a reading plan without a calendar, you need to mark at least one session as completed

for a devotional book, you just need to click on the link in this dialog

Other Dialog Options

You can choose which devotional books you wish to read/follow each day by clicking on the Choose

Devotionals to read daily link. The Choose Devotionals dialog appears where you can select the

devotionals that you want to read on a daily basis. Alternatively, you can check whether you want a

specific devotional to be considered in your daily readings, by right-clicking on the module tab in the

book view and selecting the Follow devotional readings on a daily basis menu.

The Show unread only option at the bottom toggles whether you want this dialog to display all your

daily readings, or your unread ones only.

The Create a new Bible Reading Plan link opens the New Bible Reading Plan dialog.

Startup options

This dialog is designed to automatically popup whenever you start theWord based on your settings.

Clicking the Startup Option buttons, the following dialog appears:

From this dialog you can customize the way the Daily Readings dialog appears (or not) when you start

theWord. Most options are self-explanatory. 

The Consider a single reading per day for plans with no calendar option means that theWord will track

the readings for each reading plan without a calendar and once you complete a session for a particular

day, it will consider that the daily reading for this plan has been completed. Remember that for reading
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plans without a calendar, there are only sessions that are not connected with dates.
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Graphics Viewer

Overview

theWord includes an integrated graphics/image viewer that can display images embedded in modules.

To open the graphics viewer you may:

double click on an image 

right-click on an image and select Image -> Display in Graphics Viewer

Click on the Image button ( ) that appears when you hover your mouse over an image and

select Display in Graphics Viewer

Graphics Viewer window

Unlike the other views, the Graphics Viewer is an independent window, with a different button on the

Windows taskbar to control it (this means you can minimize it separately from the rest of the program). It

supports zooming, panning, smooth resizing and image navigation among all images of the current

module.

The bottom area of the Graphics viewer displays the current module and current topic to which this

image belongs to. In the parenthesis there is the index of the image within the topic (notice the #1 above).

This index increases only if there are more than one images within a topic.

On the top-left area of the viewer a thumbnail of the image appears if the image cannot fit the viewer

window. When you move your mouse over the thumbnail, a red rectangle appears which you can drag

around in order to move the actual image within the window. You may also drag the image with your

mouse for panning.

Graphics Viewer toolbar

The Graphics viewer toolbar appears at the top of the Graphics Viewer window. The following functions

are available:

Moves to the next/previous image of the current module. This function scans sequentially the

module starting for the current topic and current image until it finds the next/previous image and displays
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it. If a topic has more than one images, this function will navigate to the next previous image within the

same topic. If there are topics with no images they will be skipped, until the next topic that contains an

image is found.

Zooms in/out the image. You can also perform a quick zoom in/out by holding down the CTRL

key and scrolling the mouse wheel.

These buttons specify how the image is fitted in the viewer; First one

is for Actual view (e.g. no zoom in/out), second is to fit the image to the viewer window width, third is

to fit the image to the viewer window height, fourth is to fit the image in both the width and height of

the viewer window. The Zoom percentage drop down allows arbitrary zooming to be set.

Decides whether the viewer thumbnail is visible or not. Clicking on it toggles the visibility of the

thumbnail. Clicking on the small black down-arrow brings up a menu that allows you to control the

thumbnail size and it's transparency level.

The Options button allows you to set the following:

Image resize quality/speed: controls how images are resized: you may experiment with the

settings here to see how your computer handles the resizing. In general, modern computer can

handle quite fast even the Excellent quality setting. 

Pattern background decides whether the background of the image will be white or a pattern

black-gray checker-like background. This setting is important if you have transparent images: you

may need to adjust if you cannot see through very well.

Always on top causes the Graphics viewer window to always stay on top of the main window, even

when it gets de-activated.

Closes the Graphics Viewer window. You can also close the windows by pressing the ESC key.
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Copying Verses

Overview

One of the most beneficial features of theWord is the extensive and customizable ability to copy Bible

verses.  There are numerous ways to do this:

1. Right-click on a Bible verse in the Bible View.  From the menu there are several selections for

copying.

2. Via the Copy Verses dialog.  This dialog can also be found in Bible View right-click menu or from

the Bible View Options.

3. Via the Clipboard Monitor.

4. Keyboard shortcut CTRL+C to copy the active verse or selection (if a selection has been made).

TIP: If you select with your mouse some verses in the Bible view before

displaying the Copy Verses dialog, then the selected range will appear in the 

Step1 buttons! The first and last verse of your selection need not include the full

verse test; even a partial select will include them in the range.

TIP: If you hold down the CTRL key while you are copying verses, then the Copy

Verses dialog will appear to allow you to customize the format.

Copy Verses Dialog

The Copy Verses Dialog is the place customize the way in which theWord will copy Bible verses to the

clipboard.  The settings are saved so that every time that you copy verses after changing the settings,

theWord will copy them according to your chosen settings.  The Copy Verses Dialog is also the place to

perform advanced range copying and formatting.  See the dialog below.
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Copy Verses Dialog

As you can see, there is an easy step-by-step process to copy Bible verses in an advanced way.  At the

left, you can see a preview pane that displays exactly what your copied verse will look like when copied.  A

simple paste command in Microsoft Word will display the verses as the preview pane shows them.  At the

bottom of the preview pane, you can change the font size of your copied verses.

Step 1: Selecting Verses

Simply select the beginning and ending range of the verses you want to copy.  You may also mouse over

the drop-down boxes and use the mouse scroll wheel to rapidly change the verse or use the PAGE UP/

PAGE DOWN key.  Yes, you may copy the entire Bible at once.  This is not possible, however, only

modules that have a restriction because of copyrights.

Step 2: Selecting Translation

Simply select the translation from which you want to copy.  You can also choose to use shortened book

names, where book names would be in copy range.

Step 3: Selecting and Formatting Header and Footer

You may customize the format of both the header and footer in this section.  Placeholder preserve space

for the specific information from your particular copy.  They are variables that represent information that

will be used to format your copied content.  There are three placeholder symbols for headers/footers: %r

for range, %t for translation, and %n for new line.  For example, if I placed %r [%t], the resulting header/

footer would be (for the screenshot above) John 3:16-18 [KJV].

Step 4: Formatting the Verses
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Customizing the verse formatting is very similar to that of the header/footer.  The placeholders for the

verse formatting are the ones above (in Step 3) and: %b for book, %c for chapter, and %v for verse.  This

formatting can be performed before each verse, after each verse, and before each chapter (if applicable).

 You may use the pre-defined formats or make your own custom format.  You are encouraged to test

these formats and the usage of the placeholders that the pre-defined formats use.  Once you have

learned how to use the placeholders successfully, you can format your verse nearly any way you want. 

See the screenshot above for a good example.

Custom Sets

Custom sets, allow you to save and reload custom settings for your different needs.

Once you have finished selecting and formatting the verses you want to copy, you may press Copy and

Close to copy the verses to the clipboard and close the dialog, saving all the formatting for a future copy,

or press Copy to copy the verses and leave the dialog open.

TIP: The options you choose at this dialog (the format) will also be used when

copying multiple verse from other places from within the program (e.g. from the

Bible view, Bible search view, etc). 

Advanced options

You may further customize the format of the copied verses using the Advanced options button on the

bottom-right area of the dialog. The following popup menu appears:

Available options are:

Default verse text Font size: Since the verse are copied formatted, this is the text font size of the actual

verses. For example, if you paste  the verses to Microsoft Word, this will be the font size of the text.

Header (overall and chapter) relative font size: The Header font size is generally 1 point larger than

that of the actual verses. This option allows you to change the relative font size of the header.

Numbers and footer relative fonts size: In a similar way, you can set from this option the relative font

size of the verse numbers and the footer.

Bold text for non-verse elements: By default, the verse numbers, header and footer use a bold font. You

can unset this from here

Copy as text only (no formatting): Check this option if you don't want any formatting (bold, colors, etc)

for the copied text and headers

Copy only verse references: This option allows you to just copy the verse references and no text at all.

No verse reference ('Step 4') for single verses: When copying a single verse, it is usually the case that

one is not interested in including headers and footers, which is what this option is for.
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Clipboard Monitor

Overview

The Clipboard Monitor is a tool in theWord that parses all text in the Windows clipboard in search of

Scriptures references.  When a reference is found, theWord displays a window on the screen that gives

the references and the texts of those references.  This is especially useful while reading on the computer. 

You simply have select and copy a portion of text, and theWord displays all the references and texts so

you don't have to turn to each one.  Once the Clipboard Monitor window is open, you may also perform

additional actions on the parsed references.

theWord's Clipboard monitor is also multi-lingual.  It will seek to detect references written in languages

other than English (depending on the current language you use and installed languages).  Further, it also

recognizes abbreviations and chapter/verse notations for other languages also.

Clipboard Monitor Window

Clipboard Monitor Window

The window that you see above is the window that displays the verse references and texts for the parsed

references.  This window may be resized to suit your desire.

At the top-most left is the translation used in the Clipboard Monitor window.

Preferences... will display the Clipboard Monitor options dialog.  See section below.

The two small arrows enable you to navigate up and down through the verse if you have overflow.

The Show parsed verses list icon displays all the references that are being displayed in the Clipboard

Monitor window.  You can jump to a particular verse in the Clipboard Monitor window by clicking the

reference in this list.

Show Parsed Verses List
Menu
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The next icon will add all the references in the Clipboard Monitor window to the current verse list in the

Bible View.

You may also increase and decrease the font size for easier viewing.  Also, the close button is at the far

right.

Verse Title Bars

The verse title bars display additional information for that reference entry.  It also allows you to perform

various actions on the verses on an individual level.

Verse Title Bar

At the far left is that reference that is displayed below the title bar.

In gray and inside parentheses is the text in the clipboard that was recognized and parsed as the verse

reference displayed.

Copy copies the verse to the Windows clipboard.  theWord uses the settings already saved in the Copy

Verses Dialog to copy these verses.

Go causes the Bible View to jump to this verse.

To List sends only this verse to the active verse list in the Bible View.  This performs the same action as is

mentioned above, only on an individual verse level.

Changing the verses with the mouse

Hovering your mouse over a verse reference highlights it in yellow:

At the same time, the header displays the message Mouse wheel scroll to offset. If at this point you

scroll the wheel of the mouse, you will be able to offset the verse displayed by one verse up or down.

This feature allows you to read quickly the context of the verse. In case of a verse range, the whole

range is moved up/down a verse.

Clipboard Monitor Options

The Clipboard Monitor options allows you to customize the behavior of the Clipboard Monitor.  It can be

accessed in two ways:

1. Main menu - File -> Preferences -> Clipboard monitoring tab.

2. Preferences button in the Clipboard Monitor window (see above).
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Maximum clipboard text size (KB): determines the amount of text that theWord will parse if the

clipboard contains a lot of text.  theWord will begin at the top and parse until it reaches this data limit.

Bible text: allows you to customize the translation that is displayed in the Clipboard Monitor window.

Clipboard windows placement: determines where the Clipboard Monitor window displays when the

clipboard is parsed.

Auto close clipboard monitor window after n seconds determines how long before the Clipboard

Monitor window closes after it is displayed.  If this option is unchecked, you will have to manually close

the window.

The child option allows you to cancel the auto close of the window if you mouse hovers over the

window.

Auto close window on mouse movement will close the Clipboard Monitor window when the mouse is

moved if the option is checked.

Disable clipboard monitoring: With this option checked, the Clipboard Monitor will not display its

window when new text is found in the Windows clipboard.

Disable temporarily clipboard monitoring for content copied from within theWord (revert behavior

with SHIFT): Check this option so that when copying content from within theWord (e.g. from a Book view,

Bible view, etc.), the Clipboard Monitoring is temporarily disabled. You can revert this behavior by holding

down the SHIFT key while copying content.

Register CTRL+SHIFT+P global hotkey to parse the clipboard on demand

This setting will allow you to activate the Clipboard Monitor at any time, parsing the content of the

Clipboard, even if you have disabled the Clipboard Monitor. This can give you greater control so you
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don't have the Clipboard Monitor appearing at inappropriate times. If there is a conflict with this shortcut

key, a different key can be registered by a setting in the config.ini file. Parse Clipboard on demand, is also

available from the tray icon via right-click menu, if you have, Minimize window to tray icon, checked in the

preferences General tab.

NOTE that the clipboard must have content for it to be parsed by the

CTRL+SHIFT+P action. This will normally mean that you have copied some text in

some way before using this action. CTRL+SHIFT+P does not carry out that action

itself.

Using the clipboard monitor to insert verse text in other application

You can use the keyboard shortcut CTRL+SHIFT+V as a global hot key to force the Clipboard monitor to

paste back to the clipboard the text of the verse it has recognized.  This function is very useful because it

allows you to insert verse text from theWord to any other application without switching to theWord (the 

Register CTRL+SHIFT+V global hot key to paste back to clipboard verse text option in the

Preferences must be checked).

To better understand how this works do the following:

1. Make sure theWord is running (you can minimize it to the task bar) 

2. Open an editor (e.g. MS Word, Open office, Notepad, etc) and write a verse reference (e.g. John

3:16).

3. Select the verse reference in the editor and copy it to the clipboard (e.g. using CTRL+C from within

the program you use). The Clipboard monitor window will appear.

4. Without switching to theWord, press CTRL+SHIFT+V on your keyboard: you will see that the actual

text of the verse will be inserted in your editor.

TIP: A previous version of theWord used the CTRL+ALT+V combination for this

function: depending on your version you may need to use this shortcut instead.

You may also override this key combination by editing directly the config.ini file.
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Cross-References

Overview

Cross-references are verse references found inline with the Bible text that point to another passage or

verse in the Bible that somehow relates to the active passage.  They are displayed (depending on

options) inline with the Bible text in the Bible view:

Cross-references in Bible view (in red rectangles)

Cross-references in theWord function nearly identically to their printed counterparts that you would find in

the center column.  Cross-references can be toggled on and off in several ways:

1. Keyboard shortcut X in the Bible View.

2. Via the Bible View Options quick list (see Bible View Options).

3. Via the Bible View Options dialog.

TIP: You can make cross-references that reference verses or verse ranges.

These ranges support not only ranges within a chapter, but can also span whole

chapters as well.

TIP: A default sets of cross-references is installed along with theWord. This is a

user set and is called Default Cross-references. You can add or delete cross-

references to/from this set, or create more user sets.

TIP: Clicking on a cross-reference will cause the current Bible view to jump to this

verse. If you hold down the CTRL key then another Bible view will be used to

display the cross reference leaving the current view unaffected.

To read more about how cross-references are displayed in the Bible view, please read the corresponding

section at the Bible view options dialog.

Cross-Reference Sets

Cross references are organized in sets. Cross-reference sets are groups of cross-references that are

stored together.  

There are two types of sets:

1. User sets, which contain cross references that you can edit
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2. Bible modules sets, which comprise the cross-references that are found in some Bible modules.

Not all Bible modules have cross-references defined within. 

You may have any number of user sets.  You may set all, none, or only some of the sets to display

together in the Bible View.  Also, you may add a cross-reference to any set that you have.  Managing

cross-reference sets is done in the Organizing Cross-References dialog (see below).

Adding a Cross-Reference

Adding a cross-reference is very simple:

Right-click the verse to which you want to add the cross-reference.

In the menu, select Add a cross reference on [verse reference]...

Add Cross-Reference Menu

You will see the Add Cross-Reference dialog.

Add Cross-Reference Dialog

First, you simply type the verse or range for the cross-reference you want to add.  If you want to define a

verse range, separate the two verses by a dash.  theWord will attempt to guess the reference you are

referring to.  If you like, you may manually select the book, chapter, and verse using the down arrow to

the right of the input box.

Next, in the Cross-reference set select box, you should choose which cross-reference set that you want to

add this particular reference to.
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The button to the right of the Cross-reference set select box will display the Cross-References Statistics

dialog.  This dialog displays all the cross-references in the selected set.  This dialog gives you the ability

to see all the references in one place.  From this dialog, you can display tool tips of the actual reference

texts, delete cross-references, and see relevant statistics for that cross-reference set.  See below for a

screenshot of this dialog.

Finally, the Organize button displays the Organize Cross-References dialog, which is explained below.

Cross-Reference Statistics Dialog

Deleting a Cross-Reference

Deleting a cross-reference is similar to adding one.  When a cross-reference is displayed in the Bible

View, right-click on the reference, and select Delete cross-reference [verse reference]...

A dialog will appear: the Delete Cross-Reference dialog.
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Delete Cross-Reference Dialog

From this dialog, you must select the set from which you want to delete the reference.  If this cross-

reference appears in more than one set, check the box(es) of the set(s) from which you want to delete the

reference that you right-clicked.

TIP: You can only delete cross references from user sets but not from Bible

modules sets (e.g. cross-references that are embedded in a Bible module)

Organize Cross-References Dialog

This dialog is used to modify or create new cross-reference user sets.  It can be accessed in two ways:

1. Via the Organize button in the Add Cross-References dialog.

2. Via the main menu: Tools -> Organize cross-references...
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Organize Cross-References Dialog

The pane at left give the cross-reference sets that are available.  The buttons at the right allow you to

perform various actions on the selected set.

New will create a new set.  See New Cross-Reference Set dialog below.

Rename will rename the selected set.

Copy from allows you to copy the cross-references in one set into another set.  To do this, select the set

(s) to which you want to add the cross-references, then select Copy from and select the set from which

you want to copy.  Once finished, the references should appear in the target set.

Clear will delete all the cross-references within that set, but will not delete the set itself.

Delete will delete the set and all the references therein.

Explore will open the Cross-Reference Statistics dialog (see above) for that set.

The Manage files... button allows you to manage the various files that store the cross-references.  See

below for more information.

New Cross-Reference Set Dialog

This dialog allows you to select options when creating a new cross-reference set.
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New Cross-Reference Set Dialog

First, you should type the name that you want for the new set.

Next, you may select to make a new empty set with no references, or copy the references from an existing

cross-reference set.

Third, you may choose to store this new set as a part of an existing cross-references set file, or create a

new file.

Managing Cross-Reference Set Files

theWord stores cross-reference sets in files called [filename].xrefs.twm.  These files can each contain

more than one set.  These files must be stored in a folder recognized by theWord to be read and be

available in theWord.

Manage Cross-Reference Set Files Dialog
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In this dialog, you can see (as in other places) the paths to your cross-reference set files.  From this

dialog you may add a new cross-reference set file or stop using an existing file.  Double clicking a file in

the left pane will display the path to the file.

TIP: You can share sets of cross-references with others by just sharing the file

that they are stored in.

Additional Options for Cross-References

Additional options can be found in the Bible View Options dialog.  See this section's help for more

information.
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Layouts

Overview

A Layout is just a specific arrangement of views, and their settings. Think of it as a snapshot of what you

see at any particular moment. 

theWord comes with a predefined set of layouts that you can access from the menu View->Layout-

>Predefined Layouts or from the layout icon ( ) that can be found on View options toolbar.

Predefined layouts

To access one of the predefined layouts use the View menu.

TIP: If you find the look of theWord overwhelming or complicated in any way, try

to choose one of the predefined layouts at the top of this list! Choose the 

Beginner or Novice layout and you will get immediately a clean and straight-

forward interface concentrated on the Bible.

Save and restore your own layouts

You can use the same menu to Save, Rename and Delete a layout. 
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To save a new layout you can just click on:

as: 'User layout n' (n=1, 2, ...) to save the current layout with this name, or

enter a more descriptive name in the or as input box and press enter, or

click on one of the previously saved layouts to overwrite/update it.

Recalling/applying a layout

To recall/apply a layout you just simply click on it's name from the menu:

The last layout you applied is indicated in bold in the menu (check the red rectangle in the above image).

TIP You can save any changes you have made to the last user layout by

pressing CTRL+ALT+S. You will get a confirmation message first. Notice that this

will only work if you have already chosen a user layout to display in the first

place. 

What is saved within the context of a layout?

A layout saves all the views and their individual settings. This includes:

for Bible views, the current verse, current modules, selected Bibles in compare view, colors, etc

for Book views the current topic, module, module set, etc
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for Search views the search phrase, options, etc

Notice that global settings (such as the main window position and size, Global Preferences under the File-

>Preferences dialog, etc) are not included in a layout.

Where are the layouts saved?

User layouts (the ones you create) are saved in the file my.lyts.twm which can be found in the Personal

files folder location. Predefined layouts are stored in the file default.layouts.twm under the Misc folder.

Read more on files and locations. 
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Popups

Overview

theWord uses popup windows to display relevant content when you move your mouse over a link or

other 'content sensitive' areas:

In the above screenshots you can see:

1. A popup over a Strong number in the Bible view which displays the content of the Strong entry

2. A popup over a verse reference (Job 38:4)

3. An active popup and the popup context menu

The popups in theWord are displayed with a small delay so they don't clutter the screen if you just want

to move your mouse over sensitive content. When a popup appear, you can just move your mouse in

order to hide it.

To activate the popup you need to hold down the SHIFT key and move your mouse over the popup: in

that case, the popup changes colors to show that it is activated. Activating a popup allows you to perform

several functions! Alternatively, you can hold down the RIGHT MOUSE BUTTON and move the mouse over

the popup to activate it.

Changing the popup width

The width of the popup is fixed and it's height is increased/decreased to accommodate the content that

needs to be displayed. If the content will not fit on the screen, a scroll bar appears: in order to scroll the

content in the popup you will need to activate it (e.g. hold down the SHIFT key) and move your mouse

over the popup.

To change the width of the popup, activate it and then drag it from it's edges to resize it. theWord will

remember the width you set so it will be used from then on (remember the height varies depending on

the content).

Links in the popup

You can click the links in the popup (if you move your mouse over them), as you can do with any other

links in theWord: in that case, a Bible or Book view will be used to display the content that the links refers

to. Notice that no second popup will be used to display the content of the links in a popup (there can be

only one popup visible at any time - no popup-in-popup is supported).

Popup context menu - Default font size
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Right-clicking on the content area of the popup will display the context popup. The functions are self-

descriptive. 

Notice that if you zoom in/out (either using the menu or the CTRL+MOUSE WHEEL move), theWord will

remember the setting and will use it from then on.
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How word lookups are performed?

Word lookup refers to the function where theWord looks through the topics of all Dictionary and Book

modules (referred below as Books) and tries to locate the ones that match a particular word. 

Word lookups are very frequent in theWord and are executed in the following two major cases:

1. When you click on a word in the Bible view, a word lookup is performed to decide which Books

contain a topic for this word - the result is the changing of appearance of the tabs of the Book view

(see View synchronization). Similar case is when you right-click on a word in the Bible view and

select the Lookup menu (submenu's are populated with all matching topics of all Books)

2. When you right-click on a word in the Bible view (Lookup menu)

3. When you right-click on a word in the Book view (either in the Topics List or in the viewer itself) and

select the Lookup menu.

Word lookups are performed in order to synchronize the different Bible and Book views and to provide

visual feedback on the Book view tab bar. Read the View synchronization topic for more information.

There is a single option that modifies the way that lookups are performed: this can be found under the 

Book view options menu and is named Fuzzy matching for topics. When this option is checked, then

theWord tries to perform a more clever word match in order to match words with different endings. The

accuracy of the result may differ heavily based on the language of the word being looked up and the

grammar rules of this language concerning word-endings. 

In general:

when lookups are initiated from a Bible view, then the Fuzzy logic is always used

when lookups are initiated from a Book view, then the Fuzzy logic is used only if the current Book

view has this option set.

How the lookup is performed

Each topic of each Book is broken up in individual words. Each word is then compared (using the Fuzzy

logic if appropriate) with the lookup word. If there is a match for any of the words that comprise the

topic, then a match is assumed. If there is a topic that exactly matches the word being looked up (e.g. a

topic that consists of a single word), then this topic gets priority in the match list.

The result of a word lookup is usually a single topic (or no topic, if no match is found): this single topic

(which is chosen according to the above rule and given priority) is used when this matched topic is to be

used (e.g. when changing tabs in the Book view or when displaying a topic in a Book view when clicking a

word in the Bible view). 
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Importing personal notes from theWord 2

Overview

You can import all your notes that you have created with an earlier version of theWord (version 2 or

earlier) from the File->Import personal notes... dialog. In previous versions, all your personal notes are

stored in a single file called user.edb. Click Browse in the Import personal notes from previous version

dialog to select the user.edb file to use.

How your notes are migrated to the new version

Version of theWord prior to 3 were more limited in the ability to make personal notes. The new version

allows you to create and store your notes in any type of supported module  (commentary, book, etc). 

When importing notes from a previous version:

Verse lists are imported as they are; no major changes exist in this area

Bible formatting (highlighting) information is imported as is, no major changes exist in this area

Footnotes of version 2 are converted to a General Book with the name My footnotes. 

Book/Chapter/Verse notes of version 2 are converted to a commentary with the name My Verse

Notes.

Subject notes (on various subjects) are converted to a General Book with the name My subject

notes.

If any of the above categories is empty (e.g. no footnotes), then no module will be created. This dialog

allows you to preview the number of notes found in the selected user.edb file: you can also choose to

only import part of your personal data (by checking/unchecking the corresponding category).
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Original language texts popups and word-click options

This topic is just a summary of information found elsewhere on this manual and provides some more

advanced information on how theWord behaves in relation to original language modules.

Overview

Original language Bible modules may contain extra information, apart from the actual text, such as Strong

numbers, Morphology codes, Lemmas and more. Modules like that include the Textus Receptus (TR),

Westcot-Hort (WHNU), Westminster Hebrew Morphology (WHM), etc . 

The following extra information can be attached behind each word: STRONG number, STRONG number

2, STRONG NUMBER 3, MORPH tag, LEMMA - root, <generic-messages>.

Examples

Remember that when a LEMMA is included in a module, then it is being used for the word lookup

function. Moreover, dictionaries that are marked as Strong are being looked-up on the root of the

words, AND on the strong indices!

Let's consider the following questions:

1. What happens when the mouse hovers over a word?

2. What happens when the user clicks on a word

3. What happens when the user right-clicks on a word.

4. How the Lookup dictionaries work in combination with the new features?

Problem 1: User hovering over a word.

Since more than one piece of information may be associated with a word, theWord creates a popup that

includes all associated information. Specifically:

1. If there is a STRONG, STRONG2, STRONG3 associated index, it is being looked up and the result(s)

displayed (based on options)

2. If there is a MORPH tag, it is also being looked up (based on options)

3. If there are extra messages attached, they are also displayed

4. If lookup dictionaries are enabled, they are appended also.

Example: let's consider the WHNU module. Suppose we have enabled lookup dictionaries with

Mickelson dictionary. Also Strong and Morph are active on the Bible view:

User hovers over first word of Mt 1:1 βίβλος: the popup displays 3 entries: first is the morph info

(N-NSF), second is the key from the strong (G976), and there is a 3rd entry which is again G976: this

comes from the lookup dictionaries: theWord looks-up the word βιβλος in Mickelson, but  since

Mickelson is marked as a strong dictionary, it does NOT search the subject (e.g. H1, H2, ...) only,

but also the actual original words in Mickelson: so it finds a match for βιβλος (which is G976 and is

being displayed a second time).

User hovers over 2nd word γενεσεως: the popup displays 2 entries: morph and strong. But there is

no 3rd entry because the word γενεσεως is NOT found in Mickelson, since the original word is

γενεσις! If there was associated LEMMA information behind the word, then a 3rd entry would also

appear (since the root of γενεσεως would be γενεσις and, as said above, the LEMMA would be

used for the dictionary lookup).
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Problem 2: user clicks on a word

Normally, clicking on a word will cause the current dictionary entry in all Book views to be updated (e.g.

dictionaries will be synced to the word being clicked, see View synchronization). The question now is:

since we now have more information behind a word, which part of it should be used to sync the book

views? The answer comes from the Word click options category in the Bible view options dialog. if you go

to this page, you will see that there are 4 options there, and you can set which of these will be performed

and in which order.

The question one could set is: what does it mean to lookup all 4 of them? The answer is that it can be

used to sync more than one book views!

Example

Open 4 book views, and set one to RMAC, one to Thayer, one to Mickelson, one to LSJ. Go to 1Cor

1:6 and click the 3rd word µαρτυριον. You will see that all 4 book views are synchronized, each one

with a different part (make sure that in Bible view options-> Word click options you have checked

the Perform the lookup on all checked items'and that each of the Book view has the Link this view

even if inactive checked).

You see, clicking on this word, which (in this module) carries 3 pieces of information (STRONG,

MORPH, the word itself) you can cause 4 books to get synchronized, each with a different piece of

this information (2 of the views, Thayer and Mickelson use the same piece, namely STRONG).

Problem 3: what happens when a user right-clicks on a word

The answer here should be quite obvious now: for each piece of information, there is a separate Find...

menu and a separate Lookup'menu! Maximum 6 of each (Find [word]. Find STRONG, Find STRONG2, Find

STRONG3, Find MORPH, Find LEMMA). Of course, each find menu automatically enters the appropriate

expression the Bible search view. Same applies for the Lookup: yet, remember that the Lookup logic is

always the same: the word being looked up is being search in all subjects of each dictionary/book

module.
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Shortcuts

Overview

theWord uses several  keyboard shortcuts to access functions that are also available via menus and

toolbars. There are three types of shortcuts:

1. Global shortcuts which are active independently of which is the active view or control

2. View specific shortcuts that apply only to the active view (to activate a view you click anywhere in

the view's rectangle)

3. Control specific shortcuts that apply to the active control (to activate a control you click on that

control)

Global Shortcuts

Global

Shortcuts

Action

Shortcuts for function keys F1 until F12

F1 Displays online help

F2 Search Books - set focus to Book search input box (if a Book search view is not present,

one is created)

SHIFT+F2 Search Book titles of active Book view

F3 Search the Bible - set focus to Bible search input box (if a Bible search view is not

present, one is created)

SHIFT+F3 Search Bible titles of active Bible view

F4 Sets the focus to the Verse-reference input box in order to enter a verse reference with

the keyboard

F5 Display the Copy Verses dialog

CTRL+F6 Show/hide view captions

F8 Show/hide the Bible tree

Book search views

F9 Create Book search view

SHIFT+F9 Create floating Book search view

CTRL+F9 Navigate Book search views

CTRL+SHIFT+F9 Close active Book search view

Bible search views

F10 Create Bible search view

SHIFT+F10 Create floating Bible search view

CTRL+F10 Navigate Bible search views

CTRL+SHIFT+F1

0

Close active Bible search view

Bible views

F11 Create Bible  view

SHIFT+F11 Create floating Bible  view

CTRL+F11 Navigate Bible  views

CTRL+SHIFT+F1

1

Close active Bible  view

Book views
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F12 Create Book view

SHIFT+F12 Create floating Book view

CTRL+F12 Navigate Book views

CTRL+SHIFT+F1

2

Close active Book view

Global  shortcuts

CTRL+SHIFT+L Reload current language file (useful when editing the .lng file during translation)

CTRL+SHIFT+R Reload active Bible module. Useful if you are editing an .ont file and you want the

changes to appear immediately without restarting theWord. Hotkey can be changed

with the bible.module.reload.hot.key config.ini parameter.

CTRL+SHIFT+V Paste back verse text from Clipboard monitor to the clipboard

CTRL+SHIFT+S Save current arrangement in last selected user layout

Bible view specific

Bible View Specific Shortcuts Action

Bookmarks

CTRL+0-9 Jump to Bible view bookmark 0 until 9

CTRL+SHIFT+0-9 Set bookmark 0-9 to current verse

CTRL+SHIFT+B Add new bookmark to next available bookmark index

Navigation

SPACE Scroll down a page/move to next chapter

CTRL+UP ARROW/DOWN

ARROW Scroll view down/up

DOWN ARROW Next verse

UP ARROW Previous verse

RIGHT ARROW Next chapter

LEFT ARROW Previous chapter

CTRL+RIGHT ARROW Next book

CTRL+LEFT ARROW Previous book

BACKSPACE History back

ALT+LEFT ARROW History back

ALT+RIGHT ARROW History forward

MOUSE FORWARD/BACKWARD

BUTTONS

Some mouses have extra buttons for forward/backward navigation:

these can be used to to back/forth in history

ALT+0..9 Activate first, second, … ninth Bible view tab (0 for tenth)

ALT+P Display the Compare view

ALT+L Display the List view

<ANY NUMBER> Jump to this verse number (supports multi-digit verse numbers also)
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SHIFT+<ANY NUMBER>

Jump to this chapter number (supports multi-digit chapter numbers

also)

Actions

CTRL+A Selects all text

CTRL+L Add current verse to current list

CTRL+C If selection exists, copy it; if not, copy current verse

CTRL+O Display Bible view options dialog

CTRL+P Print

CTRL+T Show/hide viewer icons (the vertical toolbar in the Bible view)

CTRL+H Compare view: arrange Bibles horizontally

CTRL+J Compare view: arrange Bibles vertically

CTRL+NUMPAD+ Zoom in (this is the plus sign on the numeric keypad)

CTRL+NUMPAD- Zoom out (this is the minus sign on the numeric keypad)

CTRL+MOUSE WHEEL Zoom in/out 

Quick view options (plain keys)

H Show/hide Chapter Headings

F Show/Hide footnotes

U Show/hide User formatting

J Show/hide words of Jesus in red

O Show/hide OT quotes in bold

P Toggle Paragraph mode 

X Show/hide cross references

S Show/hide Strong's numbers

SHIFT+S

Toggle display of Strong's numbers as separate links or 'hidden' below

the actual word

M Show/hide morphological codes

SHIFT+M

Toggle display morphological codes as separate links or 'hidden'

below the actual word

Q Show/hide header and footer links

L Show/hide commentary links

D Enable/disable word definition popups (dictionary lookups)

C Show inline commentaries below each verse

T Show inline commentaries beside each verse

N Hide inline commentaries
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W Create a new Bible view

<MODULE TOGGLE KEYS>

Some modules have content that can be switched on/off using specific

toggle keys. These can be found in the module properties Information

dialog (Help->Info).

Verse list

CTRL+W Show Contents (all verse lists)

CTRL+A Select all

CTRL+S Save verse list

DOWN ARROW Next verse in list

RIGHT ARROW same as DOWN ARROW

UP ARROW Previous verse in list

LEFT ARROW same as UP ARROW

HOME Jump to first verse

END Jump to last verse

SHIFT+DEL Delete current verse

PAGE UP Jump 6 verses up (or next row in multi-column display)

PAGE DOWN Jump 6 verses down (or next row in multi-column display)

CTRL+P Print

CTRL+NUMPAD+ Zoom in (this is the plus sign on the numeric keypad)

CTRL+NUMPAD- Zoom out (this is the minus sign on the numeric keypad)

CTRL+MOUSE WHEEL Zoom in/out 

SHIFT+UP ARROW move up current verse

SHIFT+DOWN ARROW move down current verse

SHIFT+MOUSE WHEEL UP move up current verse

SHIFT+MOUSE WHEEL DOWN move down current verse

CTRL+SHIFT+UP ARROW Subtract a verse from current verse passage

CTRL+SHIFT+DOWN ARROW Add a verse to current verse passage

CTRL+SHIFT+MOUSE WHEEL UP Subtract a verse from current verse passage

CTRL+SHIFT+MOUSE WHEEL

DOWN Add a verse to current verse passage

Book view

Book View Specific Shortcuts Action

CTRL+A Selects all text
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CTRL+N Add new topic

CTRL+SHIFT+N Update current topic subject

CTRL+SHIFT+D Delete selected topic(s)

CTRL+ALT+SHIFT+D Delete selected topic(s) without confirmation dialog

SHIFT+(CTRL)+DELETE Delete selected topics(s) - if topics tree is the active control

SHIFT+TAB Navigate to next control (if TAB is used to insert tabs, else TAB itself is

used)

CTRL+NUMPAD+ Zoom in (this is the plus sign on the numeric keypad)

CTRL+NUMPAD- Zoom out (this is the minus sign on the numeric keypad)

CTRL+MOUSE WHEEL Zoom in/out 

CTRL+SHIFT+UP ARROW Previous search match

CTRL+SHIFT+DOWN ARROW Next search match

CTRL+S Save reader content immediately

CTRL+D Auto-detect all verse references in current topic

CTRL+R Display the Bookmarks dialog

CTRL+SHIFT+U Toggle user module property for current module - notice that any user

formatting will become permanent.

Formatting

CTRL+SHIFT+P Right-To-Left paragraph

CTRL+SHIFT+O Left-To-Right paragraph

CTRL+SHIFT+K Right-To-Left text fragment (selected text)

CTRL+SHIFT+J Left-To-Right text fragment (selected text)

CTRL+SHIFT+F Focus the font combo box, if the book view formatting toolbar is active

CTRL+SHIFT+P Focus the font size combo box, if the book view formatting toolbar is

active

CTRL+X Cut

CTRL+C Copy

CTRL+V Paste

CTRL+Z Undo

CTRL+Y Redo

CTRL+B Bold

CTRL+I Italics

CTRL+U Underline

CTRL+. Grow font by one point
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CTRL+, Shrink font by one point

CTRL+SHIFT+= Superscript (toggle)

CTRL+= Subscript (toggle)

CTRL+K Insert hyperlink

CTRL+P Print current topic
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Advanced functions

Overview

theWord provides several more advanced functions that allow you to customize it in more ways to suit

your specific needs. Select one of the child topics to read more.

Files used by theWord

Overview

theWord software uses several different types of files. This section lists each file type and how it is used.

The main executable file is named theword.exe. There are no other file dependencies to successfully run

theWord. The sqlite3.dll file is also required, yet if it is not found it will be automatically created. At least

one Bible file is required to run theWord (the program will prompt you in case none is found).

File locations

theWord uses several folders to store files. Depending on the installation type (normal or compact) and

your operating  system, these folders reside in different locations. You can see at any time the location of

these folder from the Help->About dialog, under the File locations tab. At this dialog you can also see a

list of all the files being used by theWord.

The following table summarizes the folders used by theWord:

Folder What is stored in it?

Installation folder

This is the folder chosen during installation. The main

executable file (theword.exe) is saved there amongst other

files

Personal files folder

All files created by you. This is the folder to include in your

backup program to make sure that all your personal files,

notes, etc are safely backed-up. Each user of the computer

has a separate copy of this folder

Common modules

folder

All modules you install reside in this folder. All users of a

computer share files in this folder

Cache folder

Temporary data are stored in this folder. If you delete files

from this folder they will be recreated the next time you

restart theWord. 

Language files folder
Language files (*.lng) are stored there: theWord looks at this

folder to locate language files

Files used by theWord

This is the list of all files used by theWord:

File name Folder in

normal

installation

Folder in

compact

installation

Usage

theword.exe Installation Installation Main executable file. This is the actual program

sqlite3.dll Installation or

Cache 

Installation or

Cache

Library file, used by theWord. If it is not found in

the same folder as theword.exe, it is created

english.lng Installation Installation Default English language file. If it is not found in

the same folder as theword.exe, it is created
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*.lng Installation Installation All other add-on language files. One file for

each supported language. (e.g. greek.lng,

spanish.lng, etc)

config.ini Personal Installation All program settings are saved in this file.

compact - Installation If present, this is a compact installation

*.skn Installation\Skins Installation\Skins Skin files - each one describes a skin that can be

used by theWord.

my.vsls.twm Personal Installation Stores verse lists

my.lyts.twm Personal Installation Stores user layouts

my.bhls.twm Personal Installation Stores Bible highlighting information

*.xrefs.twm Personal Installation Stores user cross-references

*.list, *.idx, *.idx3,

*.dat

Cache Installation Cache data 

*.ttf Cache Cache Embedded fonts (if any)

Cardo.ttf,

Gentium.ttf

WINDOWS\Font

s

WINDOWS\Fonts Default Hebrew and Greek font: installed in

Windows system font directory

*.hdgs.twm Misc Misc Stores chapter headings for Bibles

default.layout.

twm

Misc Misc Default layouts

default.prgs.twm,

default2.prgs.

twm

Misc Misc Information concerning paragraph breaks for

Bibles. Two sets are included by default

nf.dat Misc Installation Stores unlock data for locked modules

*.nfp Installation Installation Appears temporarily when installing a locked

package/bundle. Contains unlock information. 

*.twm Common

modules\Books

Installation\Book

s

Book Modules. The actual module type is

determined by an internal flag, not by the

extension

*.ont, *.nt, *.ot Common

modules\Bibles

Installation\Bibles Bible modules

*.ontx, *.otx, *.ntx Common

modules\Bibles

Installation\Bibles Encrypted Bible modules

tw3brand.dll Installation Installation Branding dll - used for these distribution that are
branded for some 3rd party ministry.

errors.log Cache Cache Errors that occur are written in this file.

*.dic, *.aff Misc Misc Spelling dictionaries compatible with hunspell
spelling engine; file available from OpenOffice/

LibreOffice repositories

How theWord locates installed modules?

theWord modules are files with extension .twm, or .ont (see table above for complete list). theWord will

look in all known folders and all their sub-folders to locate modules and other files. This means that you

can create and organize your modules in sub-folders and the program will still locate and use. If a folder

name starts with a dash (-) or a dot (.) then this folder is excluded.



180

You can also add more module folders by manually adding an entry in the config.ini file (see Working

directly with the config file for information on how to do this).

Registry

theWord makes minimal use of the registry. It only stores a couple of settings under HKCU\Software\The

Word and HKLM\Software\The Word. It will not save anything there if you make a Compact/UFD

installation. 

Working directly with the config.ini file

Overview

The config.ini file is where all settings of theWord are stored. To locate the current config.ini being

used do the following:

Go to the menu Help -> About. In the About dialog, click on the File locations tab. Locate the

Personal files folder line and click on the ... button on the right: a windows shell dialog will open.

Locate the config.ini file in that dialog: this is the one used by the program.

You can edit directly this file if you want to set some advanced options. Before trying to edit it make sure

that theWord is not running or else your edits will be overwritten when you shut down theWord. 

The file is divided in sections. Each sections starts with the name of the section enclosed in square

brackets and extends until the beginning of the next section (or the end of the file). Most options that you

can set manually usually should go to the [general] section. The [general] section is usually the first one

in the config.ini file (although this is not necessary).

You can edit the config.ini file using any text editor like notepad that comes with Windows.

TIP: Editing directly the config.ini file is an advanced operation that requires

some basic knowledge of files and usage of a text editor. It is suggested that

you make a backup copy of the config.ini file before changing it manually.

What settings can be set there?

A partial list of available options is given below. Notice that this is not complete and it is only suggested

for advanced users. You should probably check the forums for more information on these options. All

entries listed here should go to the [general] section except where indicated otherwise.

Entry Used for

bible.search.regex.
ungreedy=1

Regular expression Bible searches are now greedy by default. This will

switch back to old non-greedy behavior.

skin.caption.enable=1 Removed the 'Skinned Window border' option because it brought too

many problems, especially in newer version of Windows.

This option will enable the old behavior, if desired. There is no promise

for future maintenance of this legacy mode though.

cm.parse.hot.key=X This changes the key to parse the clipboard contents on demand.

Default is P

Where X is an integer of the Virtual Key code. http://www.
ascii-code.com/ A=65 C=67 G=71 H=72 I=73 J=74 K=75 M=77
O=79 Q=81 T=84 W=87 X=88 Y=89 Z=90
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enter data under [clipview]

section

chain.reload=X

where you can set in seconds the time X you want re-registrations of the
clipboard to occur.

Internal Clipboard monitor changes for compatibil ity with some 3rd party
clipboard monitor util ities. theWord did re-register itself in the chain of
clipboard viewers every 30 seconds, yet some 3rd party tools had issues
when the chain of cl ipboard viewers of windows changed (although it is
valid). Now:
      - theWord will  not re-register if the CM is disabled (from File-
>Preferences)
      - there is a new registry setting in the [clipview] section called 'chain.
reload' where you can set in seconds the time you want these re-
registrations to occur
      - the default re-registration time has been increased to 300 seconds.

hide.verse.numbers=1 an experimental config option 'hide.verse.numbers=1' to hide the verse

numbers. Since this is experimental, it is now only a global option, not

a Bible-view specific. This is only a preview feature for testing.

verse.numbers.font.size=X Set the font size of verse numbers in the Bible view, where X is the

point size you require. 8 is default size.

active.bible.view.
force=_bible_view_X 

(where X is a number: 1, 2, ...): if present, then theWord
will always activate this view on startup

extra.paths=[list of paths
separated by ;]

Add one or more extra paths in which theWord should look for

modules. Example: 
extra.paths=c:\my modules; h:\personal\files

vref.languages=[list of
<language>, *, current]

This setting determines what language the verse detection algorithm

uses for book names. By default it uses English and current language.

You can use * for all languages installed, or a comma list with the ones

you want (current stands for the current language). Examples:
vref.languages=*
vref.languages=english,current
vref.languages=spanish,german
vref.language=english

dbv.tlb.backcolor.luma Default is 210. Luminosity of the color applied to the Bible tab bar 

jump.to.verse.list.on.add Default is 1 (true). Set to 0 if you don't want the Bible view to change

to List when you add a verse to the current list (using CTRL+L, the

menu, etc)

dbv.add.header.when.
copying.single.verse

Default is 1 (true). Set to 0 if you don't want a header when copying

single verses from the Bible view.

dbv.add.footer.when.
copying.single.verse

Default is 0 (false). Set to 1 if you want a footer when copying single

verses from the Bible view.

active.verse.highlight.
light

Default is -35. How much the current verse gets lighter from the

background (when using standard color) - applies for light background

colors (negative means it gets darker).

active.verse.highlight.dark Default is 40. How much the current verse gets lighter from the

background (when using standard color) - applies for dark background

colors.

booksearchview.showpopup.
on.tree

Default is 1 (true). Whether to show the content of the topics in a

popup when hovering over the book search results list. Use 0 to turn it
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off, 2 to show only when CTRL is pressed.

bkv.highlight.alpha.normal Default is 140; alpha value (transparency level) of highlighting of

matched book modules tabs in book view (for normal matching)

bkv.highlight.alpha.fuzzy Default is 60; alpha value (transparency level) of highlighting of

matched book modules tabs in book view (for fuzzy matching)

bkv.highlight.color.light.
normal

Default is yellow. Color for highlighting the book tabs (for normal

matching) - used for light colored themes (colors are in RGB decimal;

e.g. 2686948 is dark yellow, 2552040 is clear yellow; to use a color in

hex use windows calculator to convert to decimal, also reverse the

order of hex digits)

bkv.highlight.color.light.
fuzzy

Default is yellow. Color for highlighting the book tabs (for fuzzy

matching) - used for light colored themes

bkv.highlight.color.dark.
normal

Default is black. Color for highlighting the book tabs (for normal

matching) - used for dark colored themes

bkv.highlight.color.dark.
fuzzy

Default is dark gray. Color for highlighting the book tabs (for fuzzy

matching) - used for dark colored themes

bookview.showpopup.on.links Default is 1 (true). Whether to show popups for links in the Book view.

Use 0 to turn it off, 2 to show only when CTRL is pressed

auto.bookmark.pattern Default is bkm%d. Pattern for suggesting bookmarks in Book view. Be

careful to properly use the number placeholder %d.

lang.hot.key Default is 76 (L). Key for reloading the current language file (

CTRL+SHIFT+L is the combination)

cm.paste.hot.key Default is 86 (V). Key for pasting back to clipboard recognized verse

from within the Clipboard monitor (CTRL+SHIFT+V is the combination)

bible.module.reload.hot.key Default is 82 (R). Key for reloading current Bible module (

CTRL+SHIFT+R is the combination)

restrict.popup.inapp Default is 0 (false). Set to 1 (true) to restrict all popup windows (not

tips) within the area of the main window.

bkv.center.link.target Default is 0 (false). Set to 1 to force the display of a link with a specific

bookmark to center the target topic in the reader (by default, when you

click on a link for which a bookmark is defined, then the reader scrolls

so that the bookmark appears at the top of the reader; this option will

scroll the reader so the bookmark appears at the vertical middle of the

reader).

clipboard.format.bible.
unicode
clipboard.format.bible.rtf
clipboard.format.bible.text

These three options control in which formats text is copied to the

clipboard. All three entries have a default value of 1 (true). Set to 0 to

disallow the particular format to be copied to the clipboard. For

example, if you want to not copy rtf formatted text to the clipboard,

add to the config.ini the option clipboard.format.bible.rtf=0

clipboard.format.apply.to.
reader

Default is 0 (false). By default, the above three config options do not

apply for selected text that is copied from the Bible viewer. Set this to 1

to have these options apply for text copied directly from the Bible view

reader with mouse selection.
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strong.format This option allows you to customize the look of embedded strong

numbers in the Bible view text. Defatul value is "\super  %s" (without

the quotes). The format is actually an rtf fragment. For example, the

setting "{\fs16 <%s>}" will render the Strong numbers within the <

and > symbols and with a font size of 8. The %s represents that actual

text (e.g. G1, H123, etc).

Be very careful because incorrect rtf syntax may cause the whole

rendering of the Bible text to get corrupted.

morph.format Same as strong.format but allows you to customize the rendering of

morphological codes.

suppress.search.results.
highlight

Default is 0 (false). Set to 1 if you don't want the search results to be

highlighted in yellow.

suppress.search.results.
underline

Default is 0 (false). Set to 1 if you don't want the search results to have

the curly red underline.

popup.strong Default is 1 (true). Set to 0 if you don't want the Strong numbers to

appear in popups, no matter if the current/active Bible view displays

them.

popup.morph Default is 1 (true). Set to 0 if you don't want the morphological codes

numbers to appear in popups, no matter if the current/active Bible view

displays them.

Regular Expression Syntax

PCRE REGULAR EXPRESSION DETAILS

BACKSLASH

CIRCUMFLEX AND DOLLAR

FULL STOP (PERIOD, DOT)

MATCHING A SINGLE BYTE

SQUARE BRACKETS AND CHARACTER CLASSES

POSIX CHARACTER CLASSES

VERTICAL BAR

INTERNAL OPTION SETTING
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SUBPATTERNS

NAMED SUBPATTERNS

REPETITION

ATOMIC GROUPING AND POSSESSIVE QUANTIFIERS

BACK REFERENCES

ASSERTIONS

CONDITIONAL SUBPATTERNS

COMMENTS

RECURSIVE PATTERNS

SUBPATTERNS AS SUBROUTINES

CALLOUTS

PCRE REGULAR EXPRESSION DETAILS

The syntax and semantics of the regular expressions supported by PCRE are described below. Regular

expressions are also described in the Perl documentation and in a number of books, some of which have

copious examples. Jeffrey Friedl's "Mastering Regular Expressions", published by O'Reilly, covers regular

expressions in great detail. This description of PCRE's regular expressions is intended as reference

material.

The original operation of PCRE was on strings of one-byte characters. However, there is now also support

for UTF-8 character strings. To use this, you must build PCRE to include UTF-8 support, and then call 

pcre_compile() with the PCRE_UTF8 option. How this affects pattern matching is mentioned in several

places below. There is also a summary of UTF-8 features in the section on UTF-8 support in the main pcre

page.

A regular expression is a pattern that is matched against a subject string from left to right. Most

characters stand for themselves in a pattern, and match the corresponding characters in the subject. As a

trivial example, the pattern

  The quick brown fox

matches a portion of a subject string that is identical to itself. The power of regular expressions comes
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from the ability to include alternatives and repetitions in the pattern. These are encoded in the pattern by

the use of metacharacters, which do not stand for themselves but instead are interpreted in some special

way.

There are two different sets of metacharacters: those that are recognized anywhere in the pattern except

within square brackets, and those that are recognized in square brackets. Outside square brackets, the

metacharacters are as follows:

  \      general escape character with several uses

  ^      assert start of string (or line, in multiline mode)

  $      assert end of string (or line, in multiline mode)

  .      match any character except newline (by default)

  [      start character class definition

  |      start of alternative branch

  (      start subpattern

  )      end subpattern

  ?      extends the meaning of (

         also 0 or 1 quantifier

         also quantifier minimizer

  *      0 or more quantifier

  +      1 or more quantifier

         also "possessive quantifier"

  {      start min/max quantifier

Part of a pattern that is in square brackets is called a "character class". In a character class the only

metacharacters are:

  \      general escape character

  ^      negate the class, but only if the first character

  -      indicates character range

  [      POSIX character class (only if followed by POSIX syntax)

  ]      terminates the character class

The following sections describe the use of each of the metacharacters.

BACKSLASH

The backslash character has several uses. Firstly, if it is followed by a non-alphanumeric character, it takes

away any special meaning that character may have. This use of backslash as an escape character applies

both inside and outside character classes.

For example, if you want to match a * character, you write \* in the pattern. This escaping action applies

whether or not the following character would otherwise be interpreted as a metacharacter, so it is always

safe to precede a non-alphanumeric with backslash to specify that it stands for itself. In particular, if you

want to match a backslash, you write \\.
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If a pattern is compiled with the PCRE_EXTENDED option, whitespace in the pattern (other than in a

character class) and characters between a # outside a character class and the next newline character are

ignored. An escaping backslash can be used to include a whitespace or # character as part of the pattern.

If you want to remove the special meaning from a sequence of characters, you can do so by putting them

between \Q and \E. This is different from Perl in that $ and @ are handled as literals in \Q...\E sequences

in PCRE, whereas in Perl, $ and @ cause variable interpolation. Note the following examples:

  Pattern            PCRE matches   Perl matches

  \Qabc$xyz\E        abc$xyz        abc followed by the contents of $xyz

  \Qabc\$xyz\E       abc\$xyz       abc\$xyz

  \Qabc\E\$\Qxyz\E   abc$xyz        abc$xyz

The \Q...\E sequence is recognized both inside and outside character classes.

Non-printing characters

A second use of backslash provides a way of encoding non-printing characters in patterns in a visible

manner. There is no restriction on the appearance of non-printing characters, apart from the binary zero

that terminates a pattern, but when a pattern is being prepared by text editing, it is usually easier to use

one of the following escape sequences than the binary character it represents:

  \a        alarm, that is, the BEL character (hex 07)

  \cx       "control-x", where x is any character

  \e        escape (hex 1B)

  \f        formfeed (hex 0C)

  \n        newline (hex 0A)

  \r        carriage return (hex 0D)

  \t        tab (hex 09)

  \ddd      character with octal code ddd, or backreference

  \xhh      character with hex code hh

  \x{hhh..} character with hex code hhh... (UTF-8 mode only)

The precise effect of \cx is as follows: if x is a lower case letter, it is converted to upper case. Then bit 6 of

the character (hex 40) is inverted. Thus \cz becomes hex 1A, but \c{ becomes hex 3B, while \c; becomes

hex 7B.

After \x, from zero to two hexadecimal digits are read (letters can be in upper or lower case). In UTF-8

mode, any number of hexadecimal digits may appear between \x{ and }, but the value of the character

code must be less than 2**31 (that is, the maximum hexadecimal value is 7FFFFFFF). If characters other

than hexadecimal digits appear between \x{ and }, or if there is no terminating }, this form of escape is

not recognized. Instead, the initial \x will be interpreted as a basic hexadecimal escape, with no following

digits, giving a character whose value is zero.

Characters whose value is less than 256 can be defined by either of the two syntaxes for \x when PCRE is

in UTF-8 mode. There is no difference in the way they are handled. For example, \xdc is exactly the same

as \x{dc}.
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After \0 up to two further octal digits are read. In both cases, if there are fewer than two digits, just those

that are present are used. Thus the sequence \0\x\07 specifies two binary zeros followed by a BEL

character (code value 7). Make sure you supply two digits after the initial zero if the pattern character that

follows is itself an octal digit.

The handling of a backslash followed by a digit other than 0 is complicated. Outside a character class,

PCRE reads it and any following digits as a decimal number. If the number is less than 10, or if there have

been at least that many previous capturing left parentheses in the expression, the entire sequence is taken

as a back reference. A description of how this works is given later, following the discussion of

parenthesized subpatterns.

Inside a character class, or if the decimal number is greater than 9 and there have not been that many

capturing subpatterns, PCRE re-reads up to three octal digits following the backslash, and generates a

single byte from the least significant 8 bits of the value. Any subsequent digits stand for themselves. For

example:

  \040   is another way of writing a space

  \40    is the same, provided there are fewer than 40 previous capturing subpatterns

  \7     is always a back reference

  \11    might be a back reference, or another way of writing a tab

  \011   is always a tab

  \0113  is a tab followed by the character "3"

  \113   might be a back reference, otherwise the character with octal code 113

  \377   might be a back reference, otherwise the byte consisting entirely of 1 bits

  \81    is either a back reference, or a binary zero followed by the two characters "8" and "1"

Note that octal values of 100 or greater must not be introduced by a leading zero, because no more than

three octal digits are ever read.

All the sequences that define a single byte value or a single UTF-8 character (in UTF-8 mode) can be used

both inside and outside character classes. In addition, inside a character class, the sequence \b is

interpreted as the backspace character (hex 08), and the sequence \X is interpreted as the character "X".

Outside a character class, these sequences have different meanings (see below).

Generic character types

The third use of backslash is for specifying generic character types. The following are always recognized:

  \d     any decimal digit

  \D     any character that is not a decimal digit

  \s     any whitespace character

  \S     any character that is not a whitespace character

  \w     any "word" character

  \W     any "non-word" character
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Each pair of escape sequences partitions the complete set of characters into two disjoint sets. Any given

character matches one, and only one, of each pair.

These character type sequences can appear both inside and outside character classes. They each match

one character of the appropriate type. If the current matching point is at the end of the subject string, all

of them fail, since there is no character to match.

For compatibility with Perl, \s does not match the VT character (code 11). This makes it different from the

the POSIX "space" class. The \s characters are HT (9), LF (10), FF (12), CR (13), and space (32).

A "word" character is an underscore or any character less than 256 that is a letter or digit. The definition

of letters and digits is controlled by PCRE's low-valued character tables, and may vary if locale-specific

matching is taking place. For example, in the "fr_FR" (French) locale, some character codes greater than

128 are used for accented letters, and these are matched by \w.

In UTF-8 mode, characters with values greater than 128 never match \d, \s, or \w, and always match \D,

\S, and \W. This is true even when Unicode character property support is available.

Unicode character properties

When PCRE is built with Unicode character property support, three additional escape sequences to match

generic character types are available when UTF-8 mode is selected. They are:

 \p{xx}   a character with the xx property

 \P{xx}   a character without the xx property

 \X       an extended Unicode sequence

The property names represented by xx above are limited to the Unicode general category properties.

Each character has exactly one such property, specified by a two-letter abbreviation. For compatibility

with Perl, negation can be specified by including a circumflex between the opening brace and the

property name. For example, \p{^Lu} is the same as \P{Lu}.

If only one letter is specified with \p or \P, it includes all the properties that start with that letter. In this

case, in the absence of negation, the curly brackets in the escape sequence are optional; these two

examples have the same effect:

  \p{L}

  \pL

The following property codes are supported:

  C     Other

  Cc    Control

  Cf    Format

  Cn    Unassigned

  Co    Private use

  Cs    Surrogate

  L     Letter
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  Ll    Lower case letter

  Lm    Modifier letter

  Lo    Other letter

  Lt    Title case letter

  Lu    Upper case letter

  M     Mark

  Mc    Spacing mark

  Me    Enclosing mark

  Mn    Non-spacing mark

  N     Number

  Nd    Decimal number

  Nl    Letter number

  No    Other number

  P     Punctuation

  Pc    Connector punctuation

  Pd    Dash punctuation

  Pe    Close punctuation

  Pf    Final punctuation

  Pi    Initial punctuation

  Po    Other punctuation

  Ps    Open punctuation

  S     Symbol

  Sc    Currency symbol

  Sk    Modifier symbol

  Sm    Mathematical symbol

  So    Other symbol

  Z     Separator

  Zl    Line separator

  Zp    Paragraph separator

  Zs    Space separator

Extended properties such as "Greek" or "InMusicalSymbols" are not supported by PCRE.

Specifying caseless matching does not affect these escape sequences. For example, \p{Lu} always

matches only upper case letters.

The \X escape matches any number of Unicode characters that form an extended Unicode sequence. \X is

equivalent to
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  (?>\PM\pM*)

That is, it matches a character without the "mark" property, followed by zero or more characters with the

"mark" property, and treats the sequence as an atomic group (see below). Characters with the "mark"

property are typically accents that affect the preceding character.

Matching characters by Unicode property is not fast, because PCRE has to search a structure that

contains data for over fifteen thousand characters. That is why the traditional escape sequences such

as \d and \w do not use Unicode properties in PCRE.

Simple assertions

The fourth use of backslash is for certain simple assertions. An assertion specifies a condition that has to

be met at a particular point in a match, without consuming any characters from the subject string. The use

of subpatterns for more complicated assertions is described below. The backslashed assertions are:

  \b     matches at a word boundary

  \B     matches when not at a word boundary

  \A     matches at start of subject

  \Z     matches at end of subject or before newline at end

  \z     matches at end of subject

  \G     matches at first matching position in subject

These assertions may not appear in character classes (but note that \b has a different meaning, namely

the backspace character, inside a character class).

A word boundary is a position in the subject string where the current character and the previous

character do not both match \w or \W (i.e. one matches \w and the other matches \W), or the start or end

of the string if the first or last character matches \w, respectively.

The \A, \Z, and \z assertions differ from the traditional circumflex and dollar (described in the next

section) in that they only ever match at the very start and end of the subject string, whatever options are

set. Thus, they are independent of multiline mode. These three assertions are not affected by the

PCRE_NOTBOL or PCRE_NOTEOL options, which affect only the behaviour of the circumflex and dollar

metacharacters. However, if the startoffset argument of pcre_exec() is non-zero, indicating that matching

is to start at a point other than the beginning of the subject, \A can never match. The difference

between \Z and \z is that \Z matches before a newline that is the last character of the string as well as at

the end of the string, whereas \z matches only at the end.

The \G assertion is true only when the current matching position is at the start point of the match, as

specified by the startoffset argument of pcre_exec(). It differs from \A when the value of startoffset is non-

zero. By calling pcre_exec() multiple times with appropriate arguments, you can mimic Perl's /g option,

and it is in this kind of implementation where \G can be useful.

Note, however, that PCRE's interpretation of \G, as the start of the current match, is subtly different from

Perl's, which defines it as the end of the previous match. In Perl, these can be different when the

previously matched string was empty. Because PCRE does just one match at a time, it cannot reproduce

this behaviour.
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If all the alternatives of a pattern begin with \G, the expression is anchored to the starting match position,

and the "anchored" flag is set in the compiled regular expression.

CIRCUMFLEX AND DOLLAR

Outside a character class, in the default matching mode, the circumflex character is an assertion that is

true only if the current matching point is at the start of the subject string. If the startoffset argument of

pcre_exec() is non-zero, circumflex can never match if the PCRE_MULTILINE option is unset. Inside a

character class, circumflex has an entirely different meaning (see below).

Circumflex need not be the first character of the pattern if a number of alternatives are involved, but it

should be the first thing in each alternative in which it appears if the pattern is ever to match that branch.

If all possible alternatives start with a circumflex, that is, if the pattern is constrained to match only at the

start of the subject, it is said to be an "anchored" pattern. (There are also other constructs that can cause

a pattern to be anchored.)

A dollar character is an assertion that is true only if the current matching point is at the end of the subject

string, or immediately before a newline character that is the last character in the string (by default). Dollar

need not be the last character of the pattern if a number of alternatives are involved, but it should be the

last item in any branch in which it appears. Dollar has no special meaning in a character class.

The meaning of dollar can be changed so that it matches only at the very end of the string, by setting the

PCRE_DOLLAR_ENDONLY option at compile time. This does not affect the \Z assertion.

The meanings of the circumflex and dollar characters are changed if the PCRE_MULTILINE option is set.

When this is the case, they match immediately after and immediately before an internal newline character,

respectively, in addition to matching at the start and end of the subject string. For example, the pattern /

^abc$/ matches the subject string "def\nabc" (where \n represents a newline character) in multiline mode,

but not otherwise. Consequently, patterns that are anchored in single line mode because all branches

start with ^ are not anchored in multiline mode, and a match for circumflex is possible when the startoffset

argument of pcre_exec() is non-zero. The PCRE_DOLLAR_ENDONLY option is ignored if PCRE_MULTILINE

is set.

Note that the sequences \A, \Z, and \z can be used to match the start and end of the subject in both

modes, and if all branches of a pattern start with \A it is always anchored, whether PCRE_MULTILINE is set

or not.

FULL STOP (PERIOD, DOT)

Outside a character class, a dot in the pattern matches any one character in the subject, including a non-

printing character, but not (by default) newline. In UTF-8 mode, a dot matches any UTF-8 character, which

might be more than one byte long, except (by default) newline. If the PCRE_DOTALL option is set, dots

match newlines as well. The handling of dot is entirely independent of the handling of circumflex and

dollar, the only relationship being that they both involve newline characters. Dot has no special meaning

in a character class.
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MATCHING A SINGLE BYTE

Outside a character class, the escape sequence \C matches any one byte, both in and out of UTF-8 mode.

Unlike a dot, it can match a newline. The feature is provided in Perl in order to match individual bytes in

UTF-8 mode. Because it breaks up UTF-8 characters into individual bytes, what remains in the string may

be a malformed UTF-8 string. For this reason, the \C escape sequence is best avoided.

PCRE does not allow \C to appear in lookbehind assertions (described below), because in UTF-8 mode

this would make it impossible to calculate the length of the lookbehind.

SQUARE BRACKETS AND CHARACTER CLASSES

An opening square bracket introduces a character class, terminated by a closing square bracket. A

closing square bracket on its own is not special. If a closing square bracket is required as a member of

the class, it should be the first data character in the class (after an initial circumflex, if present) or escaped

with a backslash.

A character class matches a single character in the subject. In UTF-8 mode, the character may occupy

more than one byte. A matched character must be in the set of characters defined by the class, unless the

first character in the class definition is a circumflex, in which case the subject character must not be in the

set defined by the class. If a circumflex is actually required as a member of the class, ensure it is not the

first character, or escape it with a backslash.

For example, the character class [aeiou] matches any lower case vowel, while [^aeiou] matches any

character that is not a lower case vowel. Note that a circumflex is just a convenient notation for specifying

the characters that are in the class by enumerating those that are not. A class that starts with a circumflex

is not an assertion: it still consumes a character from the subject string, and therefore it fails if the current

pointer is at the end of the string.

In UTF-8 mode, characters with values greater than 255 can be included in a class as a literal string of

bytes, or by using the \x{ escaping mechanism.

When caseless matching is set, any letters in a class represent both their upper case and lower case

versions, so for example, a caseless [aeiou] matches "A" as well as "a", and a caseless [^aeiou] does not

match "A", whereas a caseful version would. When running in UTF-8 mode, PCRE supports the concept of

case for characters with values greater than 128 only when it is compiled with Unicode property support.

The newline character is never treated in any special way in character classes, whatever the setting of the

PCRE_DOTALL or PCRE_MULTILINE options is. A class such as [^a] will always match a newline.

The minus (hyphen) character can be used to specify a range of characters in a character class. For

example, [d-m] matches any letter between d and m, inclusive. If a minus character is required in a class, it

must be escaped with a backslash or appear in a position where it cannot be interpreted as indicating a

range, typically as the first or last character in the class.

It is not possible to have the literal character "]" as the end character of a range. A pattern such as [W-]

46] is interpreted as a class of two characters ("W" and "-") followed by a literal string "46]", so it would

match "W46]" or "-46]". However, if the "]" is escaped with a backslash it is interpreted as the end of

range, so [W-\]46] is interpreted as a class containing a range followed by two other characters. The octal
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or hexadecimal representation of "]" can also be used to end a range.

Ranges operate in the collating sequence of character values. They can also be used for characters

specified numerically, for example [\000-\037]. In UTF-8 mode, ranges can include characters whose

values are greater than 255, for example [\x{100}-\x{2ff}].

If a range that includes letters is used when caseless matching is set, it matches the letters in either case.

For example, [W-c] is equivalent to [][\\^_`wxyzabc], matched caselessly, and in non-UTF-8 mode, if

character tables for the "fr_FR" locale are in use, [\xc8-\xcb] matches accented E characters in both cases.

In UTF-8 mode, PCRE supports the concept of case for characters with values greater than 128 only when

it is compiled with Unicode property support.

The character types \d, \D, \p, \P, \s, \S, \w, and \W may also appear in a character class, and add the

characters that they match to the class. For example, [\dABCDEF] matches any hexadecimal digit. A

circumflex can conveniently be used with the upper case character types to specify a more restricted set

of characters than the matching lower case type. For example, the class [^\W_] matches any letter or digit,

but not underscore.

The only metacharacters that are recognized in character classes are backslash, hyphen (only where it can

be interpreted as specifying a range), circumflex (only at the start), opening square bracket (only when it

can be interpreted as introducing a POSIX class name - see the next section), and the terminating closing

square bracket. However, escaping other non-alphanumeric characters does no harm.

POSIX CHARACTER CLASSES

Perl supports the POSIX notation for character classes. This uses names enclosed by [: and :] within the

enclosing square brackets. PCRE also supports this notation. For example,

  [01[:alpha:]%]

matches "0", "1", any alphabetic character, or "%". The supported class names are

  alnum    letters and digits

  alpha    letters

  ascii    character codes 0 - 127

  blank    space or tab only

  cntrl    control characters

  digit    decimal digits (same as \d)

  graph    printing characters, excluding space

  lower    lower case letters

  print    printing characters, including space

  punct    printing characters, excluding letters and digits

  space    white space (not quite the same as \s)

  upper    upper case letters

  word     "word" characters (same as \w)



194

  xdigit   hexadecimal digits

The "space" characters are HT (9), LF (10), VT (11), FF (12), CR (13), and space (32). Notice that this list

includes the VT character (code 11). This makes "space" different to \s, which does not include VT (for Perl

compatibility).

The name "word" is a Perl extension, and "blank" is a GNU extension from Perl 5.8. Another Perl extension

is negation, which is indicated by a ^ character after the colon. For example,

  [12[:^digit:]]

matches "1", "2", or any non-digit. PCRE (and Perl) also recognize the POSIX syntax [.ch.] and [=ch=]

where "ch" is a "collating element", but these are not supported, and an error is given if they are

encountered.

In UTF-8 mode, characters with values greater than 128 do not match any of the POSIX character classes.

VERTICAL BAR

Vertical bar characters are used to separate alternative patterns. For example, the pattern

  gilbert|sullivan

matches either "gilbert" or "sullivan". Any number of alternatives may appear, and an empty alternative is

permitted (matching the empty string). The matching process tries each alternative in turn, from left to

right, and the first one that succeeds is used. If the alternatives are within a subpattern (defined below),

"succeeds" means matching the rest of the main pattern as well as the alternative in the subpattern.

INTERNAL OPTION SETTING

The settings of the PCRE_CASELESS, PCRE_MULTILINE, PCRE_DOTALL, and PCRE_EXTENDED options can

be changed from within the pattern by a sequence of Perl option letters enclosed between "(?" and ")".

The option letters are

  i  for PCRE_CASELESS

  m  for PCRE_MULTILINE

  s  for PCRE_DOTALL

  x  for PCRE_EXTENDED

For example, (?im) sets caseless, multiline matching. It is also possible to unset these options by

preceding the letter with a hyphen, and a combined setting and unsetting such as (?im-sx), which sets

PCRE_CASELESS and PCRE_MULTILINE while unsetting PCRE_DOTALL and PCRE_EXTENDED, is also

permitted. If a letter appears both before and after the hyphen, the option is unset.

When an option change occurs at top level (that is, not inside subpattern parentheses), the change

applies to the remainder of the pattern that follows. If the change is placed right at the start of a pattern,

PCRE extracts it into the global options (and it will therefore show up in data extracted by the 

pcre_fullinfo() function).

An option change within a subpattern affects only that part of the current pattern that follows it, so

  (a(?i)b)c
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matches abc and aBc and no other strings (assuming PCRE_CASELESS is not used). By this means, options

can be made to have different settings in different parts of the pattern. Any changes made in one

alternative do carry on into subsequent branches within the same subpattern. For example,

  (a(?i)b|c)

matches "ab", "aB", "c", and "C", even though when matching "C" the first branch is abandoned before the

option setting. This is because the effects of option settings happen at compile time. There would be

some very weird behaviour otherwise.

The PCRE-specific options PCRE_UNGREEDY and PCRE_EXTRA can be changed in the same way as the

Perl-compatible options by using the characters U and X respectively. The (?X) flag setting is special in

that it must always occur earlier in the pattern than any of the additional features it turns on, even when it

is at top level. It is best to put it at the start.

SUBPATTERNS

Subpatterns are delimited by parentheses (round brackets), which can be nested. Turning part of a

pattern into a subpattern does two things:

1. It localizes a set of alternatives. For example, the pattern

  cat(aract|erpillar|)

matches one of the words "cat", "cataract", or "caterpillar". Without the parentheses, it would match

"cataract", "erpillar" or the empty string.

2. It sets up the subpattern as a capturing subpattern. This means that, when the whole pattern matches,

that portion of the subject string that matched the subpattern is passed back to the caller via the ovector

argument of pcre_exec(). Opening parentheses are counted from left to right (starting from 1) to obtain

numbers for the capturing subpatterns.

For example, if the string "the red king" is matched against the pattern

  the ((red|white) (king|queen))

the captured substrings are "red king", "red", and "king", and are numbered 1, 2, and 3, respectively.

The fact that plain parentheses fulfil two functions is not always helpful. There are often times when a

grouping subpattern is required without a capturing requirement. If an opening parenthesis is followed

by a question mark and a colon, the subpattern does not do any capturing, and is not counted when

computing the number of any subsequent capturing subpatterns. For example, if the string "the white

queen" is matched against the pattern

  the ((?:red|white) (king|queen))

the captured substrings are "white queen" and "queen", and are numbered 1 and 2. The maximum

number of capturing subpatterns is 65535, and the maximum depth of nesting of all subpatterns, both

capturing and non-capturing, is 200.

As a convenient shorthand, if any option settings are required at the start of a non-capturing subpattern,

the option letters may appear between the "?" and the ":". Thus the two patterns
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  (?i:saturday|sunday)

  (?:(?i)saturday|sunday)

match exactly the same set of strings. Because alternative branches are tried from left to right, and

options are not reset until the end of the subpattern is reached, an option setting in one branch does

affect subsequent branches, so the above patterns match "SUNDAY" as well as "Saturday".

NAMED SUBPATTERNS

Identifying capturing parentheses by number is simple, but it can be very hard to keep track of the

numbers in complicated regular expressions. Furthermore, if an expression is modified, the numbers may

change. To help with this difficulty, PCRE supports the naming of subpatterns, something that Perl does

not provide. The Python syntax (?P<name>...) is used. Names consist of alphanumeric characters and

underscores, and must be unique within a pattern.

Named capturing parentheses are still allocated numbers as well as names. The PCRE API provides

function calls for extracting the name-to-number translation table from a compiled pattern. There is also

a convenience function for extracting a captured substring by name. For further details see the pcreapi

documentation.

REPETITION

Repetition is specified by quantifiers, which can follow any of the following items:

  a literal data character

  the . metacharacter

  the \C escape sequence

  the \X escape sequence (in UTF-8 mode with Unicode properties)

  an escape such as \d that matches a single character

  a character class

  a back reference (see next section)

  a parenthesized subpattern (unless it is an assertion)

The general repetition quantifier specifies a minimum and maximum number of permitted matches, by

giving the two numbers in curly brackets (braces), separated by a comma. The numbers must be less than

65536, and the first must be less than or equal to the second. For example:

  z{2,4}

matches "zz", "zzz", or "zzzz". A closing brace on its own is not a special character. If the second number

is omitted, but the comma is present, there is no upper limit; if the second number and the comma are

both omitted, the quantifier specifies an exact number of required matches. Thus

  [aeiou]{3,}

matches at least 3 successive vowels, but may match many more, while

  \d{8}

matches exactly 8 digits. An opening curly bracket that appears in a position where a quantifier is not

allowed, or one that does not match the syntax of a quantifier, is taken as a literal character. For example,

{,6} is not a quantifier, but a literal string of four characters.
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In UTF-8 mode, quantifiers apply to UTF-8 characters rather than to individual bytes. Thus, for example, \x

{100}{2} matches two UTF-8 characters, each of which is represented by a two-byte sequence. Similarly,

when Unicode property support is available, \X{3} matches three Unicode extended sequences, each of

which may be several bytes long (and they may be of different lengths).

The quantifier {0} is permitted, causing the expression to behave as if the previous item and the quantifier

were not present.

For convenience (and historical compatibility) the three most common quantifiers have single-character

abbreviations:

  *    is equivalent to {0,}

  +    is equivalent to {1,}

  ?    is equivalent to {0,1}

It is possible to construct infinite loops by following a subpattern that can match no characters with a

quantifier that has no upper limit, for example:

  (a?)*

Earlier versions of Perl and PCRE used to give an error at compile time for such patterns. However,

because there are cases where this can be useful, such patterns are now accepted, but if any repetition of

the subpattern does in fact match no characters, the loop is forcibly broken.

By default, the quantifiers are "greedy", that is, they match as much as possible (up to the maximum

number of permitted times), without causing the rest of the pattern to fail. The classic example of where

this gives problems is in trying to match comments in C programs. These appear between /* and */ and

within the comment, individual * and / characters may appear. An attempt to match C comments by

applying the pattern

  /\*.*\*/

to the string

  /* first comment */  not comment  /* second comment */

fails, because it matches the entire string owing to the greediness of the .* item.

However, if a quantifier is followed by a question mark, it ceases to be greedy, and instead matches the

minimum number of times possible, so the pattern

  /\*.*?\*/

does the right thing with the C comments. The meaning of the various quantifiers is not otherwise

changed, just the preferred number of matches. Do not confuse this use of question mark with its use as

a quantifier in its own right. Because it has two uses, it can sometimes appear doubled, as in

  \d??\d

which matches one digit by preference, but can match two if that is the only way the rest of the pattern

matches.

If the PCRE_UNGREEDY option is set (an option which is not available in Perl), the quantifiers are not

greedy by default, but individual ones can be made greedy by following them with a question mark. In

other words, it inverts the default behaviour.
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When a parenthesized subpattern is quantified with a minimum repeat count that is greater than 1 or with

a limited maximum, more memory is required for the compiled pattern, in proportion to the size of the

minimum or maximum.

If a pattern starts with .* or .{0,} and the PCRE_DOTALL option (equivalent to Perl's /s) is set, thus allowing

the . to match newlines, the pattern is implicitly anchored, because whatever follows will be tried against

every character position in the subject string, so there is no point in retrying the overall match at any

position after the first. PCRE normally treats such a pattern as though it were preceded by \A.

In cases where it is known that the subject string contains no newlines, it is worth setting PCRE_DOTALL in

order to obtain this optimization, or alternatively using ^ to indicate anchoring explicitly.

However, there is one situation where the optimization cannot be used. When .* is inside capturing

parentheses that are the subject of a backreference elsewhere in the pattern, a match at the start may fail,

and a later one succeed. Consider, for example:

  (.*)abc\1

If the subject is "xyz123abc123" the match point is the fourth character. For this reason, such a pattern is

not implicitly anchored.

When a capturing subpattern is repeated, the value captured is the substring that matched the final

iteration. For example, after

  (tweedle[dume]{3}\s*)+

has matched "tweedledum tweedledee" the value of the captured substring is "tweedledee". However, if

there are nested capturing subpatterns, the corresponding captured values may have been set in

previous iterations. For example, after

  /(a|(b))+/

matches "aba" the value of the second captured substring is "b".

ATOMIC GROUPING AND POSSESSIVE QUANTIFIERS

With both maximizing and minimizing repetition, failure of what follows normally causes the repeated item

to be re-evaluated to see if a different number of repeats allows the rest of the pattern to match.

Sometimes it is useful to prevent this, either to change the nature of the match, or to cause it fail earlier

than it otherwise might, when the author of the pattern knows there is no point in carrying on.

Consider, for example, the pattern \d+foo when applied to the subject line

  123456bar

After matching all 6 digits and then failing to match "foo", the normal action of the matcher is to try again

with only 5 digits matching the \d+ item, and then with 4, and so on, before ultimately failing. "Atomic

grouping" (a term taken from Jeffrey Friedl's book) provides the means for specifying that once a

subpattern has matched, it is not to be re-evaluated in this way.

If we use atomic grouping for the previous example, the matcher would give up immediately on failing to

match "foo" the first time. The notation is a kind of special parenthesis, starting with (?> as in this

example:
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  (?>\d+)foo

This kind of parenthesis "locks up" the part of the pattern it contains once it has matched, and a failure

further into the pattern is prevented from backtracking into it. Backtracking past it to previous items,

however, works as normal.

An alternative description is that a subpattern of this type matches the string of characters that an

identical standalone pattern would match, if anchored at the current point in the subject string.

Atomic grouping subpatterns are not capturing subpatterns. Simple cases such as the above example can

be thought of as a maximizing repeat that must swallow everything it can. So, while both \d+ and \d+?

are prepared to adjust the number of digits they match in order to make the rest of the pattern match, (?

>\d+) can only match an entire sequence of digits.

Atomic groups in general can of course contain arbitrarily complicated subpatterns, and can be nested.

However, when the subpattern for an atomic group is just a single repeated item, as in the example

above, a simpler notation, called a "possessive quantifier" can be used. This consists of an additional +

character following a quantifier. Using this notation, the previous example can be rewritten as

  \d++foo

Possessive quantifiers are always greedy; the setting of the PCRE_UNGREEDY option is ignored. They are

a convenient notation for the simpler forms of atomic group. However, there is no difference in the

meaning or processing of a possessive quantifier and the equivalent atomic group.

The possessive quantifier syntax is an extension to the Perl syntax. It originates in Sun's Java package.

When a pattern contains an unlimited repeat inside a subpattern that can itself be repeated an unlimited

number of times, the use of an atomic group is the only way to avoid some failing matches taking a very

long time indeed. The pattern

  (\D+|<\d+>)*[!?]

matches an unlimited number of substrings that either consist of non-digits, or digits enclosed in <>,

followed by either ! or ?. When it matches, it runs quickly. However, if it is applied to

  aaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa

it takes a long time before reporting failure. This is because the string can be divided between the

internal \D+ repeat and the external * repeat in a large number of ways, and all have to be tried. (The

example uses [!?] rather than a single character at the end, because both PCRE and Perl have an

optimization that allows for fast failure when a single character is used. They remember the last single

character that is required for a match, and fail early if it is not present in the string.) If the pattern is

changed so that it uses an atomic group, like this:

  ((?>\D+)|<\d+>)*[!?]

sequences of non-digits cannot be broken, and failure happens quickly.

BACK REFERENCES

Outside a character class, a backslash followed by a digit greater than 0 (and possibly further digits) is a

back reference to a capturing subpattern earlier (that is, to its left) in the pattern, provided there have

been that many previous capturing left parentheses.
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However, if the decimal number following the backslash is less than 10, it is always taken as a back

reference, and causes an error only if there are not that many capturing left parentheses in the entire

pattern. In other words, the parentheses that are referenced need not be to the left of the reference for

numbers less than 10. See the subsection entitled "Non-printing characters" above for further details of

the handling of digits following a backslash.

A back reference matches whatever actually matched the capturing subpattern in the current subject

string, rather than anything matching the subpattern itself (see "Subpatterns as subroutines" below for a

way of doing that). So the pattern

  (sens|respons)e and \1ibility

matches "sense and sensibility" and "response and responsibility", but not "sense and responsibility". If

caseful matching is in force at the time of the back reference, the case of letters is relevant. For example,

  ((?i)rah)\s+\1

matches "rah rah" and "RAH RAH", but not "RAH rah", even though the original capturing subpattern is

matched caselessly.

Back references to named subpatterns use the Python syntax (?P=name). We could rewrite the above

example as follows:

  (?<p1>(?i)rah)\s+(?P=p1)

There may be more than one back reference to the same subpattern. If a subpattern has not actually

been used in a particular match, any back references to it always fail. For example, the pattern

  (a|(bc))\2

always fails if it starts to match "a" rather than "bc". Because there may be many capturing parentheses in

a pattern, all digits following the backslash are taken as part of a potential back reference number. If the

pattern continues with a digit character, some delimiter must be used to terminate the back reference. If

the PCRE_EXTENDED option is set, this can be whitespace. Otherwise an empty comment (see 

"Comments" below) can be used.

A back reference that occurs inside the parentheses to which it refers fails when the subpattern is first

used, so, for example, (a\1) never matches. However, such references can be useful inside repeated

subpatterns. For example, the pattern

  (a|b\1)+

matches any number of "a"s and also "aba", "ababbaa" etc. At each iteration of the subpattern, the back

reference matches the character string corresponding to the previous iteration. In order for this to work,

the pattern must be such that the first iteration does not need to match the back reference. This can be

done using alternation, as in the example above, or by a quantifier with a minimum of zero.

ASSERTIONS

An assertion is a test on the characters following or preceding the current matching point that does not

actually consume any characters. The simple assertions coded as \b, \B, \A, \G, \Z, \z, ^ and $ are

described above.

More complicated assertions are coded as subpatterns. There are two kinds: those that look ahead of the

current position in the subject string, and those that look behind it. An assertion subpattern is matched in
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the normal way, except that it does not cause the current matching position to be changed.

Assertion subpatterns are not capturing subpatterns, and may not be repeated, because it makes no

sense to assert the same thing several times. If any kind of assertion contains capturing subpatterns within

it, these are counted for the purposes of numbering the capturing subpatterns in the whole pattern.

However, substring capturing is carried out only for positive assertions, because it does not make sense

for negative assertions.

Lookahead assertions

Lookahead assertions start with (?= for positive assertions and (?! for negative assertions. For example,

  \w+(?=;)

matches a word followed by a semicolon, but does not include the semicolon in the match, and

  foo(?!bar)

matches any occurrence of "foo" that is not followed by "bar". Note that the apparently similar pattern

  (?!foo)bar

does not find an occurrence of "bar" that is preceded by something other than "foo"; it finds any

occurrence of "bar" whatsoever, because the assertion (?!foo) is always true when the next three

characters are "bar". A lookbehind assertion is needed to achieve the other effect.

If you want to force a matching failure at some point in a pattern, the most convenient way to do it is with

(?!) because an empty string always matches, so an assertion that requires there not to be an empty

string must always fail.

Lookbehind assertions

Lookbehind assertions start with (?<= for positive assertions and (?<! for negative assertions. For

example,

  (?<!foo)bar

does find an occurrence of "bar" that is not preceded by "foo". The contents of a lookbehind assertion

are restricted such that all the strings it matches must have a fixed length. However, if there are several

alternatives, they do not all have to have the same fixed length. Thus

  (?<=bullock|donkey)

is permitted, but

  (?<!dogs?|cats?)

causes an error at compile time. Branches that match different length strings are permitted only at the top

level of a lookbehind assertion. This is an extension compared with Perl (at least for 5.8), which requires

all branches to match the same length of string. An assertion such as

  (?<=ab(c|de))

is not permitted, because its single top-level branch can match two different lengths, but it is acceptable if

rewritten to use two top-level branches:
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  (?<=abc|abde)

The implementation of lookbehind assertions is, for each alternative, to temporarily move the current

position back by the fixed width and then try to match. If there are insufficient characters before the

current position, the match is deemed to fail.

PCRE does not allow the \C escape (which matches a single byte in UTF-8 mode) to appear in lookbehind

assertions, because it makes it impossible to calculate the length of the lookbehind. The \X escape, which

can match different numbers of bytes, is also not permitted.

Atomic groups can be used in conjunction with lookbehind assertions to specify efficient matching at the

end of the subject string. Consider a simple pattern such as

  abcd$

when applied to a long string that does not match. Because matching proceeds from left to right, PCRE

will look for each "a" in the subject and then see if what follows matches the rest of the pattern. If the

pattern is specified as

  ^.*abcd$

the initial .* matches the entire string at first, but when this fails (because there is no following "a"), it

backtracks to match all but the last character, then all but the last two characters, and so on. Once again

the search for "a" covers the entire string, from right to left, so we are no better off. However, if the

pattern is written as

  ^(?>.*)(?<=abcd)

or, equivalently, using the possessive quantifier syntax,

  ^.*+(?<=abcd)

there can be no backtracking for the .* item; it can match only the entire string. The subsequent

lookbehind assertion does a single test on the last four characters. If it fails, the match fails immediately.

For long strings, this approach makes a significant difference to the processing time.

Using multiple assertions

Several assertions (of any sort) may occur in succession. For example,

  (?<=\d{3})(?<!999)foo

matches "foo" preceded by three digits that are not "999". Notice that each of the assertions is applied

independently at the same point in the subject string. First there is a check that the previous three

characters are all digits, and then there is a check that the same three characters are not "999". This

pattern does not match "foo" preceded by six characters, the first of which are digits and the last three of

which are not "999". For example, it doesn't match "123abcfoo". A pattern to do that is

  (?<=\d{3}...)(?<!999)foo

This time the first assertion looks at the preceding six characters, checking that the first three are digits,

and then the second assertion checks that the preceding three characters are not "999".

Assertions can be nested in any combination. For example,

  (?<=(?<!foo)bar)baz

matches an occurrence of "baz" that is preceded by "bar" which in turn is not preceded by "foo", while

  (?<=\d{3}(?!999)...)foo
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is another pattern that matches "foo" preceded by three digits and any three characters that are not

"999".

CONDITIONAL SUBPATTERNS

It is possible to cause the matching process to obey a subpattern conditionally or to choose between two

alternative subpatterns, depending on the result of an assertion, or whether a previous capturing

subpattern matched or not. The two possible forms of conditional subpattern are

  (?(condition)yes-pattern)

  (?(condition)yes-pattern|no-pattern)

If the condition is satisfied, the yes-pattern is used; otherwise the no-pattern (if present) is used. If there

are more than two alternatives in the subpattern, a compile-time error occurs.

There are three kinds of condition. If the text between the parentheses consists of a sequence of digits,

the condition is satisfied if the capturing subpattern of that number has previously matched. The number

must be greater than zero. Consider the following pattern, which contains non-significant white space to

make it more readable (assume the PCRE_EXTENDED option) and to divide it into three parts for ease of

discussion:

  ( \( )?    [^()]+    (?(1) \) )

The first part matches an optional opening parenthesis, and if that character is present, sets it as the first

captured substring. The second part matches one or more characters that are not parentheses. The third

part is a conditional subpattern that tests whether the first set of parentheses matched or not. If they did,

that is, if subject started with an opening parenthesis, the condition is true, and so the yes-pattern is

executed and a closing parenthesis is required. Otherwise, since no-pattern is not present, the subpattern

matches nothing. In other words, this pattern matches a sequence of non-parentheses, optionally

enclosed in parentheses.

If the condition is the string (R), it is satisfied if a recursive call to the pattern or subpattern has been

made. At "top level", the condition is false. This is a PCRE extension. Recursive patterns are described in

the next section.

If the condition is not a sequence of digits or (R), it must be an assertion. This may be a positive or

negative lookahead or lookbehind assertion. Consider this pattern, again containing non-significant white

space, and with the two alternatives on the second line:

  (?(?=[^a-z]*[a-z])

  \d{2}-[a-z]{3}-\d{2}  |  \d{2}-\d{2}-\d{2} )

The condition is a positive lookahead assertion that matches an optional sequence of non-letters followed

by a letter. In other words, it tests for the presence of at least one letter in the subject. If a letter is found,

the subject is matched against the first alternative; otherwise it is matched against the second. This

pattern matches strings in one of the two forms dd-aaa-dd or dd-dd-dd, where aaa are letters and dd

are digits.

COMMENTS

The sequence (?# marks the start of a comment that continues up to the next closing parenthesis. Nested

parentheses are not permitted. The characters that make up a comment play no part in the pattern

matching at all.
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If the PCRE_EXTENDED option is set, an unescaped # character outside a character class introduces a

comment that continues up to the next newline character in the pattern.

RECURSIVE PATTERNS

Consider the problem of matching a string in parentheses, allowing for unlimited nested parentheses.

Without the use of recursion, the best that can be done is to use a pattern that matches up to some fixed

depth of nesting. It is not possible to handle an arbitrary nesting depth. Perl provides a facility that allows

regular expressions to recurse (amongst other things). It does this by interpolating Perl code in the

expression at run time, and the code can refer to the expression itself. A Perl pattern to solve the

parentheses problem can be created like this:

  $re = qr{\( (?: (?>[^()]+) | (?p{$re}) )* \)}x;

The (?p{...}) item interpolates Perl code at run time, and in this case refers recursively to the pattern in

which it appears. Obviously, PCRE cannot support the interpolation of Perl code. Instead, it supports

some special syntax for recursion of the entire pattern, and also for individual subpattern recursion.

The special item that consists of (? followed by a number greater than zero and a closing parenthesis is a

recursive call of the subpattern of the given number, provided that it occurs inside that subpattern. (If not,

it is a "subroutine" call, which is described in the next section.) The special item (?R) is a recursive call of

the entire regular expression.

For example, this PCRE pattern solves the nested parentheses problem (assume the PCRE_EXTENDED

option is set so that white space is ignored):

  \( ( (?>[^()]+) | (?R) )* \)

First it matches an opening parenthesis. Then it matches any number of substrings which can either be a

sequence of non-parentheses, or a recursive match of the pattern itself (that is a correctly parenthesized

substring). Finally there is a closing parenthesis.

If this were part of a larger pattern, you would not want to recurse the entire pattern, so instead you

could use this:

  ( \( ( (?>[^()]+) | (?1) )* \) )

We have put the pattern into parentheses, and caused the recursion to refer to them instead of the whole

pattern. In a larger pattern, keeping track of parenthesis numbers can be tricky. It may be more

convenient to use named parentheses instead. For this, PCRE uses (?P>name), which is an extension to the

Python syntax that PCRE uses for named parentheses (Perl does not provide named parentheses). We

could rewrite the above example as follows:

  (?P<pn> \( ( (?>[^()]+) | (?P>pn) )* \) )

This particular example pattern contains nested unlimited repeats, and so the use of atomic grouping for

matching strings of non-parentheses is important when applying the pattern to strings that do not match.

For example, when this pattern is applied to

  (aaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa()

it yields "no match" quickly. However, if atomic grouping is not used, the match runs for a very long time

indeed because there are so many different ways the + and * repeats can carve up the subject, and all

have to be tested before failure can be reported.
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At the end of a match, the values set for any capturing subpatterns are those from the outermost level of

the recursion at which the subpattern value is set. If you want to obtain intermediate values, a callout

function can be used (see the next section and the pcrecallout documentation). If the pattern above is

matched against

  (ab(cd)ef)

the value for the capturing parentheses is "ef", which is the last value taken on at the top level. If

additional parentheses are added, giving

  \( ( ( (?>[^()]+) | (?R) )* ) \)

     ^                        ^

     ^                        ^

the string they capture is "ab(cd)ef", the contents of the top level parentheses. If there are more than 15

capturing parentheses in a pattern, PCRE has to obtain extra memory to store data during a recursion,

which it does by using pcre_malloc, freeing it via pcre_free afterwards. If no memory can be obtained, the

match fails with the PCRE_ERROR_NOMEMORY error.

Do not confuse the (?R) item with the condition (R), which tests for recursion. Consider this pattern, which

matches text in angle brackets, allowing for arbitrary nesting. Only digits are allowed in nested brackets

(that is, when recursing), whereas any characters are permitted at the outer level.

  < (?: (?(R) \d++  | [^<>]*+) | (?R)) * >

In this pattern, (?(R) is the start of a conditional subpattern, with two different alternatives for the recursive

and non-recursive cases. The (?R) item is the actual recursive call.

SUBPATTERNS AS SUBROUTINES

If the syntax for a recursive subpattern reference (either by number or by name) is used outside the

parentheses to which it refers, it operates like a subroutine in a programming language. An earlier

example pointed out that the pattern

  (sens|respons)e and \1ibility

matches "sense and sensibility" and "response and responsibility", but not "sense and responsibility". If

instead the pattern

  (sens|respons)e and (?1)ibility

is used, it does match "sense and responsibility" as well as the other two strings. Such references must,

however, follow the subpattern to which they refer.

CALLOUTS

Perl has a feature whereby using the sequence (?{...}) causes arbitrary Perl code to be obeyed in the

middle of matching a regular expression. This makes it possible, amongst other things, to extract

different substrings that match the same pair of parentheses when there is a repetition.

PCRE provides a similar feature, but of course it cannot obey arbitrary Perl code. The feature is called

"callout". The caller of PCRE provides an external function by putting its entry point in the global variable 

pcre_callout. By default, this variable contains NULL, which disables all calling out.
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Within a regular expression, (?C) indicates the points at which the external function is to be called. If you

want to identify different callout points, you can put a number less than 256 after the letter C. The default

value is zero. For example, this pattern has two callout points:

  (?C1)\dabc(?C2)def

If the PCRE_AUTO_CALLOUT flag is passed to pcre_compile(), callouts are automatically installed before

each item in the pattern. They are all numbered 255.

During matching, when PCRE reaches a callout point (and pcre_callout is set), the external function is

called. It is provided with the number of the callout, the position in the pattern, and, optionally, one item

of data originally supplied by the caller of pcre_exec(). The callout function may cause matching to

proceed, to backtrack, or to fail altogether. A complete description of the interface to the callout function

is given in the pcrecallout documentation.

Misc & Hidden functions

Overview

There are some functions that are 'hidden' within theWord and are only useful in very specific situations.

Finding the line in an .ont file that corresponds to a verse

If you are editing an .ont file, it is useful to be able to find the line number in the .ont that a specific verse

is. To do this, you can press CTRL+ALT+INSERT in any Bible view and a popup dialog will give you the

info you need:

Locating errors

theWord logs any errors that happen in a file called errors.log. This file can be found in the Cache folder

of your installation. If you need to manually submit a bug report, then you should attach this file also.
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Copyrights and License information

Overview

The copyright and license for theWord and paid modules is included here.

Notice that modules that are distributed for free may also be copyrighted by their respective publishers.

Please, read carefully the license and copyright restrictions before using the software or any

accompanying modules.

theWord license

This is the standard license of theWord. It is also included in the software and appears when you click on 

Help->About.

This Software ("In the beginning was theWord", abbreviated theWord) is

copyrighted.

© 2003-2022 - Costas Stergiou

Please read this license agreement carefully. You may only use theWord if you

agree to the entire license agreement. 

The Author of this Software (referenced throughout this license agreement) is

Costas Stergiou.

The copyright applies to all the program files (e.g. the theword.exe file, language

translation files etc), all documentation accompanying this program, and all add-

ons (Bible and Book module add-ons). In general, all files that can be

downloaded from the official website (http://www.theword.net) are under this

license agreement, unless otherwise stated in individual licenses of add-on

modules (this applies particularly to add-on modules that are copyrighted by

their authors and/or publishers).

theWord is free software (free to use). This means that the Software is available

for use without any charge attached to it. theWord is not open source software.

The source code is not free or available to download or view.

This license is designed to ensure that theWord remains free for everyone and is

not used in any way to promote any profit generating activities that are outside

the scope of the Software. Exceptions to this rule apply only if there is a written

agreement with the Author of the Software. 

You can copy theWord freely for personal use and give it away to friends,

relatives, etc., as long as you do not charge for it in any way. You may not

charge for duplication costs, media costs, or even postage costs. If you

undertake the task of giving copies of theWord to others, you must do it for

free. You may not sell or resell this program or distribute it as a part of a

commercial package or any other profit generating activity, even if the

distribution is free. You may not bundle the Software (even if the media is free)

with any other product (e.g. enclose in a book, distribute with tracts) or make it

appear that the Software is an add-on, bonus pack, extra-service, etc., that the

end-user gets as a bonus for any service, product, activity of yours.

You may not host theWord software executable files, installation files, or any

other official files that can be found at the official website (http://www.theword.

net) on your website. You may not post any files or archives containing the

Software itself or any other files related to the Software in any software

http://www.theword.net
http://www.theword.net
http://www.theword.net
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repository, peer-to-peer network, or other file-sharing website or program.

theWord is designed in a way so that it can be extended with add-on modules.

The structure of add-on files (Bibles, Books, language files, etc) is open and

documented in order to allow you to compile your own modules or build utilities

and auxiliary programs to enhance the functionality of the Software. You may not

charge for add-on modules or auxiliary utilities without written permission from

the Author. Under the spirit of this clause, you may examine and/or reverse

engineer the structure of add-on modules in order to create your own modules.

You may not reverse-engineer the program binary file (theword.exe) or any

encrypted module. Some modules are encrypted to protect their copyrighted

content from unauthorized duplication. You must respect this protection and not

attempt to copy, extract, modify, and/or reuse such content. If you are unsure

about copyrights and/or this protection, please contact the Author (

root@theword.net).

The origin of this Software must not be misrepresented. You must not claim that

you wrote this Software. If you choose to redistribute the Software as part of an

"official" package (e.g. your own CD compilation with a custom CD cover or

label) you must:

1. State clearly on the CD itself (and the cover if applicable) that the Software is

not written by you 

2. Place a link to http://www.theword.net in a noticeable area on the CD label

and cover

3. Contact the Author (root@theword.net) to obtain written permission. All valid

electronic media distributions of the Software (e.g. CD, DVD, USB flash drive,

etc.) will be listed, along with a picture of the actual media, on a noticeable

area on the official website (http://www.theword.gr/license)  so users will know

whether or not the distribution is legal.

This Software is provided by the Author "as is". Any express or implied

warranties, including, but not limited to, the implied warranties of merchantability

and fitness for a particular purpose are disclaimed. In no event shall the Author

or contributors be liable for any direct, indirect, incidental, special, exemplary, or

consequential damages (including, but not limited to, procurement of substitute

goods or services; loss of use, data, or profits; or business interruption)

however caused and on any theory of liability, whether in contract, strict liability,

or tort (including negligence or otherwise) arising in any way out of the use of,

or inability to use, this Software, even if advised of the possibility of such

damage.

I, Costas Stergiou (the Author), reserve the right to make exceptions to any of

these conditions, or alter these conditions, at any time. For every exception to

the above rules, a notice will be available at the official website at http://www.

theword.gr/license. If you are aware that any of these terms have been violated,

please refer to the previous link and report it. 

Costas Stergiou

Greece

root@theword.net

http://www.theword.net 

mailto:root@theword.net
http://www.theword.net
mailto:root@theword.net
http://www.theword.gr/license
http://www.theword.gr/license
http://www.theword.gr/license
mailto:root@theword.net
http://www.theword.net
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Standard non-free module license

The following license is the one that applies for each paid module, unless otherwise stated in the module

installer or Information dialog of the module. It is displayed when you install a paid module and you need

to agree in order to continue with the installation.

The module you purchased is accompanied with a personal serial number which,

along with your full name and email address, constitute the ‘unlock data’ that

allow you access to the module. In this license agreement, the word ‘module’

refers both to the ‘unlock data’ and the actual files that comprise the module.

The module(s) that you purchased are only licensed for and compatible with

theWord Bible software. You will not be able to use them with any other software

or outside of theWord.

You may not modify, decompile, disassemble or otherwise reverse engineer any

part of these module(s). You may not distribute the file(s) included in this

package in any way (either in a private or public network, internet, or other

media). You are allowed, however, to make copies of it for archival purposes.

You are not allowed to copy the content of this module out of the program

except to make reasonably short quotes. You are not allowed to re-format,

change or otherwise format-shift the content of this module for any use. This

module is solely for viewing within the theWord Bible software.

If you are an individual, you are allowed to install and use this module(s) in any

number of computers that you personally own and use for yourself and that of

your immediate family. If you are installing this module(s) on a public computer,

you may install it on a single computer. In the case of a public computer, a new

license must be purchased for each seat.
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